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Updating ASP

You should check the DMC Software web site for updates regularly as DMC Software is
continually upgrading the ASP program, and these upgrades are made available to
download free of charge.

The latest updates to your version of ASP can be downloaded from the DMC Software web
site:

www.dmcsoftware.com.

Click on DOWNLOAD at the DMC Software home page, and then follow the instructions to
update your version of ASP.
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Basic Concepts

There are four sections that are particularly helpful in understanding the functioning and
organization of ASP:

ASP Menu System Basic Operations

Data Management Selecting Variables, Cases, And Samples

Even though every effort has been made to make ASP as intuitive as possible, it can be
very useful to look over these sections when you first start using the ASP program.

ASP Menu System

You can access all of the data management, statistical, and other features of ASP through
the menu bar at the top of the ASP opening screen. There are seven options on this menu

bar:
FIL DATA MANAGEMENT STATISTICS
GRAPHS AUXILIARY HELP
File Menu

The FILE menu allows you to access all of the file management options in ASP. There are
11 options on this menu:

Create New Matrix allows you to create a new data matrix.

Open ASP File allows you to get data from an ASP data file.

Save In ASP File allows you to save data in an ASP file so that it will be available at a later
time.

Import Data From ASCII File allows you get data from a file that has been created by
another program and saved in an ASCII file.

Export Data To An ASCII File allows you to export data from ASP to an ASCII file that can
subsequently be imported into another program.

Import Data From Clipboard allows you to copy data from another program to the Windows
clipboard and then import these data to ASP.




20

List Matrix allows you to list the data matrix in memory.
Print Matrix allows you to print the data matrix in memory.

File Information allows you to open the file information file associated with the data matrix
in memory.

Updating ASP opens a window that give instructions on how you can obtain free update of
the ASP program.

Exit allows you to quit the ASP program.

In addition, the last five files you have opened or saved are listed at the bottom of the
menu. You can open any one of these files by clicking on its name in this list.

Data Management Menu

The DATA MANAGEMENT menu allows you to access all of the data management options
in ASP. There are 12 options on this menu:

Transform Variables/Cases allows you to access the Variable/Case Transformation
menu.

Recode Variables allows you to recode a variable.

Sort Data Matrix allows you to sort a data matrix.

Transpose Data Matrix allows you to transpose a data matrix.

Breakdown Variable allows you to breakdown on variable in to a set of variables that
correspond to the values of another variable.

Combine Variables allows you to combine a set of variables into a single variable.

Add Variables allows you to add variables to the data matrix in memory either from the
keyboard or from a file.

Add Cases allows you to add cases to the data matrix in memory either from the keyboard
or from a file.

Delete Variables allows you to delete variables from the data matrix in memory.

Delete Cases allows you to delete cases from the data matrix in memory.

Generate Random Samples allows you to create variables consisting of random numbers.

Generate Pattern Variables allows you to create variables consisting of numbers that follow
a pattern.
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Most of the options on this menu can be executed directly from the ASP data editor toolbar.

Statistics Menu

The STATISTICS menu allows you to access all of the statistical options in ASP. There
are 12 options on this menu:

Summary Statistics allows you to generate 33 summary statistics from the variables in the
data matrix in memory.

Probability allows you to calculate probabilities and table values from 18 probability
distributions.

Confidence Intervals allows you to calculate confidence intervals for eight population
statistics.

Hypothesis Tests provides 23 options for undertaking parametric and non parametric
hypothesis tests.

Correlation Matrix allows you to generate a correlation matrix and a matrix of p-values from
a set of variables.

Analysis Of Variance provides seven options for estimating analysis of variance models.

Regression Analysis provides seven options for estimating regression models.

Time Series Analysis provides nine options for estimating times series models.

Crosstab/Contingency allows you to crosstabulate one variable according to the values of
another and to evaluate a contingency table.

Reliability provides 12 options for estimating reliability statistics.

Factor Analysis provides for principle components analysis as well as seven options for
common factor analysis.

Power/Size/Difference allows you to calculate the power of a parametric test as well as the
optimal sample size and the minimal detectable difference for the test.

Graphs Menu

The GRAPHS menu allows you to generate plots and charts. There are two options on this
menu:

Character Plots provides plots made from characters and is the only option available on the
Student Version of ASP.
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Graphics Options provides high resolution graphics. This option is not available in
the Student version of ASP.

Both options allow you to create scatter, cumulative, horizontal sequence, quantile,
probability, correlation, and frequency plots along with control charts.

The Character Plots option also allows you to create vertical sequence, box and whisker,
and stem and leaf plots.

The Graphics Options option also allows you to create pie charts and bar graphs as well as
area, function, crosstab, and regression plots.

Auxiliary Menu

The AUXILIARY menu provides supplementary routines to handle various non
statistical computational chores. There are seven options on this menu:

Linear Equations allows you to use ASP to solve a set of linear equations.

Matrix Operations allows you to use ASP to manipulate matrices in a number of ways.

Eigen Values allows you to use ASP to calculate the eigen values of a matrix.
Determinants allows you use ASP to calculate the determinant of a matrix.
Depreciation allows you to use ASP to calculate depreciation schedules.

Interest Rates allows you to use ASP to make a number of interest rate calculations.

Linear Programming allows you to use ASP to solve linear programming problems.

Options Menu
The OPTIONS menu has three options:

Change Number Of Digits In Output allows you to change the number of digits displayed in
the output.

Change Missing Value Code allows you to change the value that is treated as missing in
ASP.

File Information allows you to open the file information window associated with the data
matrix in memory. This window allows you to record and view whatever information you
wish to save with the data matrix when it is saved in a file.
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Help Menu

The HELP menu allows you to access the ASP help system. There are four options on this
menu:

ASP Help allows you to access the ASP help file.

How To Use Help activates the Windows routine that explains how to use the Windows
Help system.

Updating ASP opens a window that gives instructions on how you can obtain free updates
of the ASP program.

About ASP provides version and other information about the ASP program.

Executing An Option On A Menu Bar Menu

There are two methods you can use to execute an option on a menu bar menu:

Click on the name of the menu you want to access in the menu bar. This will cause the
menu to open.

Click on the option that you want to execute in the open menu. This will execute the
option.

Or
Press and release the Alt key to highlight the FILE menu name.

Use the right and left cursor keys to highlight the name of the menu you want to
access.

Press the down cursor key to open the highlighted menu.
Use the up and down cursor keys to highlight the option you want to execute.

Press the Enter key to execute the option.

Submenus

All submenus, that is, menus that are accessed by executing an option on a menu bar
menu, use a common ASP menu form. This form is more efficient than the standard
Windows menu in that it remains open until you close it.

The ASP menu form consists of a single list box that contains the menu’s options, an OK
button that allows you to execute the highlighted option in the list box, and a CANCEL
button that allows you to close the menu.
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To execute an option on an ASP submenu highlight the option by clicking on it or use the
cursor keys to move the highlight bar to it, then click on OK. When you click on OK the
highlighted option is executed.

You can also execute an option on an ASP menu form by double clicking on the option, by
highlighting it and pressing Enter, or by pressing the letter to the left of the option.

Click on CANCEL or press Esc to close an ASP menu.

Basic Operations

There are a number of operations discussed in this section that are important to the
efficient operation of ASP:

Managing Memory Exponential Or E Notation
Missing Values Shortcut Keys
Changing Names Changing Color Scheme

Displaying, Printing, And Saving Output Changing The Number Of Digits In The Output

Quitting ASP Uninstalling ASP

Managing Memory

The initial installation of ASP on your computer allocates 6mb of memory to ASP. This can
lead to two problems:

First, 6mb of memory is enough to work comfortably with a data matrix of 50,000 to 60,000
numbers. If you want to work with data matrices larger than this you will have to increase
the amount of memory allocated to ASP.

Second, if your computer has less than 8mb of memory and/or if you want to multitask
more than one program, you may not have enough memory to allocate 6mb of memory to
ASP and avoid having to swap memory to disk on a regular basis. This can cause ASP to
run very slowly as it has to wait on the disk swapping that takes place. In this situation, you
may want to reduce the amount of memory allocated to ASP.

To change the amount of memory allocated to ASP:

Right click on the ASP shortcut icon that you use to start ASP. This will bring up the
Right Click Popup menu.

Click on the Properties option on the right click popup menu. This will bring up the ASP
ICON PROPERTIES form.



25

Click on the Shortcut tab.

The Target edit box on the Shortcut tab contains the command line parameters needed to
start ASP. Specifically, the command line statement:

wssize =6m

tells Windows to allocate 6mb of memory to the ASP program. You can change the amount
of memory Windows allocates to ASP by changing the 6 in this statement to whatever
value you want.

As a guide, each additional 4mb of memory you add will increase the amount of data you
can work with in ASP by approximately 50,000 numbers.

You should note that if this number is set too high, ASP will run very slowly as Windows is
forced into excessive disk swapping.

WARNING: Do not change the other two statements in the Target edit box. The first
(C:\ASPW\aspw.exe) tells Windows what program to execute and where to find it. The
second (c:\aspw\aspw.ini) tells ASP where to find the ASPW.INI file. If either of these
statements are missing or incorrect, the shortcut icon will be unable to start ASP.

Exponential Or E Notation

You can enter extreme values in exponential or E notation. The form of this notation is
aEb

which denotes the number a multiplied by 10 raised to the power b (e.g., 2.34E3 = 2340
and 2.34E-3 = .00234).

Extreme values that appear in the output are often displayed in this notation.

Missing Values

ASP allows you to enter missing values into your data matrix. ASP then tracks your missing
values by assigning each missing value a special code.

To enter a missing value in ASP:
Enter an asterisk (*) or the letter M.
Press Enter.
The missing value code will then be recorded for that value.

The default missing value code is 2 raised to the =50 power (2E-50). This value can be
changed by clicking on:
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OPTIONS -> Change Missing Value Code.

You are then prompted to enter a new value for the missing value code.
When the new value is entered you are prompted:

Replace Old Missing Values In Data With New?

If you respond YES to this prompt, the old missing values will be replaced with the new
missing value code and will still be treated as missing by ASP.

If you respond NO the old missing values are left unchanged and they will no longer be
treated as missing.

Shortcut Keys

ASP follows the standard windows conventions in using shortcut keys in the Windows
menu system. If a letter in the caption of an option in a Windows menu is underlined, you
can access that option by pressing the letter alone if the focus is on the menu in which the
option appears. If the focus is otherwise the ALT key plus the underlined letter must be
pressed to access the option.

If a shortcut hotkey combination is available for an option in a Windows menu it is listed to
the right of the caption for that option on the menu. You can use the shortcut hotkey
combinations so listed to execute the corresponding option from the editor without first
accessing the menu, e.g., by pressing Ctrl+Alt+S to execute the summary Statistics option
on the STATISTICS menu.

ASP Form Shortcut Key Conventions

You can execute an option on an ASP form by pressing the Alt key along with the
underlined key in the caption of the option just as you would in a Windows menu, but you
don't have to press the Alt key when in an ASP form. You can execute the option by
pressing the underlined letter alone, even if the focus is not on the option.

The exception to this rule is when you are editing names, labels, and other text. Since
names, labels, and other text must be able to contain the underlined letters, the ALT key
must be used to execute options in this situation.

In addition, you can press Esc to exit and close any form in ASP that has a CANCEL
button on it.

Changing Names

ASP provides a common format for changing the names it generates:
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Whenever ASP generates names, the names are indexed displayed in a list box at the
top of a form. You are then prompted ARE NAMES OK? If you respond YES in
response to this prompt you can continue without changing the names.

If you respond NO in response to the ARE NAMES OK? prompt this prompt is replaced
with a Name For Number 1 prompt, the first name in the list box is highlighted, and an
edit box that contains the first name in the list box is presented. You can then change
the name in the edit box or select another name to change.

To select another name to change:
Double click on it.
or

Use the Page Up, Page Dn, up and down cursor keys (the End, Home, right, and left
cursor keys are reserved for use in editing the name in the edit box.) to move the
highlight bar to the name you want to change and then click on OK.

Either of these actions will bring the name you have selected into the edit box.

After you have changed the name you have selected, click on OK to record the new name
and move to the next name in the list.

Repeat the above until you have made all of the changes you want.

When you have finished changing the names you want to change click on DONE to
continue to the next step in the analysis.

Changing Color Scheme

Windows sets all colors displayed by ASP. To change the color scheme click on:
Start -> Settings ->Control Panel -> Display ->Appearance.

Displaying, Printing, And Saving Output
Output is displayed using two formats in ASP:

If the output contains a numeric matrix that is not always the same size, the matrix is
displayed in a window at the bottom of the screen along with its row and column labels. In
addition, an edit window at the top of the screen contains additional information.

If the output contains only numeric matrices that are always the same size, the window at
the bottom of the screen is not used, and all of the output is displayed in the edit window at
the top of the screen.

In both formats there are five buttons at the bottom of the output display:
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CONTINUE PRINT SAVE

CLIPBOARD CANCEL
CONTINUE allows you to continue to the next stage of the analysis.

PRINT allows you to print the output that is displayed using the standard Windows Print
Setup form.

SAVE on the output display allows you to save the output in the lower window to either an
ASP data file or an ASCII file using the standard windows save File form.

If you choose to save the output as a data file you are given the option of saving the output
to a file on disk or of adding the data to the data matrix in memory.

If there is no output in the lower window (or if you choose to save the output in an ASCII
file) you are given the opportunity to:

Save the output in a new file
Add the output to an existing file
Overwrite an existing file with the output.
The resulting file ASCII file can then be opened by a word processor.

It is important to note that the number of significant digits saved when you save output in a
data matrix is determined by the number of significant digits displayed in the output.

(The default number is 6.) If you want to save more significant digits you must increase the
number of significant digits in the display before the output is generated and displayed.

CLIPBOARD allows you to add the contents of the current output display to the ASP
clipboard for you to view at a later time. The output stored in this clipboard can

be accessed at any time by clicking on the CLIPBOARD icon on the Windows task bar. In
addition, you can edit, save, and print the contents of the ASP clipboard whenever you
wish.

CANCEL allows you to cancel the current operation and return to some previous point in
the program. This allows you to avoid having to view additional output by aborting the
routine you are working with. This same result can be obtained by pressing the Esc key.

You should not click on CANCEL or press Esc to exit the output display as a matter of
course. You should click on CANCEL only when you are certain you want to abort the
routine you are working with to avoid looking at additional output. If you are not certain you
want to avoid looking at additional output, you should click on CONTINUE to exit the output
display.
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The edit window at the top of the output display allows you to enter whatever information
you want, and, thus, allows you to document the output before you print it or save it in a file.

Changing The Number Of Digits In The Output
The default value for the number of digits in the output is six. To change this value click on:

OPTIONS -> Change Number Of Digits In Output.
You are then prompted to enter the number of digits to be displayed.

This value will affect only the number of digits in the output. It will not affect the number of
digits in the editor. Five digits are displayed in the editor irrespective of the number of digits
in the output, and the number of digits stored in the data matrix in memory is 16 no matter
what the number of digits displayed.

Quitting ASP
If you wish to quit the ASP program click on:
FILE -> Exit

You will be warned before ASP is cleared from memory if you have data in the editor or in
the ASP clipboard that has not been saved.

Uninstalling ASP

You can use the Windows uninstall feature to remove ASP and ASP Graphics from your
computer. To do this click on:

My Computer -> Control Panel -> Add/Remove Programs.
This will bring up the Windows Add/Remove Programs Properties form:
Click on the Install/Uninstall tab.
Click on the A STATISTICAL PACKAGE item in the list box on this tab.
Click on the Add/Remove button. This will bring up the Windows Uninstall Wizard.
Follow the on screen instructions to uninstall ASP.

Repeat the above to uninstall the ASP GRAPHICS ADD ON.



30

Data Management

The data management routines in ASP are broken down into three categories:

Creating A New Data Matrix

Working With A Data Matrix

Working With ASP Files

Selecting Variables, Cases, Samples

Even though every effort has been made to make ASP as intuitive as possible, it can be
very useful to look over these sections when you first start using the ASP program.

Creating A New Data Matrix
To create a new data matrix:

Click on NEW MATRIX in the frame at the top of the editor. (You can also create a new
data matrix from the FILE menu.)

In response to the resulting:
Number of Variables to add?

prompt, enter the number of variables (columns) in the matrix you want to create. (You will
be asked to enter the number of cases (rows) if the By Var. option is selected.)

Click on OK.

When you click on OK a new data matrix will appear in the editor with the number of
variables (cases) you specified and one case (variable). The numeric values in this matrix
are missing as denoted by asterisks (*), the case label for each case is CASE, and the
label for the ith variable is Vari. The file label and file name are given as none.

You are now ready to use the ASP data editor to enter data into the newly created data
matrix.
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ASP Data Editor

Most of the statistical routines in ASP require that data be contained in a data matrix. A
data matrix is a rectangular array made up of columns and rows. Variables are identified
with the columns of the matrix, and cases (i.e., the values of variables that correspond to
each other) are identified with the rows. The data matrices used by ASP contain only
numbers. Thus, nonnumeric data (e.g., sex, political affiliation, etc.) must be given a
numeric code (e.g., Male=1, Female=2, etc.) if they are to be included in an ASP data
matrix.

At the bottom of the opening screen is the ASP editor. At the top of the editor is a frame
containing a set of toolbar buttons and two edit boxes:

The toolbar buttons allow you to initiate various data management routines directly without
having to go though the Windows menu system.

The edit boxes allow you to assign a file label and file name to the data matrix in the editor.

At the bottom of the editor are three grid boxes:
The grid box on the left allows you to enter case labels.

The grid box at the top allows you to enter variable names.

The main grid box on the lower right allows you to enter numeric data.

There is also an ENTER DATA By Case or By Var. option control above the grid box on
the left. This option control allows you to enter data one case at a time if the By Case
option is selected, or one variable at a time if the By Var. option is selected.

Data Editor Tool Bar
The toolbar at the top of the ASP data editor contains ten buttons:

NEW MATRIX OPEN FILE
SAVE MATRIX FILE INFO

LIST MATRIX MORE OPTIONS
ADD VARS ADD CASES
DELETE VARS DELETE CASES

These buttons allow you to initiate various data management routines directly without
having to go though the Windows menu system.

NEW MATRIX executes the Create New Matrix option on the File menu.
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OPEN FILE executes the Open ASP File option on the File menu.

SAVE MATRIX executes the Save In ASP File option on the File menu.

FILE INFO executes the File Information option on the File menu.

LIST MATRIX executes the List Matrix option on the File menu.

ADD VARS executes the Add Variables option on the DATA MANAGEMENT menu.

ADD CASES executes the Add Cases option on the DATA MANAGEMENT menu.

DELETE VARS executes the Delete Variables option on the DATA MANAGEMENT menu.

DELETE CASES executes the Delete Cases option on the DATA MANAGEMENT menu.

MORE OPTIONS opens a submenu that lists all of the additional data manipulation
options on the DATA MANAGEMENT menu that are not otherwise represented on the data
editor toolbar buttons:

T. Transform Variables/Cases D. Transpose Data Matrix

Q. Sort Data Matrix B. Break Down Variable

C. Combine Variables R. Recode Variables

Entering Numeric Data

The main grid box on the lower right holds numeric data. To enter numeric data in this grid
box:

Click on or use the Tab and cursor keys to move to the cell in the main grid box in which
you want to enter a number. This opens an edit window over the selected cell.

Enter the number in the edit window.
Press Enter.

When you press Enter the number you entered in the edit window is recorded in the data
matrix. The edit window then moves to the cell to the right if the By Case option is
selected, or to the cell below if the By Var. option is selected. You can then enter a
number in the edit window for the next cell in the matrix.

You can continue in this way until all of the cells of the case (variable, if the By Var. option
is selected) are entered. When the last cell in this case (variable) is entered, the editor
adds a new case (variable) to the end of the data matrix, and the edit window moves to the
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beginning of the new case (variable). You can then continue to fill in the next case
(variable).

If you enter a number in the edit window and then click on, or use the cursor keys to move
to a new cell before you press Enter, the edit window moves to the new cell without
recording the number you entered for the previous cell. You must press Enter to record
a new entry.

Changing Variable Names

The top grid box contains variable names for each column in the data matrix. The default
variable name of the ith variable is Vari.

To change a variable name:

Click on or use the Tab and cursor keys to select the variable name you want to
change. This will open an edit window over the variable name.

Enter the new variable name.
Press Enter.

When you press Enter the new variable name will be recorded in the data matrix, and the
edit window will move to the next variable name.

Variable names can be up to 20 characters long. However, in most situations these names
should be kept to fewer than 10 characters. ASP often combines variable names to label
output. If these names are large the resulting labels can become quite awkward. If they
become too awkward they will be suppressed.

Only 15 characters are displayed in the editor.

If you enter a variable name in the edit window and then click on, or use the cursor keys to
move to a new cell before you press Enter, the edit window will move to the new cell
without recording the variable name you entered for the previous cell. You must press
Enter to record a new entry.

Changing Case Labels

The grid box on the left of the ASP data editor contains a case label and case number for
each row of the data matrix. The default case label is CASE. The case number is assigned
by the program and cannot be changed. You can, however, change the case label.

To change a case label:

Click on or use the Tab and cursor keys to select the case label you want to change.
This will open an edit window over the case label.
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Enter the new case label.
Press Enter.

When you press Enter the new case label will be recorded in the data matrix, and the edit
window will move to the next case label.

If you enter a case label in the edit window and then click on, or use the cursor keys to
move to a new cell before you press Enter, the edit window will move to the new cell
without recording the case label you entered for the previous cell. You must press Enter
to record a new enters.

Case labels can be up to 20 characters long. Only 15 characters are displayed in the editor.

Changing File Name And Label

The file name and file label in the edit boxes at the top of the ASP Data Editor appear on
most of the output generated by ASP. This helps you keep track of the source of the output
being generated. In addition, if you subsequently save this data matrix in a file, the file
label and name will be saved with the data matrix.

To add a file name to the data matrix click on the FILE NAME edit box at the top of the data
editor and enter any legal Windows 95 file name.

Similarly, to add a file label to the data matrix click on the FILE LABEL edit box and enter
whatever text you want to describe the data matrix. You are limited to 68 characters in this
label.

Adding File Information

The File Information option on the FILE menu opens an edit window that displays and
allows you to edit documentary information on the data matrix in memory. This information
is saved with the file and is subsequently available when the file is reloaded into memory.

This option allows you to enter whatever information with regard to the data matrix that you
wish (variable coding, the method of data collection, the nature of the variables, etc.) and to
save this information in the ASP file when the data matrix is saved.

The information saved in this way can subsequently be retrieved and examined by
executing the File Information option on the FILE menu or by clicking on the FILE INFO
button on the ASP data editor toolbar.
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Working With A Data Matrix

There are a number of important data management options on the DATA MANAGEMENT
menu. Options on this menu allow you transform and recode variables and cases, sort and
transpose data matrices, breakdown and combine variables, add and delete variables and
cases, and to generate variables to add to the data matrix.

Four of the options on the DATA MANAGEMENT menu, adding and deleting variables and
cases, are available directly from the data editor by clicking on the ADD VARS, ADD
CASES, DELETE VARS, or DELETE CASES buttons on the data editor tool bar in the
frame at the top of the editor. The rest of the options on the DATA MANAGEMENT menu
are on the MORE OPTIONS menu obtained by clicking on the MORE OPTIONS button on
the data editor tool bar.

Eight of the options on the DATA MANAGEMENT menu allow you to operate directly on
the data matrix in the editor:

Add Variables Sort Data Matrix

Add Cases Combine Variables
Delete Variables Transpose Data Matrix
Delete Cases Break Down Variables

There are also two options on the FILE menu that allow you to operate directly on the data
matrix in the editor:

List Matrix Print Matrix

Deleting Variables Or Cases
To delete a variable or case from the data matrix in the editor:

Click on DELETE VARIABLE or DELETE CASE in the data editor tool bar at the top of the
editor. (You can also delete variables and cases from the DATA MANAGEMENT menu.)

Select the variables or cases you want to delete.

When you are finished selecting the variables or cases you are prompted to verify the
number to delete.

The variables or cases you have selected are then deleted from the data matrix in the
editor.
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Editing A Data Matrix

Once a data matrix is in the editor you can edit it as you see fit. Use the scroll bars to the
right and below the numeric grid box to bring any given cell in the data matrix into view,
then click on the cell to open the edit window over the cell. You can also use the cursor
keys to move the edit window to any cell in the data matrix.

In addition, pressing:
Home moves the edit window to the first case in the variable in which it is located.
End moves the edit window to the last case in the variable in which it is located.

Ctrl + Home (hold down Ctrl and press the Home key) moves the edit window to the first
variable in the case in which it is located.

Ctrl + End moves the edit window to the last variable in the case in which it is located.
Page Up mover the edit window up one screen.

Page Dn moves the edit window down one screen.

Ctrl + Page Up moves the edit window one screen to the left.

Ctrl + Page Dn moves the edit window one screen to the right.

Adding Variables Or Cases
To add a variable or case to the current data matrix:

Click on ADD VARIABLE or ADD CASE in the data editor tool bar at the top of the
editor. (You can also add variables or cases from the DATA MANAGEMENT menu.)

You are then given the option of adding the new variables or cases from the keyboard
or from a file:

Adding Variables Or Cases From Keyboard. If you choose to add from the
keyboard the new variables or cases are added to the data matrix in the editor as
missing values to be filled in.

Adding Variables Or Cases From File. If you choose to add from a file the
Windows OPEN FILE form appears for you to open the file from which to add the
variables or cases.

In either case, you are prompted to specify the column or row at which you want to add
the variables or cases to the data matrix in the editor.
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The variables or cases are then added to the data matrix at the column or row which you
specified.

Transposing A Data Matrix
To transpose the data matrix in the editor click on:

DATA MANAGEMENT -> Transpose Data Matrix.

(This option is also available on the MORE OPTIONS menu accessed by clicking on
MORE OPTIONS in the data editor tool bar.)

The data matrix in the editor will then be transposed, that is, its rows and columns will be
interchanged. As a result, its cases become variables and its variables become cases.

Sorting A Data Matrix
To sort the data matrix in the editor click on:

DATA MANAGEMENT -> Sort Data Matrix.

(This option is also available on the MORE OPTIONS menu accessed by clicking on
MORE OPTIONS in the data editor tool bar.)

You must then choose between sorting by a variable or sorting by the case label number:
Sorting By A Variable. If you choose to sort by a variable you must choose:
The variable by which the data matrix is to be sorted.
Between sorting in ascending or descending order.

If you choose to sort in ascending order, the cases in the current data matrix are
rearranged in the order of the sort variable from lowest to highest. If you choose to sort
in descending order the cases in the current data matrix are rearranged in the order of
the sort variable from highest to lowest.

Sorting By Case Label Number. If you choose to sort by case label number, the cases
in the data matrix are rearranged in the order of the case label numbers in ascending
order, that is, from lowest to highest. This alternative, in effect, allows you to unsort the
data matrix.

Combining Variables

To combine a set of variables into a single variable by stacking the variables on top of each
other:
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Click on
DATA MANAGEMENT -> Combine Variables.

(This option is also available on the MORE OPTIONS menu accessed by clicking on
MORE OPTIONS in the editor.)

You are then presented with the SELECT VARIABLES form. Select the variables to be
combined.

Click on CONTINUE.

The selected variables are then combined and two variables are added to the end of the
original data matrix in the editor:

The first, CVARS , is the combined variable.

The second, INDEX , is an index variable that indexes the variables that have been
combined in the combined variable.

You can change the names of these variables in the editor.

Breaking Down Variables
To break down one variable in accordance with the values of another:
Click on DATA MANAGEMENT -> Break Down Variables. (This option is also

available on the MORE OPTIONS menu accessed by clicking on MORE OPTIONS in
the data editor tool bar.)

Select the variable to be broken down along with the breakdown variable.
Click on CONTINUE.

The selected variable is broken down in accordance with the values of the breakdown
variable, and added to the end of the original data matrix in the editor.

The names of the new variables are created by enclosing in parentheses the name of the
break down variable set equal to the value to which the new variable corresponds. These
parentheses are then attached to the name of the variable being broken down. You can
change the names in the editor.

Printing A Data Matrix
To print the data matrix in the editor click on:

FILE -> Print Matrix
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Click on YES in response to the resulting All Variables And Cases? prompt. (If you
click on NO in response to this prompt you are given the option of selecting the
variables and cases to be printed.) This yields the Windows PRINT SETUP form.

When all of the defaults in this form are set properly, click on OK to print the data
matrix.

When you click on OK a copy of the data matrix is sent to the printer you have selected
with the defaults you have chosen for that printer.

Listing A Data Matrix
To list the data matrix in the editor:

Click on LIST MATRIX in the frame at the top of the editor. (You can also list the data
matrix from the FILE menu.)

Click on YES in response to the resulting All Variables And Cases? prompt. (If you
click on NO in response to this prompt you are given the option of selecting the
variables and cases to be listed.)

At this point, the data matrix in the editor will be listed in the ASP output format.

Transformations

The variable and case transformation options are located on the VARIABLE/CASE
TRANSFORMATION menu. You can access this menu by clicking on:

DATA MANAGEMENT -> Transform Variables/Cases.

(You can also access this menu through the MORE OPTIONS menu accessed by clicking
on MORE OPTIONS in the editor.)

The VARIABLE/CASE TRANSFORMATIONS menu has twenty-four options:

A. Absolute Value(X) B. 1/X

C. Copy (X) D. XA2

E. X*5 F. a+b*X

G. X(+,-,<, =, etc.)a H. X(+,-.<, = etc.)Y
l. a(+,-.<, = ,etc.)X J. Y(+,-.<, = etc.)X

K. Log/Antilog(X) L. Lag/Difference/%Change
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M. Case Transformations N. Sin/Cos/Tan(X)

O. Round(X)To a Places P. Accumulate(X)

Q. Deviation From Mean R. Rank(X)

S. Scale(as*X) T. Trend/Case No. Variables
U. Standardizes(X) V. Create Dummy Variables

W. Generate Random Samples X. Generate Pattern Variables

Format For Variable Transformations

Options on the VARIABLE/CASE TRANSFORMATIONS menu, except as indicated, follow
a common format:

Click on the option you want to execute.

If the option requires that an operator or relation be specified (G, H, I, and J) you are
prompted to select the operator or relation from the SELECT OPERATOR / RELATION
menu. If the option requires that you choose between alternatives (K, L, and M) you
are prompted to make the choice. If the option requires that parameters be specified
(G, 1,0, S, and F) you are prompted to enter the values for these parameters.

You are then prompted to select the variables that are to be transformed.

The names of the variables to be transformed are displayed as proposed names for the
transformed variables, and you are given an opportunity to change these names.

You are then given the option of adding the transformed variables to the current data
matrix or using these variables to replace the variables that were transformed.

The transformations are then calculated and the transformed variables are added to the
data matrix in the manner specified.

You are then returned to the VARIABLE/CASE TRANSFORMATIONS menu.

Direct Transformations

There are nineteen direct variable transformations options on the VARIABLE/CASE
TRANSFORMATIONS menu:

A. Absolute Value (X) B. 1/X
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C. Co X D. X~2

E. X».5 F. a+b*X

G. X(+,-,<,=,etc.) a H X+ - <= etc)Y
lLa(+,-,<,=,etc) X JY(+,-,<,=,etc.) X
K. Log/Antilog (X) L. Lag/Difference/%Change
N. Sin/Cos/Tan (X) 0. Round (X) To a Places
P. Accumulate (X) Q. Deviation From Mean
R. Rank (X) S. Scale (a * X))

U. Standardize (X)

A. Absolute Value (X) returns a variable in which each element is equal to the
absolute value of the corresponding element of the variable being transformed.

B. 1 / X returns a variable in which each element is equal to t he reciprocal of the
corresponding element of the variable being transformed.

C. Copy (X) returns a copy of the variable being transformed.

D. X N 2 returns a variable in which each element is equal to the square of the
corresponding element of the variable being transformed.

E. X A .5 returns a variable in which each element is equal to the square root of the
corresponding element of the variable being transformed.

F. a+ b * X returns a variable in which each element is equal to a plus b times the
corresponding element of the variable being transformed.

G. X (+,-,<,=,etc.) aandI. a (+,-,<,=,etc.) X allow you to choose an operator or
relation to place between a constant (a) and the variable (X). The available choices are
given by the SELECT OPERATOR/RELATION menu.

The result is a variable in which each element is equal to the result when the selected
operator or relation is placed between the specified constant and the corresponding
element of the variable being transformed.

When a relation is used in a transformation the result is 1 when the relation holds and 0
otherwise.
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H. X (+,-,<,=,etc.) Yand J. Y (+,-,<,=,etc.) X allow you to select an operator or
relation to place between two variables (Y and X) that are chosen to be transformed.

The result is a variable in which each element is equal to the result when the selected
operator or relation is placed between corresponding elements in the two variables.

When a relation is used in a transformation the result is 1 when the relation holds and 0
otherwise.

K. Log/Antilog (X) allows you to calculate log and antilog transformations. When you
execute this option you are prompted first to choose between logs or antilogs and then
between natural logs and other logs:

If you choose natural logs the result is a variable in which each element is the natural
log (antilog) of the corresponding element of the variable being transformed.

If you do not choose natural logs you are prompted to enter the value of the base of
the logarithmic system that you want the transformation to utilize. The result is a
variable in which each element is the log (antilog) of the corresponding element of the
variable being transformed as determined by the base of the logarithmic system you
have entered.

L. Lag/Difference/% Change allows you to perform lag, difference, and percent
change transformations. When you execute this option you are prompted to choose
between lags, differences, or percent changes. You are then prompted to specify the
number of periods for which the variables to be transformed are to be lagged or differenced
or for which the percent changes are to be calculated:

The Lag option results in a variable in which each element is equal to the corresponding
lagged element of the variable being transformed.

The Difference option results in a variable in which each element is equal to the
difference between the corresponding element of the variable being transformed and
the corresponding lagged element of this variable.

The Percent Change option results in a variable in which each element is equal to 100
times the difference between the corresponding element of the variable being
transformed and the corresponding lagged element, divided by the corresponding
lagged element.

N. Sin/Cos/Tan (X) returns trigonometric transformations. When you execute this
option you are prompted to choose between calculating the function or arc function of the
trigonometric transformation and then between the sine, cosine, or tangent transformation.

The result is a variable in which each element is equal to the (arc) sine, cosine, or tangent,
depending on which you choose, of the corresponding element, measured in radians, of the
variable being transformed.
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S. Scale (a * X) returns a variable in which each element is equal to a times the
corresponding element of the variable being transformed.

0. Round (X) To a Places returns a variable in which each element is equal to the
corresponding element of the variable being transformed rounded to a decimal places.

R. Rank (X) returns a variable in which each element is equal to the rank of the
corresponding element of the variable being transformed. Tied ranks are recorded as the
arithmetic mean of the adjoining ranks for which the ties occur.

U. Standardize (X) returns standardize transformations. When you execute this option
you are given the choice of calculating z-scores or some other standardized form:

If you choose z-score the result is a standardized variable with a mean equal to 0 and
a standard deviation equal to 1 and where each element is equal to the z-score of the
corresponding element of the variable being transformed.

If you do not choose z-score you are prompted to enter values for the mean (a) and
standard deviation (b) of the standardized variable you want to create. The result is a
variable in which each element is equal to a plus b multiplied by the z-score of the
corresponding element of the variable being transformed, and, thus, is a standardized
variable with mean a and standard deviation b.

Q. Deviation From Mean returns a variable in which each element is equal to the
deviation of the corresponding element of the variable being transformed from the mean of
the variable being transformed.

P. Accumulate (X) returns a variable in which each element is the sum of all preceding
elements of the variable being transformed.

Variable Creating Transformations

Four options on the VARIABLE/CASE TRANSFORMATION menu create variables that are
added to the data matrix in the editor:

T. Trend/Case No. Variable creates a trend or case number variable, that is, a variable in
which the value of each element is equal to the number of the row in which that element is

located.

When you execute this option you are prompted to specify the name for the variable. The
variable is then added to the end of the data matrix in the editor.

V. Create Dummy Variables creates a set of dummy variables. When you execute this
option you are prompted to Create Seasonal Dummies?:

If you respond YES you are prompted to enter the Number Of Seasonal Units? per
time period. The result is a dummy variable for each seasonal period wherein the value
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of each element is 1 if the element corresponds to the season for which the variable is
defined and 0 otherwise. The names for these variables are then given as Dm1, Dm2,
etc. up to the number of seasonal periods, and you are given an opportunity to change
these names. The seasonal dummy variables are then added to the end of the data
matrix in the editor.

If you respond NO you are prompted to select the variable from which the dummy
variables are to be created. The result is a dummy variable for each value taken by the
selected variable. The value of each element in the dummy variable is equal to 1 if the
element corresponds to the value of the selected variable for which the dummy variable
is defined and 0 otherwise. Names for these variables are then given as Var(j), where
Var denotes the name of the selected variable and j the value of the selected variable
for which the dummy variable is defined. You are given an opportunity to change these
names. The dummy variables are then added to the end of the data matrix in the editor.

X. Generate Pattern Variables allows you to create pattern variables, that is, variables
that repeat the individual values of a sequence of consecutive integers from 1 to N, where
N is the number of values that the sequence takes. (You can also access this option from
the DATA MANAGEMENT menu.)

This option is useful in entering data for ANOVA routines. For example, the Sex, Union,
and Method variables in the XYZ Corporation data in Coding ANOVA Data repeat patterns
where N = 2, 2, and 3, respectively, and the number of repeats for each value = 3, 18, and
6.

When you execute this option you are prompted to enter the number of values (N), the
number of repeats for each value, and the number of cases in the variable. You are

then given the opportunity to enter a name for the pattern variable, and the new variable is
added to the end of the data matrix in the editor.

W. Generating Random Samples allows you to create random samples from a number of
probability distributions. (You can also access this option from the DATA MANAGEMENT
menu.)

When you execute this option you are presented with the GENERATING RANDOM
SAMPLES menu. All of the options on this menu follow a common format:

Click on the probability distribution from which you want to generate a random sample.
You are then prompted to enter:

The number or random samples you want to generate.

The values for the parameters that define the distribution you have selected.

The size of the samples.
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ASP then creates variable names for the samples being generated (Rnd1, Rnd2, etc.) and
you are given an opportunity to change these names.

The generated samples are then added as variables to the end of the data matrix in the
editor.

Case Transformations

The M. Case Transformations option on the VARIABLE/CASE TRANSFORMATIONS
menu allows you to calculate summary statistics for cases. When this option is executed
you are presented with the CASE TRANSFORMATION menu. This menu has options that
allow you to calculate 15 summary statistics for cases:

Mean Sample Variance

Median Sample Standard Deviation
Maximum Number of Nonmissing Values
Minimum Coefficient Variation

Variance Sum Of Squared Deviations
Sum Standard Deviation

Sum Of Squares Coefficient Median Sample

Standard Error

When an option on this menu is executed you are prompted to select the variables and
cases for which summary statistics are to be calculated.

The result is a variable in which each element is the corresponding summary statistic of the
cases of the variables selected to be transformed. This variable is then added to the end of
the data matrix in the editor.

Recoding Variables

The Recode Variables option on the DATA MANAGEMENT menu allows you to
systematically change the values of a set of variables.

You can execute this option by clicking on:
DATA MANAGEMENT -> Recode Variables.

(This option is also available on the MORE OPTIONS menu accessed by clicking on
MORE OPTIONS in the editor.)
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Format For Recoding A Set Of Variables
To recode a set of variables:

Click on DATA MANAGEMENT -> Recode Variables.

Select the set of variables you want to recode.

Select the option from the RECODE OPTIONS menu that you want to use to recode the
variables you have selected.

Use the option you have selected to select the values in the variables you have selected
that you want to recode.

Specify the value you want to replace the values you have selected to recode.
You are then presented with a menu of three options as to how to proceed:

C. Continue Recoding Current Variables allows you to continue recoding the current
variables.

L. List Original And Recoded Variables allows you to list the original and recoded
variables.

X. Exit And Record Recoded Variables allows you to exit the recode routine and
record the recoded variables.

The process of recoding a set of variables with the selected option continues until you
select the X. Exit And Recode Variables option on this menu.

When you have finished recoding the variables and exit the recode routine by executing the
X. Exit And Record Variables option, you are given the opportunity to rename the
recoded variables.

You are next prompted to choose between adding the newly recoded variables to the data
matrix or using these variables to replace the original variables.

The recoded variables are then added to the data matrix in the editor in the manner you
selected and you are returned to the RECODING OPTIONS menu.

Recoding Options

When the Recode Variables option is executed you are presented with the RECODING
OPTIONS menu. This menu has three options:
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A. Recode X = a allows you to recode a particular value (a) of the variable being
recoded. When this option is executed you are prompted to select a value to be recoded

(a).

B. a (<or<=) X (<or<=) b allows you to recode a range of values in the variable being
recoded. When this option is executed you are presented with a menu of interval
conditions that allows you to specify the conditions for selecting the range of values to
be recoded. You are then prompted to specify the minimum (a) and maximum (b)
values of the range of values to be recoded.

M. Multiple Selection Of Cases For Recode allows you to use the selecting cases
format to select values to be recoded.

Working With ASP Files

The data you enter in the editor is stored in your computer’s memory. When you exit ASP
your data is erased from memory and will be lost unless you save it in a file on a disk.

Once your data is saved in a file on a disk it is accessible to ASP at any time in the future.
All you have to do is open the file within ASP.

All of the file management options in ASP are available through the FILE menu on the left
in the Windows menu system at the top of the opening screen.

This menu contains options to open and save ASP files, to import and export ASCII files,
and to import data from the clipboard. In addition, it allows you to create a new data matrix,
list and print the data matrix in the editor, and to exit ASP.

The FILE menu also keeps track of the last five files you opened or saved by listing them at
the bottom of the menu. You can open any one of these files by clicking on its name in this
list.

The basic operations of saving and opening a standard ASP file are also available directly
within the editor by clicking on the SAVE MATRIX or OPEN FILE buttons on the data editor
tool bar.

Saving Data In An ASP386.SF File

ASP uses a standard Windows SAVE FILE form to save your data in a file. This form has a
Save in combo box at the top that is used to select the drive or folder on, or in which you
want to save your file.

There are four buttons located to the right of the Save in combo box:

The first from the left allows you to move back one level in the directory tree displayed
in the combo box.
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The second allows you to create a new folder in the folder displayed in the combo box.

The last two buttons allow you to change the way folders are displayed in the contents
window below the Save in combo box.

The contents window below the Save in combo box displays the contents of the object
given in the Save in combo box. If you double click on a drive or folder displayed in this
window, it will be moved to the Save in combo box and the contents of this drive or folder
will be displayed in the contents window.

The File name edit box below the contents window is where you enter the name for the file
in which you want to save your data.

The Save as type combo box allows you to select the type of file in which you want to save
your data. The standard ASP file format is the ASP386.SF format. This format can be
written and read by both DOS386 and ASP versions of ASP. The extension for this file
format is .SF.

The Cancel button allows you to exit the form without saving your data.

The Save button allows you to save your data in a file when the rest of the form is set
correctly.

To save your data in an ASP386.SF file:

Click on SAVE MATRIX in data editor tool bar. This will bring up the Windows SAVE
FILE form. (You can also save your data matrix from the FILE menu.)

Click on the open symbol to the right of the Save in combo box to select the drive or
folder on, or in which you want to save your data.

Double click in the contents window on the folder in which you want to save your data.

If you have not assigned a file name to your data, none will appear in the File name
edit box. If this is the case, click on none and replace it with the file name of your
choice.

Since you have clicked on SAVE MATRIX in the editor to save your data, the default in
the Save as type combo box will be ASP386(*.SF). This is the standard ASP file type.
Click on Save to save your file.

Respond YES to the resulting All Variables and Cases? prompt. (If you respond NO to
this prompt you are given the option of selecting the variables and cases to be saved in
the file.)

The data matrix in the editor will then be saved in a standard ASP386.SF file, along with its
file name, file label, case labels, and variable names on the disk you have chosen, in the
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folder you have chosen, and it will be assigned the name you have entered. The data you

have entered in the file information edit window will also be saved with this file.

Getting Data From An ASP386.SF File

Once data is saved in an ASP386.SF file you can access these data at any time by using

ASP to open the file in which the data are saved.
To open an ASP386.SF file:

Click on OPEN FILE on the data editor tool bar. (You can also open a file from the
FILE menu.) This will bring up a standard Windows OPEN FILE form. This form is
identical to the SAVE FILE form except that the Save button is relabeled Open, the

Save in combo box is relabeled Look in, and the Save as type combo box is relabeled

Files of type.

Click on the open symbol to the right of the Look in combo box to select the drive or
folder on, or in which the file you want to open is saved.

Double click in the contents window on the folder in which the file you want to open is
saved.

Click in the contents window on the file name of the file you want to open.

Click on Open to open the file.

The data matrix in the ASP386.SF file you have selected will then appear in the ASP editor

along with its file name, file label, case labels, and variable names. In addition, its file
information data can be accessed by clicking on FILE INFO on the data editor tool bar.

Saving And Opening An ASP.ASF File

The ASP.ASF file format was used by the original ASP program for the IBM XT. This format

is very limited in that the IBM XT computer could utilize only 1mb of memory.

You can save and open ASP.ASF formatted files in ASP using the same format you use to

save and open an ASP3386.SF file. (See SAVE/OPEN FILE.) The only difference is that
you must click on the Save as type or Files of type combo box and select the
ASPXT(*.ASF) option before you save or open the file.

Working With ASCII Files

There are three options for working with ASCII files on the File menu at the top of the
opening screen:

Import From ASCII File
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Export To ASCII File

Import Data From Clipboard

Importing From An ASCII File

You can use the Import From ASCII File option on the FILE menu to import data from a
file that is created in another program, such as a spread sheet or word processor, and
saved as an ASCII file by that program. ASP can read either a delimited or fixed field
format ASCII file.

Once the file is opened you are prompted to specify whether the file is a delimited of fixed
field file. If the file being opened is a fixed field file you must specify the number of variables
in the file and the width of each variable field.

The Import From ASCII File option assumes that the numbers stored in a delimited ASCI|I
file are delimited (i.e., separated) by either a space, a tab, or a comma, and that each case
is followed by a carriage return and a line feed character.

To execute the Import From ASCII File option click on
FILE -> Import From ASCII File.

This will bring up a standard Windows OPEN FILE form that is identical to the OPEN FILE
form used to open an ASP file, except that the default in the Files of type combo box is
ASCII(*.DAT). This means that only files with a DAT extension will be displayed in the
contents window of the form:

If the file you want to open has a DAT extension you can use the procedures outlined in
OPEN FILE to find and open the file.

If the file you want to open does not have a DAT extension you must click on the open
symbol to the right of the Files of type combo box to select the ALL(*.*) option. This will
show all of the files in the contents window that are in the drive or folder displayed in the
Look in combo box. You can then use the procedures outlined in OPEN FILE to find
and open the file that you want.

Once the file is opened you are prompted to specify whether the file is a delimited of fixed
field file:

If the file being opened is a fixed field file you must specify the number of variables in
the file and the width of each variable field.

If the file being opened is a delimited file you are prompted to specify the character
that is used to separate the individual data values.
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If variable names are included in the first row of the ASCII file they will be read in to the
data editor along with the numeric data. In addition, missing values in the file will be
replaced with the ASP missing value code.

Case labels cannot be read from an ASCII file.

Exporting To An ASCII File

You can use the Export To ASCII File option on the File menu to save your data in a file
that can be read by another program. To execute this option click on:

FILE -> Export To ASCII File.

This will bring up a standard Windows SAVE FILE form that is identical to the SAVE FILE
form used to save an ASP file, except that the default in the Save as type combo box is
ASCII(*.DAT). This means that only files with a DAT extension will be displayed in the
contents window of the form.

The format for exporting an ASCII file is the same as that for saving a standard ASP file,
except:

If you want to save the file with an extension other than DAT, you must enter the
extension in the File name edit box as well as the file name.

When you exit the SAVE FILE form you are presented with a SAVING ASCII FILE form
that contains two prompts and three check boxes, instead of the Save All Variables
And Cases? prompt in the standard format.

The prompts and checkboxes on the SAVING ASCII FILE form determine how the data will
be saved:

Number Of Decimal Places To Be Saved. This prompt allows you to specify the
number of decimal places to be saved in the ASCII file. ASP stores numeric data to 16
significant digits.

Code Missing Values As. This prompt allow you to replace the default missing value
code in the data to be saved. The default missing value code in ASP is 2 raised to the —
50 power (2-50). If you do not specify a replacement for this default, missing values will
be rounded to 0 when your data is saved.

Tab Delimited File. This check box allows you to save the data in a tab-delimited file. If
you uncheck this checkbox the file will be save as a space delimited file with a fixed field
format.

Add Variable Names To Beginning Of File . This check box allows you to add the
variable names to the beginning of the file. If you uncheck this checkbox the variable
names will not be added to the beginning of the file.
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All Variables And Cases. This checkbox allows you to save all variables and cases. If
you uncheck this check box you will be prompted to select variables and cases to be
saved when you exit the SAVE ASCII FILE form.

Importing From Clipboard

You can use the Import From Clipboard option on the File menu to quickly import data
from another program, such as a spreadsheet or word processor. You just copy the data
from the other program to the clipboard, start ASP, and click on:

FILE -> Import From Clipboard.
The data in the clipboard will instantly appear in the editor.
If there are missing values in the data they must be coded with an asterisk (*), a period (.),

or some other character before they are copied to the clipboard if ASP is to be able to read
the data.

Selecting Variables, Cases, and Samples
There are three routines examined in this section:

Selecting Samples

Selecting Variables

Selecting Cases

Selecting Samples

Many options in ASP give you a choice as to how you can select samples from your data
matrix through the SELECTING SAMPLES menu. There are four options on this menu:

A. Get Samples From Variables B. Get Samples From Variable X

C. Get Samples From Cases D. Break Down Var. X By Var. Y

A. Get Samples From Variables allows you to select a set of variables from the current
data matrix to be used for samples. When this option is executed you are prompted to
select variables to be used as samples in the routine being executed.

B. Get Samples From Variable X allows you to get samples from a single variable. When
this option is executed:

You are prompted to select the variable (X) from which the samples are to be selected.
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If the number of samples to be used in the routine being executed is not predefined, you
are prompted to specify the number of cases to select.

You are then prompted to select the first sample from the cases of the variable you
have specified through the SELECTING CASES menu. Once the cases for the first
sample have been selected you are prompted to specify the name of the sample that
has been selected.

You are then prompted to verify the correctness of the criteria by which the sample has
been selected.

If the criteria are OK you are prompted to repeat steps 3 through 5 until all of the
samples are selected.

C. Get Samples From Cases allows you to get samples from the cases in a set of
variables. When this option is executed you are prompted to select the variables from
which the cases are to be used as samples.

D. Break Down Var. X By Var. Y allows you to select samples by breaking down one
variable by another. When this option is executed you are prompted to select a data
variable (X) and a break down variable (Y). A sample is then constructed for each value of
Y from the corresponding values of X.

Selecting Variables

A common format is available throughout ASP for selecting variables to be used in
statistical and other routines. This format consists of a SELECTING VARIABLES form
with a SELECT FROM list box on the left that contains the names of the variables to be
selected from. On the right is one or more list boxes to which the variable names selected
from the list on the left are moved.

Above each list box on the right is an option button. Clicking on this button makes the list
box active. This option button also contains a caption that identifies the purpose of the of
the list box.

There are four other buttons on the SELECTING VARIABLES form:

The SELECT-> button allows you to transfer names highlighted in the list box on the left
to the active list box on the right.

The <-UNSELECTED button allows you to transfer the names highlighted in the active
list box on the right back to the list box on the left.

The CONTINUE button allows you to continue to the next step in the analysis when
your selections are complete.

The CANCEL button allows you to abort the analysis and exit the SELECTING
VARIABLES form without making a selection.
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The SELECTING VARIABLES form may contain an Include All Cases check box at
the bottom, depending on whether it is appropriate to select cases in the particular
situation at hand. By default, this check box is checked. If you want to select a subset of
cases from the variables you have selected you must uncheck this box by clicking on it
before you exit the SELECTING VARIABLES form. When this box is unchecked you
will subsequently be presented with the Selecting CASES menu.

Highlighting Variable Names To Select
The are two ways to highlight a single variable name in a list box.

Click on the variable name you want to highlight. This in itself will highlight the variable
name.

Or

Use the Tab key to select the list box that contains the variable name you want to
highlight.

Use the cursor keys to move the highlight bar to the variable name you want to
highlight.

If the active list box to which the highlighted variable names are to be moved can contain
more than a single variable name, you can highlight multiple variable names in the list box
from which the names are to be moved. There are three ways to highlight multiple variable
names in a list box:

If the multiple variable names to be highlighted are contiguous:
Click on the first variable name you want to highlight

While holding down the left mouse button, drag the highlighting to the last name you
want to highlight.

Or

Use the Tab key to select the list box that contains the variable name you want to
highlight.

Use the cursor keys to move the highlighted bar to the first variable name you want to
highlight.

Hold down the Shift key.

Use the cursor keys to move the highlighting to the last variable name you want to
highlight.
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If the multiple variable names to be highlighted are not contiguous:
Click on the first variable name you want to highlight.
Hold down the Ctrl key.
Click on the next variable name you want to highlight.

Repeat until all of the names you want to highlight are highlighted.

Format For Selecting Variables

To select variables using the SELECTING VARIABLES form you move variable names
from the SELECT FROM list box on the left to the list boxes on the right. To do this:

Click on the option button above the list box on the right to which you want to move
variable names. This will make it the active list box.

Highlight the variable name(s) in the SELECT FROM list box on the left that you want to
move to the active list box on the right.

Click on SELECT-> to move the highlighted names in the SELECT FROM list box on
the left to the active list box on the right.

Highlight any variable name(s) in a list box on the right that should not be there.

Click on -=>UNSELECT to move the highlighted names back to the SELECT FROM list
box.

Continue the above until all selections are correct.

Click on the Include All Cases check box to uncheck it if you want to select cases from
the set of variables you have selected. Otherwise, leave this check box checked.

Click on CONTINUE to continue to the next step in the analysis.

Selecting Cases

The SELECTING VARIABLES form may contain an Include All Cases check box at the
bottom depending on whether it is appropriate to select cases in the particular situation at
hand. By default, this check box is checked. If you want to select a subset of cases from
the variables you have selected, you must uncheck this box by clicking on it before you exit
the SELECTING VARIABLES form.

If the Include All Cases check box is unchecked when you exit the SELECTING
VARIABLES form you are presented with the SELECTING CASES menu. This menu
provides six options for selecting cases from the variables you have selected, an option for
listing the cases you have selected, and an option that allows you to start over if necessary.
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Selecting Cases Options
There are six options on the SELECTING CASES menu that allow you to select cases:

D. Select Cases Directly N. Select Cases By Consecutive Row Number
A. Select Cases If: X (<, >, =, B. Select Cases If: X1 (<, >, =, etc.) X2
etc.) a

C. Select Cases By Case Label R. Select Cases By Random Sample

D. Select Cases Directly allows you to select individual cases directly. The format for
doing this is identical to the format for selecting a set of variables except that case labels
are listed in the SELECT FROM list box instead of variable names.

N. Select Cases By Consecutive Row Numbers allows you to select cases that have
consecutive row numbers. When you choose this option you are prompted to specify the
beginning row number and the ending row number of the set of cases you want to select.

A. Select Cases If: X (<,>,=,etc.) a allows you to select cases for which the individual
values of a variable (X) are in a specific relation to a constant (a). When you choose this
option you are prompted to:

Select a relation from the relations options menu.
Select the X variable.
Specify a value for a.

B. Select Cases If: X1 (<,>,=,etc.) X2 allows you to select cases for which the individual
values of a variable (X1) are in a specific relation to a second variable (X2). When you
choose this option you are prompted to:

Select a relation from the relations options menu
Select the X1 and X2 variables.

C. Select Cases By Case Label allows you to select cases that correspond to a particular
case label. The format for doing this is identical to the format for selecting variables except
that case labels are listed in the SELECT FROM list box instead of variable names.

R. Select Cases By Random Sample allows you to select a random sample of cases.
When you choose this option you are prompted to specify the size of the sample you want
to select.
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Format For Selecting Cases
To select cases using the SELECTING CASES menu:

Select the option on the selecting cases menu that you want to execute.

Respond to the prompts generated by the option you have selected. You are then
prompted to:

Select More Cases?

Respond NO to this prompt if you want to continue including only the cases you have
previously selected.

Respond YES if you want to select more cases.

If you respond YES to the "Select More Cases?" prompt you are given the opportunity to
select more cases using the option you selected initially. When you have selected
additional cases by completing the input for this option, you are given a menu with three
options:

+. ADD To Previously Selected Cases allows you to add the cases you have just
selected to the cases you previously selected.

-. SUBTRACT From Previously Selected Cases allows you to subtract the cases you
have just selected from the cases you previously selected.

&. SELECT From Previously Selected Cases allows you to select the cases you have
just selected only if they are among the cases you previously selected.

You are then prompted to Select More Cases? You can continue to select cases until you
press NO in response to this prompt.
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Miscellaneous Statistical Routines

There are three miscellaneous statistical routines examined here:

Summary Statistics

Correlation Matrices

Crosstab/Contingency

Summary Statistics

Summary statistics can be obtained in ASP by clicking on:

STATISTICS -> Summary Statistics.

You are then prompted to select the variables and cases for which the summary statistics
are to be calculated, and are given the option of selecting which summary statistics you
wish to calculate. Thirty three summary statistics are available:

Variance

Geometric Mean

Range
Minimum
Maximum
Sum

First Quartile

Third Quartile

Standard Error Of The Mean

Missing Values

Valid Observations

Sample Variance

Standard Deviation

Sample Standard Deviation

Harmonic Mean

Coefficient Of Variation

Sample Coefficient Of Variation

Interquartile Range

Lower Adjacent Value
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Minor Outliers Upper Adjacent Value
Major Outliers Sum Of Squared Deviations
Sum Of Squares Coefficient Of Skewness
Third Moment Coefficient Of Kurtosis
Second Moment Mean Absolute Deviation

Fourth Moment

If we denote the nonmissing elements of a variable X (i.e., those elements in X that are not
equal to the missing value code) by Xi where i = 1 to N, the statistics calculated by this
option are as follows:

The Mean of X is the sum of the nonmissing elements in X divided by the total number of
nonmissing elements in X :

_ o

X= [Z x!} = I
iml

The Maximum of X is the largest of the nonmissing elements in X. The Minimum of X is

the smallest of the nonmissing elements in X. The Range of X is the maximum of X less
the minimum of X.

The Valid Observations of X is the number of nonmissing elements in X. Missing Values
is the number of elements in X that are missing, that is, that are equal to the missing value
code.

The Sample Standard Dev. (sample standard deviation) of X is the square root of the sum
of the squared deviations of the nonmissing elements in X from the mean of X divided by
the number of nonmissing elements in X less 1:

5= [[i[x -Eﬂ (- 1)]”2_

The Sample Variance of X is the square of the sample standard deviation of X. The
Sample Cof. Of Var. (sample coefficient of variation) of X is 100 times the sample standard
deviation of X divided by the mean of X. The Standard Error Of Mean of X is the sample
standard deviation of X divided by the square root of the number of nonmissing elements in
X.

The Median of X is such that fifty percent of the nonmissing elements in X are less than or
equal to the median, and fifty percent of the nonmissing elements in X are greater than or
equal to the median.
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The First Quartile of X is such that twenty-five percent of the nonmissing elements in X are
less than or equal to the first quartile, and seventy-five percent of the nonmissing elements
in X are greater than or equal to the first quartile. The Third Quartile of X is such that
seventy-five percent of the nonmissing elements in X are less than or equal to the third
quartile, and twenty-five percent of the nonmissing elements in X are greater than or equal
to the third quartile. The Interquartile Range of X is the third quartile of X less the first
quartile of X.

The Lower Adjacent Value of X is the lowest value of X within 1.5 interquartile ranges
below the first quartile. The Upper Adjacent Value of X is the highest value of X within 1.5
interquartile ranges above the third quartile.

The Minor Outliers of X is the number of values of X that fall between 1.5 and 3
interquartile ranges above the third quartile or below the first quartile. The Major Outliers
of X is the number of values of X that fall beyond 3 interquartile ranges above the third
quartile or below the first quartile.

The Standard Deviation of X is the square root of the sum of the squared deviations of the
nonmissing elements in X from the mean of X, divided by the number of nonmissing
elements in X:

o= Hi_l (xi— E)ﬁ] + NJM_

The Variance of X is the square of the standard deviation of X. The Coefficient Of Var.
(coefficient of variation) of X is 100 times the standard deviation of X divided by the mean
of X. The Sum of X is the sum of the nonmissing elements of X.

The Sum Of Squares of X is the sum of the squared nonmissing elements of X. The Sum
Of Squared Dev. (sum of squared deviations) of X is the sum of the squared deviations of
the nonmissing elements of X from the mean of X:

S50 = %(n - X

il

The Second Moment of X is the sum of the squared deviations of X divided by the number
of nonmissing elements in X. The Third Moment of X is the sum of the deviations of X
raised to the third power divided by the number of nonmissing elements in X.

p(3) = [Z (xi— E’;F} N

i=1

The Fourth Moment of X is the sum of the deviations of X raised to the fourth power
divided by the number of nonmissing elements in X.
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mld) = (i (xi— Z’}“J = N

The Coefficient Of Skewness of X is the third moment of X divided by the sample
standard deviation of X raised to the third power. The Coefficient Of Kurtosis of X is the
fourth moment of X divided by the sample standard deviation of X raised to the fourth
power. The Geometric Mean of X is the Nth root of the product of the Xi:

W
gm = 1_[ &
ﬁ il

Harmonic Mean of X is the reciprocal of the arithmetic mean of the reciprocal of the Xi:

P 1 N
RN
Nidx il &

Mean Absolute Dev. of X is the arithmetic mean of the absolute value of the deviations of
the Xi from the mean of the Xi:

wactct :[ixi—m}w

iml

The Mode of X is the most frequent value of the Xi.

Correlation Matrices

ASP allows you to calculate both product moment and rank order correlation matrices. To
calculate a correlation matrix click on:

STATISTICS -> Correlation Matrix.

In response, you are prompted to select the variables and cases from which the correlation
matrix is to be calculated, and then to choose between calculating a product moment or a
rank order correlation matrix. The correlation matrix is then displayed.

When you exit the correlation matrix output by clicking on CONTINUE, a matrix of p-values
for the correlations in the correlation matrix is calculated and displayed. If you exit the
correlation matrix output by clicking on CANCEL or by pressing Esc, the matrix of p-values
is not displayed.

If a rank order correlation matrix is to be calculated the program automatically calculates
the ranks for each variable before any correlations are computed. The correlation matrix is
then displayed.
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This routine does not adjust for tied ranks. However, the O. R.O. Correlation (XY) = x
option on the HYPOTHESIS TESTS menu also calculates a rank order correlation
coefficient that does adjust for tied ranks. (Zar)

Crosstab/Contingency Table Analysis
To analyze a contingency table click on:
STATISTICS -> Crosstab/Contingency.

In response you are prompted to choose between creating a contingency table by
crosstabulating two variables or by entering a table directly from a data matrix:

If you choose to crosstabulate two variables you are prompted to select these variables.

If you choose to enter a contingency table directly the columns of the table must be
stored as variables in a data matrix and the rows of the table as cases. You must then
select the variables and cases that make up the table.

The output from the crosstab/contingency table analysis includes not only the contingency
table but also a chi square statistic along with its p-value; Cramer’s V and gamma statistics;
lambda, Somer’s d, and the Goodman/Kruskal Tau as well as the inverse values of these
statistics; and Kendall’s Tau a, b, and c. In addition, Fisher’s exact test is computed for 2
by 2 tables.

When the contingency table output is exited by clicking on CONTINUE the CROSSTAB
OPTIONS menu is displayed. This menu gives you the option of listing the contingency
table as expected frequencies, percentages of column totals, percentages of row totals,
and as percentages of the total number of observations. You are also given the option of
listing differences in percentages on the contingency table and of calculating the individual
cell chi squares. Finally, you have the option of estimating a chi squared test for trend.

If the contingency table output is exited by clicking on CANCEL or by pressing Esc the
analysis is aborted and the CROSSTAB OPTIONS menu does not appear. (Blalock,
Handel)
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Probability Distributions

The PROBABILITY DISTRIBUTIONS menu can be obtained by clicking on:
STATISTICS -> Probability.

There are 13 probability distribution options on this menu:

A. Normal B.t

F.F D. Chi Square
E. Beta F. Gamma

G. Exponential H. Weibull

|. Hypergeometric J. Geometric
L. Negative Binomial K. Binomial
M. Poisson

The options on this menu allow you to find probabilities from the cumulative distribution
functions of the indicated distributions.

In the case of continuous distributions, they also allow you to find the table values of the
cumulative distribution functions as well, and in the case of discrete distributions to find the
values of the density functions.

If a probability or table value cannot be calculated, the program returns an asterisk (*).

Continuous Distributions

There are eight continuous distribution options on the PROBABILITY DISTRIBUTIONS

menu:
A. Normal B.t
C.F D. Chi Square
E. Beta F. Gamma

G. Exponential H. Weibull
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These options can be used to find the:
Probability of obtaining a number less than or equal to a given number.
Table value corresponding to a given cumulative probability.

When one of these options is executed you are prompted to choose between finding a
probability or the table value of the cumulative distribution function of the distribution:

If you choose to find a probability you are prompted to enter the calculated value for
which the probability is to be found.

If you choose to find a table value the program responds by prompting you to enter the
probability for which the Table value is to be found.

The way in which the program continues depends on the particular option being
executed. (Frank and Althoen, Kohler, Sincich, Zar)

Normal

The A. Normal option on the PROBABILITY DISTRIBUTIONS menu gives the standard
normal distribution with mean 0 and standard deviation 1:

P(Z<x) = % [e%faz
?E-—ID

The table value or probability must be specified for this option.

t Distribution

The B. t option on the PROBABILITY DISTRIBUTIONS menu gives the student t
distribution with a degrees of freedom:

Tila+1)/2)

Fit = = T
t=xla) danT(al2)

The number of degrees of freedom must be specified for this option as well as the table
value or probability.

F Distribution

The C. F option on the PROBABILITY DISTRIBUTIONS menu gives the F distribution
with a degrees of freedom in the numerator and b degrees of freedom in the denominator:
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Both the numerator and denominator degrees of freedom must be specified for this option
as well as the table value or probability.

Chi Square

The D. Chi Square option on the PROBABILITY DISTRIBUTIONS menu gives the chi
square distribution with a degrees of freedom:

1 iXaIEE—XIEM
Tia /24128

1]

FlX =x|a)=

The degrees of freedom must be specified for this option as well as the table value or
probability.
Beta

The E. Beta option on the PROBABILITY DISTRIBUTIONS menu gives the beta
distribution with parametersaand b :

1
(a,&)

Plx=x|ald)= ; jXﬂ‘l(l—X)""‘lciX

Both a and b must be specified for this option as well as the table value or probability.

Gamma

The F. Gamma option on the PROBABILITY DISTRIBUTIONS menu gives the
standardized gamma distribution with shape parameter a:

PX Zx|a)= Lj Yelg Xy
T(a);

The shape parameter must be specified for this option as well as the table value or
probability.

Exponential

The G. Exponential option on the PROBABILITY DISTRIBUTIONS menu gives the
exponential distribution with mean a :

PlX =x|a)=1-g7"
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The distribution mean must be specified for this option as well as the table value or
probability.

Weibull

The H. Weibull option on the PROBABILITY DISTRIBUTIONS menu gives the
standardized Weibull distribution with shape parameter a and scale parameter b:

P(X =x|a,b)=1-eg7"2F

The shape and scale parameters of the distribution must be specified for this option as well
as the table value or probability.

Discrete Distributions

There are five discrete distribution options on the PROBABILITY DISTRIBUTIONS menu:

|. Hypergeometric J. Geometric
L. Negative Binomial K. Binomial
M. Poisson

These options can be used to find the probability of obtaining a number less than or equal
to a given number. The probability of obtaining the number itself is given as well.

When one of these options is executed you are prompted to choose between finding just
the value of the cumulative distribution function or all of the intermediate values as well.
The way in which the program continues depends on the particular option being executed.
(Erank and Althoen, Kohler, Sincich, Zar)

Hypergeometric

The I. Hypergeometric option on the PROBABILITY DISTRIBUTIONS menu gives the
hypergeometric distribution where x is the number of successes in a trials, b is the size of
the population, and ¢ is the number of successes in the population:

s S

All four of these parameters must be specified for this option.
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Geometric

The J. Geometric option on the PROBABILITY DISTRIBUTIONS menu gives
the geometric distribution where x equals number of trials until the first success, and a is
the probability of a success:

P(X =x|a)=a(l-a)™
Both of these parameters must be specified for this option.

Negative Binomial

The L. Negative Binomial option on the PROBABILITY DISTRIBUTIONS menu gives
the negative binomial distribution where is the number of failures before a successes
and b is the probability of a success.

il o=

P(X5x|a,b)=i[i+a11](1—bj"bﬂ

All three of these parameters must be specified for this option.

Binomial

The K. Binomial option on the PROBABILITY DISTRIBUTIONS menu gives the binomial
distribution where x is the number of successes in a trials, and b is the probability of a
success:

PX =x|ab)= Zx:[‘_ﬁ](l—b)“b"
I

i=ll
All three of these parameters must be specified for this option.

Poisson

The M. Poisson option on the PROBABILITY DISTRIBUTIONS menu gives the Poisson

distribution where x is the number of occurrences, and a is the mean and variance of the
distribution of X :

FX =x|a)= i(e'ﬂai) /il

iml]l

Both of these parameters must be specified for this option.
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Combinations, Permutations, Exponentials, And Factorials

In addition to the 13 probability distribution options on the PROBABILITY DISTRIBUTIONS
menu, there are five options that perform summary calculations:

N. P = Factorial a gives the value of factorial a.

O. P = Ln Factorial a gives the value of the natural log of factorial a.

P. P = Perm.(a/b) gives the number of permutations in a things taken b at a time.
Q. P = Comb.(a/b) gives the number of combinations in a things taken b at a time.
R. P = a ? b gives the value of a raised to the power b.

When one of these options is executed you are prompted to enter the values for the
parameters that must be specified.
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Hypothesis Tests

You can access the HYPOTHESIS TESTS menu by clicking on:
STATISTICS -> Hypothesis Tests.

Twenty three hypothesis test options, both parametric and non parametric, are available on

this menu:
A. Mean X =x B. Mean X = Mean Y
C. Proportion X = x D. Proportion X=Proportion Y
E. Variance X = x F. Variance X = Variance Y
G. Confidence Interval H. Wilcoxon Rank-Sum
[. Mann-Whitney Test J. Sign Test
K. Wilcoxon Signed-Rank L. Runs Test
M. Kruskal-Wallis Test N. Kolmogorov-Smirnov
0. R.O. Correlation (XY) = x P. Friedman Test
Q. Cochran’s Q R. P.M. Correlation (XY) = x
S. Goodness Of Fit Test T. Control Charts
U. Concordance Tests V. Cor(XY) = Cor(VW)

W. Power/Sample Size/Difference

The format by which you undertake these tests depends of the particular routine you
choose. (Frank and Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Single Sample Hypothesis Tests

There are five single sample hypothesis test options on the HYPOTHESIS TESTS menu:

A. Mean X = x C. Proportion X = x
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E. Variance X = x J. Sign Test

L. Runs Test
You can access these tests by clicking on:
STATISTICS -> Hypothesis Tests.
These options follow a common format:

When one of these options is executed you are prompted to choose between
calculating statistics from a variable chosen from the current data matrix or from
numbers entered by you.

In the cases of options A and E you are prompted to specify whether the sample is
drawn from a large or small population.

At this point, the course by which the program proceeds depends on whether test
statistics are to be calculated from a variable selected from the current data matrix or
from numbers entered by you.

If statistics are to be calculated from a variable selected from the current data matrix
you are prompted to select this variable.

If statistics are to be calculated from numbers entered by you, you are prompted to
enter the appropriate numbers.

In the cases of options A, C, and E you are prompted to specify a value for x.

If you are dealing with a small population (Kohler) you must next specify the size of the
population.

The output produced by the option being executed is then generated. (Frank and Althoen,
Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar )

t Test Of Population Mean

The hypothesis that a population mean equals a specific number can be tested by
executing the A. Mean X = x option on the HYPOTHESIS TESTS menu. (See Single
Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the mean, variance, and the size of the sample.

In either case you are prompted to enter the hypothesized value (x) and, for small
population tests, the size of the population.
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The output generated by this option includes the difference between the sample mean and
the hypothesized population mean along with the value of the t statistic for the null
hypothesis that this difference is equal to zero. The degrees of freedom for this t statistic
are listed along with the probability value and the probability value divided by two. The
standard error of the estimated difference between the sample mean and the hypothesized
population mean is also given. (Frank and Althoen, Kohler, McClave and Benson, Siegel,
Hays, Sincich, Zar)

Test Of Population Proportion

The hypothesis that a population proportion equals a specific number can be tested by
executing the C. Proportion X = x option on the HYPOTHESIS TESTS menu. (See Single
Sample Hypothesis Tests.)

For the purpose of this test the program assigns a one to any value in a variable that is
greater than or equal to the mean of the variable and a zero otherwise. The program then
examines the proportion of ones.

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the number of successes in the sample from which the test statistics are to be calculated,
the size of this sample, and the hypothesized value (x).

The output generated by this option includes the difference between the sample proportion
and the hypothesized population proportion along with the value of the normal
approximation Z statistic for the null hypothesis that this difference is equal to zero. The
Probability value and the probability value divided by two for this statistic are also listed.
Also, the standard error of the estimated difference between the sample proportion and the
hypothesized population proportion is given.

In addition, the exact p-values for this test derived from the binomial distribution are given.

This test is approximate in finite samples. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)

Sign Test For Median (Single Sample)

A single sample sign test can be run by executing the J. Sign Test option on the
HYPOTHESIS TESTS menu and clicking on ONE in response to the ONE Or TWO
Sample Test? prompt. (See Single Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the size of the sample (i.e., number of nonzero differences), number of successes or
failures, and the hypothesized value of the median (x).

The output generated by this option includes the probability value of the number of
successes or failures and this probability value divided by two. (Zar)
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Test Of Population Variance

The hypothesis that a population variance equals a specific number can be tested by
executing the E. Variance X = x option on the HYPOTHESIS TESTS menu. (See Single
Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the variance of the sample from which the statistics are to be calculated and the size of this
sample.

In either case you are prompted to enter the hypothesized value (x).

The output generated by this option includes the value of the chi square statistic for the null
hypothesis that the value of the population variance is equal to the hypothesized value
along with its degrees of freedom, probability value, and probability value divided by two.
(Frank and Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Runs Test

A runs test can be run by executing the L. Runs Test option on the HYPOTHESIS TESTS
menu. (See Single Sample Hypothesis Tests.)

For the purpose of this test the program assigns a one to any value in an input variable that
is greater than or equal to the mean of that variable and a zero otherwise. The program
then examines runs of zeros and ones.

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the number of positive runs, the number of positive values, and the size of the sample.

The output generated by this option includes the Z statistic for the null hypothesis that the
set of runs is random, the probability value and the probability value over two for this Z
statistic, and the standard error of the number of positive runs.

This test is approximate in finite samples. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)

Two Sample Hypothesis Tests

There are nine two sample hypothesis test options on the HYPOTHESIS TESTS menu:

B. Mean X = Mean Y D. Proportion X = Proportion Y

F. Variance(X) = Variance(Y) H. Wilcoxon Rank Sum

I. Mann-Whitney Test J. Sign Test
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K. Wilcoxon Signed Rank 0. R.O. Correlation(XY) = x

R. P.M. Correlation (XY) = x

You can access these tests by clicking on:
STATISTICS -> Hypothesis Tests.
These options follow a common format:

When one of these options is executed you are first prompted to choose between
calculating statistics from samples chosen from the current data matrix or from numbers
entered by you.

The course by which the program proceeds depends on which of these two options is
chosen.

If statistics are to be calculated from numbers entered by you, you are prompted to
enter the appropriate numbers. The numbers to be entered depend on the particular
test being executed and are explained in the section for each test.

If statistics are to be calculated from samples chosen from the current data matrix you
are prompted to select the samples through the SELECTING SAMPLES menu.

The output produced by the option being executed is then generated. (Frank and Althoen,
Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Difference Of Means Tests

The hypothesis that the difference between two population means is zero can be tested by
executing the B. Mean X = Mean Y option on the HYPOTHESIS TESTS menu. (See Two
Sample Hypothesis Tests.)

The hypothesis that this difference is equal to some non-zero number a can be tested by
adding a to the variable X or Y before this option is executed.

When this option is executed you are prompted to specify whether the samples are
independent or contain matched pairs. For independent samples, you are prompted to
specify whether the population variances are equal.

If statistics are to be calculated from numbers entered by you, you are also prompted to
enter the mean, variance, and size of each sample.

The output generated includes the difference between the two sample means along with
the value of the Z statistic for the null hypothesis that the population difference is equal to
zero. The probability value and the probability value divided by two for this statistic are
listed, and an estimate of the standard error of the estimated difference between the two
population means is given.
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For matched pairs, if statistics are to be calculated from numbers entered by you, you are
prompted to enter the mean of the sample differences along with the sample variance and
size.

The output generated includes the value of the t statistic for the null hypothesis that the
mean of the differences is equal to zero. The degrees of freedom for this t statistic are also
listed along with its probability value and its probability value divided by two. The standard
error of the estimated mean of the matched pair differences is given. (Erank and Althoen,
Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Difference Of Proportions Tests

The hypothesis that the difference between two population proportions is zero can be
tested by executing the D. Proportion X = Proportion Y option on the HYPOTHESIS
TESTS menu. (See Two Sample Hypothesis Tests.)

The hypothesis that this difference is equal to some non-zero number a can be tested by
adding a to the variable X or Y before this option is executed.

For the purpose of this test the program assigns a one to any value in a sample that is
greater than or equal to the mean of the sample and a zero otherwise. The program then
examines the proportion of ones.

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the proportion and size of each sample (X and Y).

The output generated by this option includes the difference between the two sample
proportions along with the value of the Z statistic for the null hypothesis that this difference
is equal to zero. The probability value and the probability value divided by two for this
statistic are also listed along with the standard error of the estimated difference between
the two population proportions.

This test is approximate in finite samples. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)

Wilcoxon Rank-Sum Test

A Wilcoxon rank-sum test can be run by executing the H. Wilcoxon Rank-Sum option on
the HYPOTHESIS TESTS menu. (See Two Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the size of the two samples (X and Y), and then the sum of the X ranks.

The output generated by this option includes the Z statistic for the null hypothesis that the
two populations are identical, the probability value and the probability value over two for
this statistic, and the standard error of the sum of the X ranks.
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This test is approximate in finite samples and is generally considered to be acceptable only
if the size of each sample is 10 or greater. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)

Mann-Whitney Test

A Mann-Whitney test can be run by executing the I. Mann-Whitney test option on the
HYPOTHESIS TESTS menu. (See Two Sample Hypothesis Tests.)

The format by which this option is executed is identical to that by which the H. Wilcoxon
Rank-Sum option is executed.

The output for these two tests are also identical except that the output of the Mann-Whitney
test option reports the Mann-Whitney U statistic, and the standard error reported in this
output is the standard error of both the sum of X ranks and the U statistic.

This test is approximate in finite samples and is generally considered to be acceptable only
if the size of each sample is 20 or greater. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)

Sign Test (Two Sample)

A two sample sign test can be run by executing the J. Sign Test option on the
HYPOTHESIS TESTS menu and responding TWO in response to the ONE Or TWO
Sample Test? prompt. (See Two Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the size of the sample (i.e., Number of nonzero differences) and then the number of
differences that are positive in the sample.

The output generated by this option includes the probability value of the number of positive
values, given the null hypothesis that the two samples are identical, along with this value
divided by two and the standard error of the estimated number of positive values.

This test uses the binomial distribution and is exact. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)

Wilcoxon Signed-Rank Test

A Wilcoxon signed-rank test can be run by executing the K. Wilcoxon Signed-Rank option
on the HYPOTHESIS TESTS menu. (See Two Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the size of the sample (i.e., number of non-zero differences), and the sum of the negative
or positive signed ranks, whichever is smaller in absolute value.

The output generated by this option includes the Z statistic for the null hypothesis that the
two populations are identical, the probability value and the probability value over two for
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this statistic, and the standard error of the minimum sum of the negative and positive
signed ranks statistic.

This test is approximate in finite samples and is generally considered to be acceptable only
if the sample size is 10 or greater. (Frank and Althoen, Kohler, McClave and Benson,
Siegel, Hays, Sincich, Zar)

Rank Order Correlation Test

A test that a Spearman rank order correlation coefficient is equal to a specific number can
be run by executing the O. R.O. Correlation (XY) = x option on the HYPOTHESIS
TESTS menu. (See Two Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the size of the sample, the sample rank order correlation coefficient, and the hypothesized
population correlation coefficient (x).

The output generated by this option depends on the hypothesized population correlation
coefficient (x):

When the hypothesized population correlation coefficient (x) is not equal to 0 the
output generated includes the Fisher r to z transform, the Z statistic for the null
hypothesis that the correlation between the two variables is equal to the hypothesized
population value (x), the probability value and the probability value over two for this
statistic, and the standard error of the estimated correlation coefficient. In calculating z
the Fisher transformation is adjusted by r/2(n-1). (Zar)

When the hypothesized population correlation coefficient (x) is equal to 0 the
output generated includes the t statistic for the null hypothesis that the correlation
between the two variables is equal to 0, the probability value and the probability value
over two for this statistic, and the standard error of the estimated correlation coefficient.

This test is approximate in finite samples and is generally considered to be acceptable only
if the sample size is 10 or greater and the sample probability is less than or equal to 9. The
correlation coefficient is adjusted for ties. (Zar)

Product Moment Correlation Test

A test that a product moment correlation coefficient is equal to a specific number can be
run by executing the R. P.M. Correlation(XY) = x option on the HYPOTHESIS TESTS
menu. (See Two Sample Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the sample size, the product moment correlation coefficient, and the hypothesized
population correlation coefficient (x). The output generated by this option depends on the
hypothesized value for x:
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The output generated by this option when x is not equal to 0 includes the Fisher r
to z transformation, the Z statistic for the null hypothesis that the correlation between
the two variables is equal to the hypothesized population value (x), the probability value
and the probability value over two for this statistic, and the standard error of the
estimated correlation coefficient. In calculating z the Fisher transformation is adjusted
by r/2(n-1). (Zar)

The output generated by this option when x is equal to 0 includes the t statistic for
the null hypothesis that the correlation between the two variables is equal to 0, the
probability value and the probability value over two for this statistic, and the standard
error of the estimated correlation coefficient.

(Frank and Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Equality Of Two Variances Test

A test of the equality of two population variances can be run by executing the F.
Variance(X) = Variance(Y) option on the HYPOTHESIS TESTS menu. (See Two Sample
Hypothesis Tests.)

If statistics are to be calculated from numbers entered by you, you are prompted to enter
the variance and size of each sample (X and Y).

The output generated by this option includes the F statistic for the null hypothesis that the
two variances are identical along with its numerator and denominator degrees of freedom.
The probability value and the probability value divided by two for this statistic are also
reported. (Frank and Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Multiple Sample Nonparametric Tests

There are four multiple sample nonparametric test options on the HYPOTHESIS TESTS
menu:

M. Kruskal Wallis Test P. Friedman Test

Q. Cochran’s Q R. Concordance Test

You can access these tests by clicking on:
STATISTICS -> Hypothesis Tests.
These options follow a common format:

When one of the multiple sample options is executed you are prompted to select the
samples through the SELECTING SAMPLES menu.
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Once the samples have been selected you are prompted to compute ranks within the
input data. You must click on YES in response to this prompt unless the ranks have
already been computed.

You are then asked if you wish to suppress the data matrix. If you respond YES to this
prompt a listing of the data matrix will not be added to the output. If you respond NO
the data matrix will be added to the output.

The output produced by the option being executed is then generated by the program.

The specifics output generated depends on the particular option being executed. (Frank
and Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar )

Kruskal-Wallis Test

A Kruskal-Wallis Test can be run by executing the M. Kruskal-Wallis Test option on the
HYPOTHESIS TESTS menu. (See Multiple Sample Nonparametric Tests.)

The output generated by this option includes the chi square statistic, along with its degrees
of freedom and probability value, for the null hypothesis that the samples come from the
same population.

This test is approximate in finite samples and is generally considered to be acceptable only
if each sample size is 5 or greater. The algorithm used in calculating chi square adjusts for
ties. (Frank and Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Friedman Test

A Friedman test can be run by executing the P. Friedman Test option on the
HYPOTHESIS TESTS menu. (See Multiple Sample Nonparametric Tests.)

The output for this option consists of the chi square statistic, along with its degrees of
freedom and probability value, for the null hypothesis that there are no differences in effects
of the N treatments on the experimental groups.

This test is approximate in finite samples and is generally considered to be acceptable only
if the sample size is 10 or greater. (Frank and Althoen, Kohler, McClave and Benson,
Siegel, Hays, Sincich, Zar)

Cochran's Q Test

A Cochran’s Q test can be run by executing the Q. Cochran’s Q option on the
HYPOTHESIS TESTS menu. (See Multiple Sample Nonparametric Tests.)

For the purpose of this test the program assigns a one to any value in an input sample that
is greater than or equal to the mean of this sample and a zero otherwise.
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The output generated by this option includes the Cochran’s Q statistic, along with its
degrees of freedom and probability value, for the null hypothesis that there are no
differences in the effects of the N treatments on the experimental groups. (Frank and
Althoen, Kohler, McClave and Benson, Siegel, Hays, Sincich, Zar)

Kendall's Coefficient Of Concordance

Kendall’s coefficient of concordance test can be run by executing the U. Concordance test
option on HYPOTHESIS TESTS the menu. (See Multiple Sample Nonparametric Tests.)

The output generated by this option includes Kendall’s coefficient of concordance statistic
and a chi square statistic, along with its degrees of freedom and probability value, for the
null hypothesis that the rankings are random.

This test is approximate in finite samples and is generally considered to be acceptable only
if the sample size is 8 or greater. (Frank and Althoen, Kohler, McClave and Benson,
Siegel, Hays, Sincich, Zar)

Goodness Of Fit/Kolmogorov-Smirnov Tests

The S. Goodness Of Fit test and N. Kolmogorov-Smirnov options on the HYPOTHESIS
TEST menu generate goodness of fit and Kolmogorov Smirnov tests. You can access
these tests by clicking on:

STATISTICS -> Hypothesis Tests
and then selecting the corresponding option.
These two options follow the same format:

When either of these options is executed you are prompted to choose between entering
the observed and expected values from samples chosen from the data matrix or from
numbers entered by you.

The course by which the program proceeds depends on whether samples are to be
selected from the data matrix or from numbers entered by you:

If the samples are to be selected from the data matrix, you are prompted to
select the samples through the SELECTING SAMPLES menu.

If the samples are to be selected from numbers entered by you, you are
prompted to specify the number of groups of data that are to be entered and then to
enter each of these groups in turn.

At this point, the expected and observed values are totaled and you are prompted to
verify their accuracy.
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Once the totals have been verified, you are prompted (for the goodness of fit test only)
to specify the number of parameters that have been estimated using these data.

The output produced by the option being executed is then generated.

It should be noted that you have a certain degree of flexibility in the way in which these
groups of data are entered: both observed and expected values can be entered as raw
numbers, or as a decimal fraction of the total number of observed values, in which case
you will eventually be prompted to enter the total number of observed values in the sample.

The observed values can also be entered as raw numbers and the expected values as
decimal fractions of the total of the observed values. The ASP program automatically
adjusts to accommodate each of these situations by checking to see whether the totals of
the observed and expected values are greater than or approximately equal to one and
responding accordingly. (Frank and Althoen, Kohler, McClave and Benson, Siegel, Hays,
Sincich, Zar)

Goodness Of Fit Test

A goodness of fit test can be run by executing the S. Goodness Of Fit test option on the
HYPOTHESIS TESTS menu.

The output generated by this option includes the chi square statistic for the null hypothesis
that the observed values are generated by the distribution from which the expected values
are generated along with its degrees of freedom and p-value.

This test is approximate in finite samples and is generally considered to be acceptable only
if each expected value is 5 or greater. (Frank and Althoen, Kohler, McClave and Benson,
Siegel, Hays, Sincich, Zar)

Kolmogorov-Smirnov

A Kolmogorov-Smirnov test can be run by executing the N. Kolmogorov-Smirnov option
on the HYPOTHESIS TESTS menu. (See Goodness Of Fit/Kolmogorov-Smirnov Tests.)

The output from this option includes the Kolmogorov-Smirnov D statistic. The chi square
statistic implied by the Kolmogorov-Smirnov D for the null hypothesis that the observed and
expected values represent two independent samples that are generated from the same
distribution is also given, along with the degrees of freedom for this statistic and its p-value.

This test is only approximate in finite samples and is generally considered to be acceptable
only if the size of each sample is 20 or greater. (Frank and Althoen, Kohler, McClave
and Benson, Siegel, Hays, Sincich, Zar)
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Test Of Two Correlations

The V. Cor(XY) = Cor(VW) option on the HYPOTHESIS TEST menu allows you to test the
equality of two correlations. You can access these tests by clicking on:

STATISTICS -> Hypothesis Tests
and then selecting the V. Cor(XY) = Cor(VW) option.

When this option is executed you are first prompted to choose between calculating
statistics from samples chosen from the current data matrix or from numbers entered by
you. The course by which the program proceeds depends on which of these two options is
chosen.

If statistics are to be calculated from numbers entered by you, you are prompted to enter
sample correlation and size for the two correlations.

If statistics are to be calculated from samples chosen from the current data matrix you are
prompted to select the samples through the SELECTING SAMPLES menu.

The output produced by this option is then generated and includes the difference between
the two correlation coefficients, the z statistic for the null hypothesis that this difference is
equal to zero, and the p-value and p-value divided by two for this z statistic. (Zar)
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Power/Size/Difference

You can access the Power/Size/Difference option on the STATISTICS menu by clicking
on:

STATISTICS -> Power/Size/Difference.

This option can be used to estimate the power, optimum sample size, and minimum
detectable difference for 11 statistical tests:

A. Mean X =x B. Mean X = Mean Y

C. Proportion X = x D. Proportion X=Proportion Y
E. Variance X = x F. Variance X = Variance Y
J. Sign Test R. P.M. Correlation (XY) = x

V. Cor(XY) = Cor(VW) K. Oneway ANOVA

P. Pearson-Hartley F

When you execute an option on this menu you are prompted to select the particular
operation that you wish to undertake:

P. Power S. Sample Size M. Minimum Detectable Difference

where:
P. Power allows you to estimate the power of the test.

S. Sample Size allows you to estimate the optimum sample size.

M. Minimum Detectable Difference allows you to estimate the minimum difference that
can be detected by the test.

The format by which you continue depends of the particular option you choose. (Zar)

Power Of Test Menu

You can calculate the power of a test by clicking on:
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STATISTICS -> Power/Size/Difference,

and then selecting the P. Power option on the resulting menu. You are then presented
with the POWER OF TEST menu. There are eleven options on this menu:

A. Mean X =x B. Mean X =Mean Y
C. Proportion X = x D. Proportion X= Proportion Y
E.Var X=x F.Var X=VaryY

R. Pearson Cor (XY) = x V. Cor(XY) = Cor(VW)

J. Sign Test K. Oneway ANOVA

P. Pearson-Hartley F

The format by which you proceed from here and the resulting output generated depend on
the particular option chosen.

Mean Test

When the A. Mean X = x option on the POWER OF TEST menu is executed you are
prompted to choose between calculating the power for a small or large populate test and
then to enter:

Sample size

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated power for both a one and a two tailed test. (Zar)

Difference Of Means Test

When the B. Mean X = Mean Y option on the POWER OF TEST menu is executed you are
prompted to enter:

Sample size of X
Sample size of Y

Minimum detectable difference
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Significance
Population variance

The resulting output is the estimated power for both a one and a two tailed test. (Zar)

Proportion Test

When the C. Proportion X = x option on the POWER OF TEST menu is executed you are
prompted to enter:

Number of successes
Sample size
Significance
Hypothesized value (x)

The resulting output is the estimated power for both a one and a two tailed test. These
results are given for both an exact calculation using the Binomial distribution and for the
Normal approximation. (Zar)

Difference Of Proportions

When the D. Proportion X = Proportion Y option on the POWER OF TEST menu is
executed you are prompted to enter:

Sample proportion of X
Sample size of X
Sample proportion of Y
Sample size of Y
Significance

The resulting output is the estimated power for both a one and a two tailed test. (Zar)

Variance Test

When the E. Var X = x option on the POWER OF TEST menu is executed you are
prompted to enter:

Sample size



85

Minimum detectable difference
Significance
Hypothesized value (x)
The resulting output is the estimated power for both a one and a two tailed test. In addition,

since the distribution is asymmetrical these results are reported for both positive and
negative differences. (Zar)

Variance Ratio Test

When the F. Var X = Var Y option on the POWER OF TEST menu is executed you are
prompted to enter:

Sample size

Minimum detectable difference
Significance

Population variance

The resulting output is the estimated power for both a one and a two tailed test. (Zar)

Correlation Test

When the R. Pearson Cor(XY) = x option on the POWER OF TEST menu is executed you
are prompted to enter:

Sample size

Sample correlation of X and Y
Significance

Hypothesized value (x)

The resulting output is the estimated power for both a one and a two tailed test. (Zar)

Difference Of Correlation

When the V. Cor(XY) = Cor(VW) = x option on the POWER OF TEST menu is executed
you are prompted to enter:

Sample correlation of X and Y

Sample size of X and Y
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Sample correlation of V.and W
Sample size of V and W
Significance
The resulting output is the estimated power for both a one and a two tailed test. (Zar)

Sign Test

When the J. Sign Test option on the POWER OF TEST menu is executed you are
prompted to enter:

Number of successes
Sample size
Significance

The resulting output is the estimated power for both a one and a two tailed test. These
results are given for both an exact calculation using the Binomial distribution and for the
Normal approximation. (Zar)

Oneway ANOVA Test

When the K. Oneway ANOVA option on the POWER OF TEST menu is executed you are
prompted to enter:

Number of treatments

Sample size

Significance

Minimum detectable difference
Variance

The resulting output is the estimated power for a one tailed test. (Zar)

Pearson-Hartley F

When the P. Pearson-Hartley F option on the POWER OF TEST menu is executed you
are prompted to enter:

Numerator degrees of freedom



87

Denominator degrees of freedom
Significance
Non-centrality parameter

The resulting output is the estimated power for a one tailed test. (Zar)

Optimum Sample Size
You can calculate the optimum sample size for a test by clicking on:
STATISTICS -> Power/Size/Difference,

and then selecting the S. Sample Size option on the resulting menu. You are then
presented with eleven options:

A. Mean X = x B. Mean X = Mean Y
C. Proportion X = x D. Proportion X= Proportion Y
E.Var X =x F.Var X=VaryY

R. Pearson Cor (XY) = x V. Cor(XY) = Cor(VW)

J. Sign Test K. Oneway ANOVA

P. Pearson-Hartley F

The format by which you proceed from here and the resulting output generated depend on
the particular option chosen.

Mean Test

When the A. Mean X = x option on the OPTIMUM SAMPLE SIZE menu is executed you
are prompted to choose between calculating the power for a small or large populate test
and then to enter:

Power of the test

Minimum detectable difference
Significance

Population variance

Size of population (small population tests only)
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The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)

Difference Of Means Test

When the D. Proportion X = Proportion Y option on the OPTIMUM SAMPLE
SIZE menu is executed you are prompted to enter:

Power of the test

Minimum detectable difference
Significance

Population variance

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)

Proportion Test

When the C. Proportion X = x option on the OPTIMUM SAMPLE SIZE menu is
executed you are prompted to enter:

Sample proportion of X
Power of the test
Significance
Hypothesized value (x)

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)

Difference Of Proportions Test

When the D. Proportion X = Proportion Y option on the OPTIMUM SAMPLE
SIZE menu is executed you are prompted to enter:

Sample proportion of X
Sample proportion of Y
Significance

Power of the test

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)
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Variance Test

When the E. Var X = x option on the OPTIMUM SAMPLE SIZE menu is executed you are
prompted to enter:

Power of the test

Minimum detectable difference
Significance

Hypothesized value (x)

The resulting output is the estimated sample size for both a one and a two tailed test. In
addition, since the distribution is asymmetrical these results are reported for both positive
and negative differences. (Zar)

Variance Ratio Test

When the F. Var X = x option on the OPTIMUM SAMPLE SIZE menu is executed you are
prompted to enter:

Power of the test

Minimum detectable difference
Significance

Population variance

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)

Correlation Test

When the R. Pearson Cor(XY) = x option on the OPTIMUM SAMPLE SIZE menu is
executed you are prompted to enter:

Power of the test

Sample correlation of X and Y
Significance

Hypothesized value (x)

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)
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Difference Of Correlation

When the V. Cor(XY) = Cor(VW) option on the OPTIMUM SAMPLE SIZE menu is
executed you are prompted to enter:

Power of the test

Sample correlation of X and Y
Significance

Minimum detectable difference

The resulting output is the estimated sample size for both a one and a two tailed test. In
addition, since the distribution is asymmetrical these results are reported for both positive
and negative differences. (Zar)

Sign Test

When the J. Sign Test option on the OPTIMUM SAMPLE SIZE menu is executed you are
prompted to enter:

Sample proportion of X
Power of the test
Significance

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar

)

Oneway ANOVA Test

When the K. Oneway ANOVA option on the OPTIMUM SAMPLE SIZE menu is
executed you are prompted to enter:

Power of the test

Number of treatments
Significance

Minimum detectable difference
Variance

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)
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Pearson-Hartley F

When the P. Pearson-Hartley F option on the OPTIMUM SAMPLE SIZE menu is
executed you are prompted to enter:

Power of the test

Numerator degrees of freedom
Significance

Non-centrality parameter

The resulting output is the estimated sample size for both a one and a two tailed test. (Zar)

Minimum Detectable Difference

You can calculate the minimum detectable difference that can be examined by a test by
clicking on:

STATISTICS -> Power/Size/Difference,

and then selecting the M. Minimum detectable difference option on the resulting menu.
You are then presented with eleven options:

A. Mean X =x B. Mean X=Mean Y

C. Proportion X = x D. Proportion X = Proportion Y
E.VarX=x F.VarX=VarY

R. Pearson Cor(XY) = x V. Cor(XY) = Cor(VW)

J. Sign Test K. Oneway ANOVA

P. Pearson-Hartley F

The format by which you proceed from here and the resulting output generated depend on
the particular option chosen.

Mean Test

When the A. Mean X = x option on the MINIMUM DETECTABLE DIFFERENCE menu is
executed you are prompted to choose between calculating the power for a small or large
populate test and then to enter:

Power of the test
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Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. (Zar)

Difference Of Means Test

When the B. Mean X = Mean Y option on the MINIMUM DETECTABLE DIFFERENCE
menu is executed you are prompted to choose between calculating the power for a small or
large populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. (Zar)

Proportion Test

When the C. Proportion X = x option on the MINIMUM DETECTABLE DIFFERENCE
menu is executed you are prompted to choose between calculating the power for a small or
large populate test and then to enter:

Power of the test

Minimum detectable difference
Significance

Population variance

Size of population (small population tests only)
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The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. In addition, since the distribution may be asymmetrical these results are
reported for both positive and negative differences. (Zar)

Difference Of Proportions Test

When the D. Proportion X = Proportion Y option on the MINIMUM DETECTABLE
DIFFERENCE menu is executed you are prompted to choose between calculating the
power for a small or large populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. In addition, since the distribution may be asymmetrical these results are
reported for both positive and negative differences. (Zar)

Variance Test

When the E. Var X = x option on the MINIMUM DETECTABLE DIFFERENCE menu is
executed you are prompted to choose between calculating the power for a small or large
populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. In addition, since the distribution may be asymmetrical these results are
reported for both positive and negative differences. (Zar)
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Variance Ratio Test

When the F. Var X = Var Y option on the MINIMUM DETECTABLE DIFFERENCE menu is
executed you are prompted to choose between calculating the power for a small or large
populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. (Zar)

Correlation Test

When the R. Pearson Cor(XY) = x option on the MINIMUM DETECTABLE DIFFERENCE
menu is executed you are prompted to choose between calculating the power for a small or
large populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. In addition, since the distribution may be asymmetrical these results are
reported for both positive and negative differences. (Zar)

Difference Of Correlation

When the V. Cor(XY) = Cor(VW) option on the MINIMUM DETECTABLE DIFFERENCE
menu is executed you are prompted to choose between calculating the power for a small or
large populate test and then to enter:

Power of the test
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Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. In addition, since the distribution may be asymmetrical these results are
reported for both positive and negative differences. (Zar)

Sign Test

When the J. Sign Test option on the MINIMUM DETECTABLE DIFFERENCE menu is
executed you are prompted to choose between calculating the power for a small or large
populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. In addition, since the distribution may be asymmetrical these results are
reported for both positive and negative differences. (Zar)

Oneway ANOVA Test

When the K. Oneway ANOVA option on the MINIMUM DETECTABLE DIFFERENCE
menu is executed you are prompted to choose between calculating the power for a small or
large populate test and then to enter:

Power of the test

Minimum detectable difference
Significance

Population variance

Size of population (small population tests only)
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The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. (Zar)

Pearson-Hartley F

When the M Pearson-Hartley F option on the MINIMUM DETECTABLE DIFFERENCE
menu is executed you are prompted to choose between calculating the power for a small or
large populate test and then to enter:

Power of the test

Minimum detectable difference

Significance

Population variance

Size of population (small population tests only)

The resulting output is the estimated minimum detectable difference for both a one and a
two tailed test. (Zar)
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Confidence Intervals

The confidence interval options are on the CONFIDENCE INTERVAL menu. This menu
can be accessed by clicking on:

STATISTICS -> Confidence Intervals.

(The CONFIDENCE INTERVAL menu can also be accessed through the HYPOTHESIS
TESTS menu.)

There are seven options on this menu:

M. Mean P. Proportion
V. Variance C. Correlation
D. Mean X—Mean Y R. Proportion X—Proportion Y

A. Variance X/ Variance Y E. Median X

(_Frank and Althoen , Kohler, McClave and Benson , Sincich, Zar)

Format For Confidence Intervals

Options on the CONFIDENCE INTERVAL menu follow a common format:

When you click on the option you want you are prompted to:
Get Samples From DATA Matrix Or Enter NUMBERS?
How the program continues depends on which option you choose:

If you choose to get samples from the data matrix, you are prompted to select the
samples.

If you choose to enter numbers you are prompted to enter the appropriate
numbers. The numbers requested depend on the confidence interval being
constructed.

Whether statistics are to be calculated from samples or from numbers entered by you, you
are prompted to specify a value for the level of confidence. You have a great deal of
flexibility in specifying this value in that either the confidence or significance level can be
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entered in either decimal or percentage form. For example, entering 95, .95, 5, or .05 will all
yield a 95% confidence interval.

For some routines you are prompted to specify the particular kind of sampling situation
being examined. (e.g., independent samples or matched pairs, large or small population,
etc.)

The output associated with the particular interval being calculated is then generated and
displayed.

A Sample Mean

The M. Mean option on the CONFIDENCE INTERVAL menu allows you to construct a
confidence interval about a sample mean. (See Format For Confidence Intervals.)

If the confidence interval is to be calculated from numbers entered by you, you are
prompted to enter the sample mean, variance, and size.

In either event you must enter the level of confidence.

You must also specify whether the sample is drawn from a large or small population,
(Kohler) and if from a small population, you must specify the size of the population.

The output generated by this option includes the upper and lower limits of the confidence
interval along with the value of the t statistic which corresponds to this confidence interval.
The standard error of estimate of the population mean along with the value of t multiplied
by this standard error are also listed.

A Sample Proportion

The P. Proportion option on the CONFIDENCE INTERVAL menu allows you to construct a
confidence interval about a sample proportion. (See Format For Confidence Intervals.)

If the confidence interval is to be calculated from numbers entered by you, you are
prompted to enter the number of successes and the sample size.

In either event you must enter the level of confidence.

This option uses the F distribution to calculate the exact values of the binomial
distribution that correspond to the upper and lower limits of the estimated confidence
interval. (Zar)
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The output generated by this option includes the sample proportion, the exact values of the
upper and lower limits of the confidence interval about this proportion, and the F statistics
that correspond to the upper and lower limits of this confidence interval.

The output also includes the Z statistic associated with the Normal approximation to this
confidence interval, the upper and lower limits implied by the Normal approximation, the
standard error of estimate of the population proportion, and the value of Z multiplied by this
standard error.

A Sample Variance

The V. Variance option on the CONFIDENCE INTERVAL menu allows you to construct a
confidence interval about a sample variance. (See Format For Confidence Intervals.)

If the confidence interval is to be calculated from numbers entered by you, you are
prompted to enter the sample variance and size.

In either event you must enter the level of confidence.

The output generated by this option includes the upper and lower limits of the confidence
interval along with the degrees of freedom and the upper and lower chi squares.

Sample Correlation Coefficient

The C. Correlation option on the CONFIDENCE INTERVAL menu allows you to construct
a confidence interval about a sample correlation. (See Format For Confidence Intervals.)

When this option is executed you are prompted to specify whether a Pearson product
moment or Spearman rank order correlation coefficient is to be considered.

If the confidence interval is to be calculated from numbers entered by you, you must enter
the correlation coefficient and sample size.

In either event you must enter the level of confidence.

The output generated by this option includes the upper and lower limits of the confidence
interval along with the Z statistic, the Fisher r to z transformation, and the standard error of
the estimated value. In constructing these limits the Fisher z transformation is adjusted by
subtracting r/2(n-1). (Zar)

For Spearman rank order coefficients these limits are approximate in finite samples and are
considered acceptable only if the sample size is greater than 9 and the correlation
coefficient is less than or equal to .9. (Zar)
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The Difference Between Two Means

The D. Mean X — Mean Y option on the CONFIDENCE INTERVAL menu allows you to
construct a confidence interval about the difference between two sample means. (See
Format For Confidence Intervals.)

When this option is executed you are prompted to choose between independent samples
or matched pairs.

If the confidence interval is to be calculated from numbers entered by you, the numbers you
must enter depend on the sampling situation:

For independent samples you must enter the mean, variance, and size of each sample.
You must also indicate whether the population variances are assumed to be equal.

For matched pairs you must enter the mean of the sample differences, the sample
variance, and sample size.

In either event you must enter the level of confidence.

The output generated by this option includes the upper and lower limits of the confidence
interval along with the value of the t statistic and its degrees of freedom. The standard error
of estimate of the difference between the population means (the mean of the differences for
matched pairs) is given along with the value of t multiplied by this standard error.

The Difference Between Two Proportions

The R. Proportion X — Proportion Y option on the CONFIDENCE INTERVAL menu allows
you to construct a confidence interval about the difference between two sample
proportions. (See Format For Confidence Intervals.)

If the confidence interval is to be calculated from numbers entered by you, you are
prompted to enter the proportion and size of each sample.

In either event you must enter the level of confidence.
The output generated by this option includes the upper and lower limits of the confidence

interval, the Z statistic, the difference in the sample proportions, standard error of estimate
of this difference, and the value of Z multiplied by this standard error.
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The Ratio Of Two Variances

The A. Variance X / Variance Y option on the CONFIDENCE INTERVAL menu allows you
to construct a confidence interval about the ratio of two sample variances. (See Format For
Confidence Intervals.)

If the confidence interval is to be calculated from numbers entered by you, you are
prompted to enter the variance and size of each sample.

In either event you must enter the level of confidence.

The output generated by this option includes the upper and lower limits of the confidence
interval along with the values of the upper and lower F statistics and their respective
degrees of freedom.

A Sample Median

The E. Median option on the CONFIDENCE INTERVAL menu allows you to construct a
confidence interval about a sample mean. (See Format For Confidence Intervals.)

If the confidence interval is to be calculated from numbers entered by you, you are
prompted to enter sample size and the level of significance.

In either event you must enter the level of confidence.

The output generated by this option includes the upper and lower limits of the confidence
interval along with the median for these data. If the interval is calculated from numbers
entered by you the results are expressed in terms of the ranks of these values in the
corresponding data. (Zar)
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Reliability Analysis

To analyze the reliability of a set of scores click on:
STATISTICS -> Reliability.

In response you are prompted to select a set of score variables and cases. You are then
presented with the RELIABILITY ANALYSIS OPTIONS menu. There are 13 options on

this menu:
l. Item And Scale Statistics A. Analysis Of Variance
S. Split Model G. Guttman Model
P. Parallel Model T. Strict Parallel Model
C. Concordance/Friedman’s Test H. Hotelling’s T Squared Test
V. Variance/Covariance Matrix Q. Quartile Breakdown Mean
D. Affect Of Deleting ltem B. Quartile Breakdown Std Dev

L. Select New Items

(Guttman, Kristof)

Item And Scale Statistics

The I. Item And Scale Statistics option on the RELIABILITY ANALYSIS OPTIONS
menu provides the number of items in the scale and the number of cases along with the
scale mean, variance, and standard deviation. In addition, it provides the grand mean,
Cornbach’s alpha, standardized alpha, interclass correlation, and the Spearman Brown
predictor.

This option also provides the mean, variance, standard deviation, covariance, correlation of
the given item with the sum of the other items, and the reliability index of each item in the
scale. It also provides the mean, variance, standard deviation, maximum, minimum, range,
and maximum over the minimum of each of the proceeding statistics.
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Scale Analysis

There are seven scale analysis options on the RELIABILITY ANALYSIS OPTIONS menu:

A. Analysis Of Variance S. Split Model
G. Guttman Model P. Parallel Model
T. Strict Parallel Model C. Concordance/Friedman’s Test

H. Hotelling’s T Squared Test

(Guttman, Kristof)

Analysis Of Variance

The A. Analysis Of Variance option on the RELIABILITY ANALYSIS OPTIONS
menu provides the analysis of variance table for the reliability model being examined.

If the items in the scale are non-dichotomous this includes the between measures and
nonadditivity F statistics along with the Tukey additivity power. If the items in the scale are
dichotomous only the between measures F statistic is included.

Split Model

The S. Split Model option on the RELIABILITY ANALYSIS OPTIONS menu divides the
items in the scale into two groups, the first half of the items in the first group and the
second half of the items in the second group. (If there is an odd number of items the first
group will have one more item than the second.)

The correlation between the two groups is then calculated along with the Spearman Brown
coefficient and the Guttman split half coefficient. The various scale statistics provided by
option | are also provided for each half of the scale.

Guttman Model

The G. Guttman Model option on the RELIABILITY ANALYSIS OPTIONS menu provides
the values for L1 through L6 of the Guttman Model. (Guttman )

Strict Parallel Model

The P. Parallel Model option on the RELIABILITY ANALYSIS OPTIONS menu provides
the chi square test for goodness of fit for the parallel model along with its degrees of
freedom, p-value, and all of the statistics necessary to generate this test.

The T. Strict Parallel Model option on the RELIABILITY ANALYSIS OPTIONS
menu provides the chi square test for goodness of fit for the strict parallel model along with
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its degrees of freedom, p-value, and all of the statistics necessary to generate this test.
(Kristof)

Concordance/Friedman’s Test

The C. Concordance/Friedman’s Test option on the RELIABILITY ANALYSIS OPTIONS
menu is only available when the scale items are dichotomous. In this case Friedman’s chi
square (along with its degrees of freedom, and p-value) and Kendall’s coefficient of

concordance are provided along with all of the statistics necessary to generate these two
items.

Hotelling’s T Squared Test

The H. Hotelling’s T Squared Test option on the RELIABILITY ANALYSIS OPTIONS

menu provides Hotelling’s T squared statistic along with its F statistic, degrees of freedom,
and p-value.

Item Analysis

There are four item analysis options on the RELIABILITY ANALYSIS OPTIONS menu:

V. Variance/Covariance Matrix D. Affect Of Deleting ltem

Q. Quartile Breakdown Mean B. Quartile Breakdown Std Dev

(Guttman, Kristof)

Variance/Covariance Matrix

The V. Variance/Covariance Matrix option on the RELIABILITY ANALYSIS OPTIONS
menu provides the variance/covariance matrix of the items in the scale.

Affect Of Deleting Item

The D. Affect Of Deleting Item option on the RELIABILITY ANALYSIS OPTIONS

menu shows how the mean, variance, and alpha of the scale will change if a given item is
excluded from the scale.

Quartile Breakdown

The Q. Quartile Breakdown Mean option on the RELIABILITY ANALYSIS OPTIONS
menu provides a quartile breakdown of the mean of each item in the scale.

The B . Quartile Breakdown Std Dev option on the RELIABILITY ANALYSIS OPTIONS
menu provides a quartile breakdown of the standard deviation of each item in the scale.




105

Analysis Of Variance

The analysis of variance options in ASP are available on the ANALYSIS OF VARIANCE
menu. You can access this menu by clicking on:

STATISTICS -> Analysis Of Variance.
This menu has seven options:

0. One Way Analysis Of Variance

S. Simple Random Block/Repeated Measures

A. N Way Analysis Of Variance

R. N Way Random Block/Repeated Measures

C. Covariance Analysis

M. Estimate Factor Means

U. Setup Regression Matrix

These options allow you to estimate N way fixed, random, and mixed effects analysis of
variance and random block/repeated measures models with or without a nested factor.
They also provide for covariance analysis and a mechanism whereby you can setup
general ANOVA regression matrices. (Kleinbaum et al, Neter et al, Hays)

Coding Analysis Of Variance Data

Each of the options on the ANALYSIS OF VARIANCE menu requires the input data, both
for the dependent variable and for the factors (independent variables), be stored as
variables in the columns of a data matrix with the values of the variables that correspond to
each other (cases) in the rows.

Factor levels must be coded as a set of consecutive integers that range from 1 to r where r
is the number of unique levels (values) that the factor takes. If the factor levels are not
coded consecutively, or if factor levels are not coded from 1 to r an error condition will
result and the message A FACTOR IS NOT CODED PROPERLY will be reported. (A
factor that is coded from 0 to r-1 will be recoded from 1 to r by ASP and will appear in the
output with a +1 attached to its name.)
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An example of the format of a typical analysis of variance data matrix is given in Tables 1
and 2 below where Time is the dependent variable, and Sex, Union, and Method are
explanatory factors with factor levels 2, 2, and 3, respectively.

The data matrix in Table 2 below was created from the data in Table 1. You should
examine these two tables carefully to be certain that you understand how an analysis of
variance data matrix must be coded to be used in the ASP program. You should also note
that the Sex, Union, and Method variables do not have to be entered directly into the data
editor, in that these variables can be created by the Generate Pattern Variables option on
the DATA MANAGEMENT menu, where Sex takes 2 values with 3 repeats, Union takes 2
values with 18 repeats, Method takes 2 values with 6 repeats and there are 36 cases for all
three of these variables.

A random block/repeated measures data matrix is identical in form to the analysis of
variance data matrix with a block or subject variable that is coded to number the blocks or
subjects in the design.

Table 1, Manufacturing Data From The XYZ Corporation.

K=1 K=2

J=1 J=2 J=3 J=1 J=2 J=3
=1 125 131 121 102 111 103

117 125 119 109 111 106

123 124 120 106 112 105
=2 106 110 102 86 92 84

107 104 102 84 94 86

100 105 103 88 95 81

| = Sex, K = Union, J = Method.

Time = assembly time, Sex = sex of assembler(1 = Male, 2= Female), Union = union
membership(1=Nonmember, 2 = Member),and Method= method of assembly.

Table 2, ANOVA Data Matrix From Table 1.

Manufacturing Time:
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24 88 2 2 2
25 111 1 2 1
26 111 1 2 1
27 112 1 2 1
28 92 2 2 1
29 94 2 2 1
30 95 2 2 1
31 103 1 2 2
32 106 1 2 2
33 105 1 2 2
34 84 2 2 2
35 86 2 2 2
36 81 2 2 2

One-Way Analysis Of Variance

A one-way analysis of variance model can be estimated by executing the O. One Way
Analysis Of Variance option on the ANALYSIS OF VARIANCE menu.

When this option is executed you are prompted to select the dependent variable and a
single factor for the model to be estimated.

The output from this option is displayed in the manner examined in ANOVA Output.
(Kleinbaum et al, Neter et al, Hays)

N Way Analysis Of Variance

An N way analysis of variance model can be estimated by executing the A. N Way
Analysis Of Variance option on the ANALYSIS OF VARIANCE menu. This option allows
you to estimate fixed, random, and mixed effects analysis of variance models with or
without a nested factor.

When this option is executed you are prompted to:
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Select the dependent variable and factors for the model to be estimated.
Identify the nested factor if there is a nested factor in the model to be estimated.
|dentify the random factors if there are random factors in the model to be estimated.

The output from this option is displayed in the manner examined in ANOVA Output.
(Kleinbaum et al, Neter et al, Hays)

Simple Random Block/Repeated Measures

A simple random block/repeated measures model can be estimated by executing the S.

Simple Random Block / Repeated Measures option on the ANALYSIS OF VARIANCE
menu

When this option is executed you are prompted to select the dependent variable and two
factors for the model to be estimated.

The output from this option is displayed in the manner examined in ANOVA Output.
(Kleinbaum et al, Neter et al, Hays)

N Way Random Block/Repeated Measures

An n way random block or repeated measures model can be estimated by executing the R.
N Way Random Block/Repeated Measures option on the ANALYSIS OF VARIANCE
menu. This option allows you to estimate fixed, random, and mixed effects random block or
repeated measures models with or without a nested block/subject factor.

When this option is executed you are prompted to:
Select the dependent variable and factors for the model to be estimated.

|dentify the nested factor if the block/subject factor is nested in the model to be
estimated.

|dentify the random factors if there are random factors in the model to be estimated.

In the case of a three-way or greater fixed effects random block model you are prompted to
specify whether the model to be estimated is additive or interactive:

In additive models all block variable interaction terms are suppressed.
In interactive models only the highest order interactive terms are suppressed.

You are also prompted to identify the block variable.
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The output from this option is displayed in the manner examined in ANOVA Output.
(Kleinbaum et al, Neter et al, Hays)

Analysis Of Covariance

A set of covariance variables can be included in an analysis of variance or random
block/repeated measures model by executing the C. Covariance Analysis option on the
ANALYSIS OF VARIANCE menu.

When this option is executed:

You are prompted to specify whether you want the covariance variables to be added to
an analysis of variance or a random block/repeated measures model.

You are then prompted to select the dependent variable and explanatory factors.

You are prompted to select the covariance variables that are to appear in the model
from the variables that have not yet been selected from the data matrix.

The format continues in the manner indicated for an analysis of variance or random
block/repeated measures option depending on which has been chosen.

The output generated by the C. Covariance Analysis option is essentially the same as the
output generated by the analysis of variance or the random block/repeated measures
options.

The major differences are that the covariance sum of squares, degrees of freedom, mean
square, F statistic, and p-value are added to the analysis of variance table and the various
means and effects are adjusted so as to be estimated at the mean of the covariance
variables.

Both the adjusted and unadjusted means are reported in the analysis of variance output,
while only the adjusted means are reported in the random block/repeated measures output.

The output from this option is displayed in the manner examined in ANOVA Output with the
additions noted above. (Kleinbaum et al, Neter et al, Hays)

Setting Up A Regression Matrix

The S. Setup Regression Matrix option on the ANALYSIS OF VARIANCE menu creates
an analysis of variance regression data matrix that can be subsequently altered and
estimated by you.
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When this option is executed you are prompted to select the dependent variable and the
factors for the model to be examined. You are then given the option of:

Estimating the regression model.

Listing the regression data matrix.

Adding the regression data matrix to the current data matrix.

Deleting variables from the regression data matrix to form a reduced model.

When the regression model is estimated the output includes an algebraic representation of
the regression equation in this model, and an analysis of variance table that reports the
regression, residual, and total sum of squares along with their respective degrees of
freedom, the regression and residual mean square, and the F statistic and its probability
value for the null hypothesis that the regression sum of squares is zero.

You are also given the option of listing the variance/covariance matrix for this model and of
listing, plotting, etc. the residuals of the model. (Neter et al)

Estimating Factor Means

The M. Estimate Factor Means option on the ANALYSIS OF VARIANCE menu provides a
mechanism by which you can estimate the factor means without estimating an analysis of
variance model.

When this option is executed you are prompted to select the dependent variable and
factors for the model to be examined. The means are then calculated and displayed.

Only the factor and interaction means and variances are estimated by this option and not
the factor and interaction effects.

Analysis Of Variance Output

Output from the options on the ANALYSIS OF VARIANCE menu is generated in two
stages:

First, an ANALYSIS OF VARIANCE TABLE is displayed.

Second, when the analysis of variance table is exited by clicking on CONTINUE the
ANALYSIS OF VARIANCE OPTIONS menu is presented.

Analysis Of Variance Table

The analysis of variance table contains the sum of squares explained by each factor, the
error sum of squares, and the total sum of squares along with the degrees of freedom
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associated with each of these sums of squares. Next the mean square associated with
each sum of squares is listed, as is the F statistic with its associated probability value for
the null hypothesis that the factor level means are equal.

The analysis of variance Table for an n-way analysis contains sums of squares, degrees of
freedom, mean squares, F statistics, and probability values for the interaction effects
between factors as well as for the factors themselves.

Expected mean squares are given for nested designs and for random and mixed models.
The denominator of the F statistics in the analysis of variance table is also given for these
models, as are the nested sums of squares when appropriate. (Kleinbaum et al, Neter et

al, Hays)

Analysis Of Variance Options Menu

Once the Analysis Of Variance Table is exited you are presented with the ANALYSIS OF
VARIANCE OPTIONS menu. This menu contains six options for additional analysis and
output:

M. Means And Effects C. Pairwise Comparisons

E. Estimate Linear Combinations V. List Variance/Covariance Matrix

R. Plot/List/Save Residuals In File T. Plot Treatment Means

B. Plot Breakdown Of Residuals

(Kleinbaum et al, Neter et al, Hays)

Means And Effects

When the M. Means And Effects option on the ANALYSIS OF VARIANCE OPTIONS
menu is executed the factor level effects and means are calculated and displayed.

The estimate of the overall (grand) mean is presented in this display along with the
variance of this estimate and the model’s mean squared error and associated degrees of
freedom.

In addition, estimates of the effects and means of each factor level (the ith level of factor |
is denoted I(i)) are presented, and the variance of each of these estimates is listed to its
right. The number of treatments that were available to estimate each factor level mean is
reported in the NO. column.
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The output for an n-way analysis reports the effects, means, variances and number of
treatments for the interactions between individual factor levels as well as for the factor
levels themselves. (Kleinbaum et al, Neter et al, Hays)

Listing The Variance/Covariance Matrix

The V. List Variance/Covariance Matrix option on the ANALYSIS OF VARIANCE
OPTIONS menu allows you to display the variance/covariance matrix of the coefficients of
the underlying regression model from which the parameters of the analysis of variance
model are derived.

The result is an algebraic representation of the underlying analysis of variance regression
model along with the variance/covariance matrix for the estimated coefficients in this
model. (Neter et al)

Plotting Treatment Means

The T. Plot Treatment Means option on the ANALYSIS OF VARIANCE OPTIONS menu
allows you to break down and plot the treatment means for the individual values of the
factors. This option is only available for models with more than one factor.

When this option is executed you are prompted to:
Enter a scale factor.
Select factor to breakdown and plot.
Select the break down factor (only if there are more than two factors).

Specify values for the remaining factors in the model (only if there are more than two
factors).

A character plot of the treatment means for each value of the factor you have selected is
plotted for each value of the breakdown factor, given the values specified for the
remaining factors. (Neter et al)

List/Plot/Add Residuals To Data Matrix

The R. Plot/List/Save Residuals In File option on the ANALYSIS OF VARIANCE
OPTIONS menu allows you to calculate the standardized, studentized, and jackknife
residuals in the model being estimated along with the leverage and influence of each
residual as well as the estimated value of the dependent variable.

When this option is estimated you are presented with the LIST/PLOT/ADD RESIDUALS
menu. This menu has four options:
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D. Add Variables To Data Matrix P. Plot Standardized Residuals

L. List Leverage, Student, Etc. A. List Actual/Estimated/Residual

D. Add Variables To Data Matrix allows you to add the standardized, studentized, and
jackknife residuals in the model being estimated to the data matrix in memory along with
the leverage and influence of each residual and the estimated value of the dependent
variable.

When this option is executed you are prompted to select the variables to be added to the
data matrix in memory and are then given the opportunity to change the names of these
variables. The selected variables are then added to the end of the data matrix in memory.

P. Plot Standardized Residuals allows you to plot the standardized residuals in the model
being estimated. When this option is executed the residuals and standardized residuals are
listed along with a vertical sequence character plot of the standardized residuals.

L. List Leverage, Student, Etc. allows you to list the residuals along with the
standardized, leverage, studentized, influence, and jackknife values for each residual.
When this option is executed these values are listed.

A. List Actual/Estimated/Residual allows you to list the actual value of the dependent
variable in the model being estimated along with its estimated value and the residual
implied by the difference between the actual value and its estimated value. When this
option is executed these values are listed. (Kleinbaum et al, Neter et al, Hays)

Breaking Down residuals

The B. Plot Breakdown Of Residuals option on the ANALYSIS OF VARIANCE OPTIONS
menu allows you to plot a breakdown of the residuals.

When this option is executed you are prompted to:
Enter a scale factor.
Choose between breaking down residuals by factor values or by treatments.
Choose between plotting a frequency or a sequence plot.

If you have chosen to break down the residuals by a variable, you are prompted to
select the variable.

When you have responded to these prompts the plots are then generated and displayed:

If you choose to generate a frequency plot, a single plot of all residuals broken down
by the criteria chosen will be generated.
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If you choose to generate sequence plots, individual plots for each value of the
criteria chosen will be generated.

(Kleinbaum et al, Neter et al, Hays)

Linear Combinations

The E. Estimate Linear Combinations option on the ANALYSIS OF VARIANCE
OPTIONS menu allows you to estimate linear combinations of factor and treatment means.

When this option is executed you are presented with the LINEAR COMBINATION
OPTIONS menu. This menu is identical to the PAIRWISE COMPARISON OPTIONS menu
except that the T. Tukey Confidence Limits option is absent. The four options on this
menu are:

P. P-Values A. A Priori Confidence Limits

S. Scheffe Confidence Limits B. Bonferroni Confidence Limits

(Kleinbaum et al, Neter et al, Hays)

P-Values

The P. P-Values option on the LINEAR COMBINATION OPTIONS menu allows you to
calculate a priori p-values for linear combinations.

When this option is executed you are prompted to choose between calculating a linear
combination for factor means or treatment means:

If you choose factor means you are prompted to select the factor for which the linear
combination is to be made before you are prompted to specify the weights for the
individual means.

If you choose treatment means you are prompted to specify the weights for the
individual means.

The output for this option includes the value of the linear combination, the standard error of
this value, the t statistic for the hypothesis that this value is equal to zero, and the p-value
and p-value over two for the t statistic. (Neter et al)

A Priori Confidence Intervals

The A. A Priori Confidence Limits option on the LINEAR COMBINATION OPTIONS
menu allows you to calculate a priori confidence intervals for linear combinations.
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When this option is executed you are prompted to specify the level of confidence. You are
then prompted to choose between calculating a linear combination for factor means or
treatment means:

If you choose factor means you are prompted to select the factor for which the linear
combination is to be made before you are prompted to specify the weights for the
individual means.

If you choose treatment means you are prompted to specify the weights for the
individual means.

The output for this option includes the value of the linear combination, the standard error of
this value, the t statistic for the level of confidence you have chosen, this statistic times the
standard error, and the lower and upper limits for the confidence interval. (Neter et al)

Scheffe Confidence Intervals

The S. Scheffe Confidence Limits option on the LINEAR COMBINATION OPTIONS
menu allows you to calculate Scheffe confidence intervals for linear combinations.

When this option is executed you are prompted to specify the level of confidence. You are
then prompted to choose between calculating a linear combination for factor means or
treatment means:

If you choose factor means you are prompted to select the factor for which the linear
combination is to be made before you are prompted to specify the weights for the
individual means.

If you choose treatment means you are prompted to specify the weights for the
individual means.

The output for this option includes the value of the linear combination, the standard error of
this value, the Scheffe S statistic for the level of confidence you have chosen, this statistic
times the standard error, and the lower and upper limits for the confidence interval.

The output also includes the F statistic for the hypothesis that the linear combination is
equal to zero along with the p-value for this statistic. (Neter et al)

Bonferroni Confidence Intervals

The B. Bonferroni Confidence Limits option on the LINEAR COMBINATION OPTIONS
menu allows you to calculate Bonferroni confidence intervals for linear combinations.

When this option is executed you are prompted to specify the level of confidence and then
the number of comparisons to be considered. You are then prompted to choose between
calculating a linear combination for factor means or treatment means:
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If you choose factor means you are prompted to select the factor for which the linear
combination is to be made before you are prompted to specify the weights for the
individual means.

If you choose treatment means you are prompted to specify the weights for the
individual means.

The output for this option includes the value of the linear combination, the standard error of
this value, the Bonferroni B statistic for the level of confidence you have chosen, this
statistic times the standard error, and the lower and upper limits for the confidence

interval. (Neter et al)

Pairwise Comparisons

The C. Pairwise Comparisons option on the ANALYSIS OF VARIANCE OPTIONS menu
allows you to estimates the values for all possible pairwise comparisons of the factor level
and treatment means in the model being estimated.

When this option is executed you are presented with the PAIRWISE COMPARISON
OPTIONS menu. This menu offers you five options as to how the pairwise comparisons are
to be constructed:

P. P-Values A. A Priori Confidence Limits

T. Tukey Confidence Limits S. Scheffe Confidence Limits

B. Bonferroni Confidence Limits

(Neter et al)

P-Values

The P. P-Values option on the PAIRWISE COMPARISON OPTIONS menu allows you to
calculate a priori p-values for pairwise comparisons.

When this option is executed you are prompted to choose between calculating pairwise
comparisons for factor means or treatment means.

If you choose factor means you are prompted to select the factor for which the
pairwise comparisons are to be made before the comparisons are calculate and
displayed.

If you choose treatment means the comparisons are calculated and displayed.
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The output for this option includes the difference between all possible factor or treatment
means, the standard error of each difference, the t statistic for the hypothesis that this
difference is equal to zero, and the p-value and p-value over two for each t statistic. (Neter
et al)

A Priori Confidence Intervals

The A. A Priori Confidence Limits option on the PAIRWISE COMPARISON OPTIONS
menu allows you to calculate a priori confidence intervals for pairwise comparisons.

When this option is executed you are prompted to specify the level of confidence. You are
then prompted to choose between calculating pairwise comparisons for factor means or
treatment means:

If you choose factor means you are prompted to select the factor for which the
pairwise comparisons are to be made before the comparisons are calculated and
displayed.

If you choose treatment means the comparisons are calculated and displayed.

The output for this option includes the difference between all possible factor or treatment
means, the standard error of each difference, the t statistic for the level of confidence you
have chosen, this statistic times the standard error, and the lower and upper limits for the
confidence interval.

A matrix indicating significant differences is also included. (Neter et al)

Tukey Confidence Intervals

The T. Tukey Confidence Limits option on the PAIRWISE COMPARISON OPTIONS
menu allows you to calculate Tukey confidence intervals for pairwise comparisons.

When this option is executed you are prompted to specify the level of confidence. You are
then prompted to choose between calculating pairwise comparisons for factor means or
treatment means:

If you choose factor means you are prompted to select the factor for which the
pairwise comparisons are to be made before the comparisons are calculated and
displayed.

If you choose treatment means the comparisons are calculated and displayed.

The output for this option includes the difference between all possible factor or treatment
means, the standard error of each difference, the studentized range S statistic for the level
of confidence you have chosen, this statistic times the standard error, and the lower and
upper limits for the confidence interval.
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A matrix indicating significant differences is also included. (Neter et al)

Scheffe Confidence Intervals

The S. Scheffe Confidence Limits option on the PAIRWISE COMPARISON OPTIONS
menu allows you to calculate Scheffe confidence intervals for pairwise comparisons.

When this option is executed you are prompted to specify the level of confidence. You are
then prompted to choose between calculating pairwise comparisons for factor means or
treatment means:

If you choose factor means you are prompted to select the factor for which the
pairwise comparisons are to be made before the comparisons are calculated and
displayed.

If you choose treatment means the comparisons are calculated and displayed.

The output for this option includes the difference between all possible factor or treatment
means, the standard error of each difference, the Scheffe S statistic for the level of
confidence you have chosen, this statistic times the standard error, and the lower and
upper limits for the confidence interval.

A matrix indicating significant differences is also included. (Neter et al)

Bonferroni Confidence Intervals

The B. Bonferroni Confidence Limits option on the PAIRWISE COMPARISON OPTIONS
menu allows you to calculate Bonferroni confidence intervals for pairwise comparisons.

When this option is executed you are prompted to specify the level of confidence and then
the number of comparisons to be considered. You are then prompted to choose between
calculating pairwise comparisons for factor means or treatment means:

If you choose factor means you are prompted to select the factor for which the
pairwise comparisons are to be made before the comparisons are calculated and
displayed.

If you choose treatment means the comparisons are calculated and displayed.

The output for this option includes the difference between all possible factor or treatment
means, the standard error of each difference, the Bonferroni B statistic for the level of
confidence you have chosen, this statistic times the standard error, and the lower and
upper limits for the confidence interval.

A matrix indicating significant differences is also included. (Neter et al)



120

Regression

The regression options in ASP are available on the REGRESSION menu. You can access
this menu by clicking on:

STATISTICS -> Regression.

This menu has seven options:

P. Simple Regression M. Multiple Regression
W. Weighted Least Squares T. Two Stage Least Squares
A. Autocorrelation S. Stepwise Regression

L. Binary Logit Regression

(Efroymson, Frank and Althoen, Goldberger, Theil, Sincich, Neter et al)

Simple Regression

A simple, two variable, ordinary least squares regression model can be estimated by
executing the S. Simple Regression option on the REGRESSION menu.

When this option is executed you are prompted to select the dependent and independent
variables of the model.

There is an Include Constant check box at the bottom of the select variables form. By
default, this box is checked, and a constant is added to your regression model. If you want
to run a regression without a constant you must uncheck this box.

The output generated by this option is explained in Regression Output. ( Goldberger, Theil,
Sincich, Neter et al)

Multiple Regression

A multiple regression model can be estimated by executing the M. Multiple Regression
option on the REGRESSION menu.
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When this option is executed you are prompted to select the dependent and independent
variables of the model.

There is an Include Constant check box at the bottom of the select variables form. By
default, this box is checked, and a constant is added to your regression model. If you want
to run a regression without a constant you must uncheck this box.

The output generated by this option is explained in Regression Output. (Goldberger, Theil,
Sincich, Neter et al)

Weighted Least Squares

A weighted least squares regression model can be estimated by executing W. Weighted
Least Squares on the REGRESSION menu.

When this option is executed you are prompted to:

Select the dependent and independent variables of the model. There is an Include
Constant check box at the bottom of the select variables form. By default, this box is
checked. If you want to run a regression without a constant you must uncheck this box.

Select the variable by which to weight the regression data matrix. Each variable in the
model being estimated is subsequently multiplied by this variable.

The name of the weight variable is appended to the names of the other variables in the
model being estimated and you are given an opportunity to change these names.

There is an Include Constant check box at the bottom of the select variables form. By
default, this box is checked, and a constant is added to your regression model. If you want
to run a regression without a constant you must uncheck this box.

The output generated by this option is explained in Regression Output. (Goldberger, Thell,
Sincich, Neter et al)

Autocorrelation

An autocorrelation model can be estimated by executing the A. Autocorrelation option on
the REGRESSION menu.

When this option is executed you are prompted to:

Select the dependent and independent variables of the model and then to add a
constant variable. There is an Include Constant check box at the bottom of the select
variables form. By default, this box is checked. If you want to run a regression without
a constant you must uncheck this box.
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You are then prompted to specify the order of the autocorrelation process in this model.

The expression -rLi is appended on to the names of the variables in the model where i
is the order of the autocorrelation process. You are given the option of changing these
names.

You are then presented with the AUTOCORRELATION menu.

The original ordinary least squares estimates of the residuals, Durbin Watson statistic, and
autocorrelation coefficient(s) for the untransformed data are calculated, and the resulting
Durbin Watson statistic is displayed in a window at the top of this menu.

The original estimate(s) of the autocorrelation coefficient(s) in the ordinary least squares
model is (are) then used to transform the original regression data matrix.

The residuals, Durbin Watson statistic, and autocorrelation coefficient(s) for the
transformed data are then calculated and the new Durbin Watson statistic and
autocorrelation coefficient(s) are displayed. You are then presented with the
AUTOCORRELATION menu

This menu gives you four options by which to proceed:

E. Estimate Model allows you to estimate the model being run and to generate the
output for the model.

R. Reestimate Autocorrelation Coefficient(s) allows you to run another iteration of
the autocorrelation transformation. The Durbin Watson statistic and autocorrelation
coefficient(s) that result from this iteration will subsequently be listed below those
already listed.

C. Change Order allows you to change the order of the autocorrelation process.

S. Specify Autocorrelation Coefficient(s) allows you to specify the autocorrelation
coefficient(s) directly.

A. Add Constant option allows you to add the constant term back into the model in the
event this term is suppressed by the program. (The constant term is suppressed by the
program when the sum of the autocorrelation coefficients is approximately equal to
one.)

You can use the last four options to experiment with the model and the first option to exit
the AUTOCORRELATION menu to display the resulting output.

When the AUTOCORRELATION menu is exited by executing the E. Estimate Model
option the output for the model is generated.
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The output generated by this option is explained in Regression Output. It should be noted
that, if not suppressed, the constant variable is transformed by the program along with the
other independent variables. Thus, the estimate of the constant coefficient that appears in
the output is an unbiased estimate of the constant coefficient in the original model and does
not need to be transformed in the way it would have to be if the constant variable were not
transformed. (Goldberger, Theil, Sincich, Neter et al)

Two Stage Least Squares

A two stage least squares regression model can be estimated by executing the T. Two
Stage Least Squares option on the REGRESSION menu.

When this option is executed you are prompted to:
Select the dependent and independent variables.
Select the independent variables in the model that are endogenous.

Select the predetermined variables in the model from the variables in the data matrix
that do not appear in the equation being estimated.

The models components are then broken down and displayed and you are prompted to
verify its correctness.

There is an Include Constant check box at the bottom of the select variables form. By
default, this box is checked, and a constant is added to your regression model. If you want
to run a regression without a constant you must uncheck this box.

The output generated by this option is explained in Regression Output. (Theil, Goldberger)

Stepwise Regression

A stepwise regression can be run by executing the S. Stepwise Regression option on the
REGRESSION menu. When this option is executed:

You are prompted to select the dependent variable and the potential independent variables
of the model.

You are then prompted to specify the:
F value necessary to enter a variable into the regression equation.
F value necessary to drop a variable from the regression equation.

Minimum tolerance for entering a variable in the regression equation.
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Maximum number of steps to be calculated in estimating the model.

You are also given the option of suppressing the output header. This allows you to
suppress the list of variables that appears in the header of each page of output.

At this point the stepwise regression procedure begins by regressing the dependent
variable on the independent variable that has the highest R square with the dependent
variable and an F value that is greater than or equal to the specified minimum.

The program reports the variable that has been entered along with the R square, adjusted
R square, and standard error of estimate for the resulting regression equation. The
program also reports the coefficient of the variable that has been entered, its standard
error, and the F statistic, along with its degrees of freedom for the null hypothesis that the
true value of the coefficient is zero. This statistical output is reported at the end of each
step in the stepwise procedure.

For every variable after the first, the program checks to see if adding that variable has
reduced the F statistic of the other variables in the equation. If it has reduced the value of
this statistic for a particular variable below the specified minimum the variable is dropped.
The program reports the results of dropping this variable and then attempts to add another
variable.

The process of adding variables and checking to see if a variable should be dropped
continues until all of the variables in the equation have an F statistic that is above the
minimum value specified for dropping a variable, and all of the variables that are not in the
equation have an F statistic or a tolerance that is less than or equal to the specified
minimum for adding a variable.

The program then reports the partial R square and tolerance of each variable that is not
included in the equation. Also reported for each of these variables is the F statistic, along
with its degrees of freedom and probability value, for the null hypothesis that the true value
of its corresponding coefficient is zero.

When the display of output explaining the variables not in the equation is exited, all of the
output explained in Regression Output is generated. (Efroymson, Neter et al)

Binary Logit Regression

A binary logit regression model can be estimated by executing the L. Binary Logit
Regression option on the REGRESSION menu.

When this option is executed you are prompted to:

Select the dependent and independent variables of the model.
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Enter the convergence tolerance for the iterative estimating process and the maximum
number of iterations.

Choose between specifying the initial values for the iterative process or having the
program calculate them for you.

If you choose to specify the initial values you are prompted to enter each in turn.
The output is then generated and displayed.

If the iterative process does not converge to the convergence tolerance in the number of
iterations you have allowed, you will be given the option of adding more iterations or
generating output from the model as it is.

The output generated from this option follows the same pattern as that of the other options
on the REGRESSION menu, (Regression Output) but the output itself differs considerably
from that of the other options.

The table of coefficients and statistics contains the coefficients, their standard errors, their
Wald statistic, and the p-value of this statistic. It also contains the initial estimates,
tolerance, number of iterations, log likelihood, and number of covariate patterns in the
iterative estimating process. The logit R square, deviance, likelihood ratio, and Pearson chi
square and the p-values of these statistics are included as well.

The LOGIT OPTIONS menu also contains options that differ from the REGRESSIONS
OPTIONS menu. The options on this menu allow you to: plot, list, and add the residuals of
the model to the data matrix, list the variance/covariance matrix of the coefficients of the
model, calculate the unadjusted odds ratios for the model, perform a Hosmer-Lemeshow
test on the model, test reduced forms of the model, and generate a classification table for
the model. (Hosmer and Lemeshow )

Regression Output

When an option on the REGRESSION menu is executed you are prompted to select the
variables that specifies the model to be estimated. Once the model is specified and
estimated output is generated and displayed in two stages:

First, a TABLE OF COEFFICIENTS and statistics is generated and displayed.

When the table of coefficients and statistics is exited by pressing CONTINUE, the
REGRESSION OPTIONS menu is displayed. (Theil, Goldberger, Neter et al )

Table Of Coefficients And Statistics

For most routines on the REGRESSION menu the table of coefficients and statistics
includes an algebraic representation of the equation being estimated and a table that lists
the estimates of the coefficients in this equation.
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The values of the t statistics, along with their associated degrees of freedom and probability
values, for the null hypotheses that each individual coefficient is zero are listed in this table
as is the partial R square for each of the independent variables. The standard errors of the
individual coefficients are also listed.

Below the table the R square, adjusted R square, Durbin Watson statistic, and standard
error of estimate are reported along with the F statistic and its degrees of freedom and
probability value for the null hypothesis that the coefficients of all variables other than the
constant term are zero. (Theil, Goldberger, Neter et al)

Regression Options Menu

When the table of coefficients and statistics is exited the REGRESSION OPTIONS menu is
displayed.

There are eight options on this menu:

P. Plot/List/Save Residuals In V. Variance/Covariance Matrix
File

B. Beta Weights E. Forecast Dependent Variable

A. Analysis Of Variance Table R. Test For Reduced Model

L. Test For Linear Fit I. Variance Inflation Factors

These options allow you to examine the model being estimated in greater detail.
(Goldberger, Theil, Sincich, Neter et al)

Plot/List/Save Residuals In File

The P. Plot/List/Save Residuals In File option on the REGRESSION OPTIONS menu
allows you to calculate the standardized, studentized, and jackknife residuals in the model
being estimated along with the leverage and influence of each residual as well as the
estimated value of the dependent variable.

When this option is estimated you are presented with the LIST/PLOT/ADD RESIDUALS
menu. This menu has four options:

D. Add Variables To Data Matrix L. List Leverage, Student, Etc.

P. Plot Standardized Residuals  A. List Actual/Estimated/Residual

D. Add Variables To Data Matrix allows you to add the standardized, studentized, and
jackknife residuals in the model being estimated to the data matrix in memory along with
the leverage and influence of each residual and the estimated value of the dependent
variable.
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When this option is executed you are prompted to select the variables to be added to the
data matrix in memory and are then given the opportunity to change the names of these
variables. The selected variables are then added to the end of the data matrix in memory.

P. Plot Standardized Residuals allows you to plot the standardized residuals in the model
being estimated. When this option is executed the residuals and standardized residuals are
listed along with a vertical sequence character plot of the standardized residuals.

L. List Leverage, Student, Etc. allows you to list the residuals along with the
standardized, leverage, studentized, influence, and jackknife values for each residual.
When this option is executed these values are listed.

A. List Actual/Estimated/Residual allows you to list the actual value of the dependent
variable in the model being estimated along with its estimated value and the residual
implied by the difference between the actual value and its estimated value. When this
option is executed these values are listed. (Neter et al)

Variance/Covariance Matrix

The V. Variance/Covariance Matrix option on the REGRESSION OPTIONS menu allows
you to list the variance/covariance matrix for the coefficients of the model being estimated.
(Goldberger, Theil, Sincich, Neter et al)

Beta Weights

The B. Beta Weights option on the REGRESSION OPTIONS menu allows you to list the
beta weights associated with each independent variable in the model being estimated.
(Neter et al)

Analysis Of Variance Table

The A. Analysis Of Variance Table option on the REGRESSION OPTIONS menu
displays an analysis of variance table for the model being estimated.

This table contains the regression, residual, and total sums of squares along with their
respective degrees of freedom and the regression and residual mean squares. The F
statistic, along with its degrees of freedom and probability value, for the null hypothesis that
the coefficients of all variables other than the constant term are zero are also given.
(Goldberger, Theil, Sincich, Neter et al)

Test For Reduced Model

The R. Test For Reduced Model option on the REGRESSION OPTIONS menu allows you
to test hypotheses on subsets of variables in the model being estimated.
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When this option is executed you are prompted to choose between dropping variables from
the model or specifying a set of constraints on the coefficients of the model. How the
program proceeds and the output generated depends on your choice in this regard:

If you choose to drop variables from the model you are prompted to select the
variables to drop. The full and reduced models are then displayed along with the error
sums of squares for these models and the F statistic with its p-value for the hypothesis
that the true coefficients of the dropped variables are zero.

If you choose to specify constraints you are prompted to specify the number of
constraints to specify, and then to specify, in turn, the weight for each coefficient in each
constraint. The output includes the error sums of squares for the full and reduced
models along with the F statistic and its p-value for the hypothesis that the constraints
hold for the model. ( Neter et al)

Test For Linear Fit

The L. Test For Linear Fit option on the REGRESSION OPTIONS menu allows you to test
the model being estimated for linearity.

The output from this option includes the regression, lack of fit, and pure error sums of
squares, degrees of freedom, and mean squares.

Also included is the F statistic (RMS/PEMS), along with its degrees of freedom and p-value,
for the null hypothesis that coefficient of determination is equal to zero, and the F statistic
(LFMS/PEMS) for the null hypothesis that the true model being estimated is a linear
function of the variables included in the model. (Frank and Althoen )

Variance Inflation Factors

The I. Variance Inflation Factors option on the REGRESSION OPTIONS menu allows
you to list the variance inflation factors for the coefficients of the model being estimated.
(Neter et al)

Forecast Dependent Variable

The F. Forecast Dependent Variable option on the REGRESSION OPTIONS menu
allows you to use the model being estimated to forecast the dependent variable.

When this option is executed:

You are first presented with a menu of options from which to choose the kind of
confidence limits you want for your forecast:

F. Single Period Confidence Limits
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S. Scheffe Confidence Limits

B. Bonferroni Confidence Limits

W. Working-Hotelling Confidence Limits

If you have selected the Scheffe or Bonferroni interval, you are prompted to enter the
number of forecasts to be considered.

Next you are prompted to enter the degree of confidence for these limits.

You are then prompted to enter the values for the independent variables for which the
forecast is to be made.

The forecast is then generated and displayed. The output generated by this routine
depends on the kind of confidence limits you have chosen. (Neter et al)

Single Period Confidence Limits

The F. Single Period Confidence Limits option on the FORECAST OPTIONS menu
generates a forecast of the dependent variable and its expected value.

It also generates the standard error of the forecast and its expected value, the t statistic for
the specified level of confidence, the standard errors times this t statistic, and the
confidence intervals for the forecast and its expected value. (Neter et al)

Scheffe Confidence Limits

The S. Scheffe Confidence Limits option on the FORECAST OPTIONS menu generates
a forecast of the dependent variable and the Scheffe S statistic for the specified number of
forecasts and level of confidence.

It also generates the standard error of the forecast, the S statistic times this standard error,
and the confidence interval for the forecast. (Neter et al)

Bonferroni Confidence Limits

The B. Bonferroni Confidence Limits option on the FORECAST OPTIONS
menu generates confidence limits for a specific number of forecasts of the dependent
variable, the means of these forecasts, and their expected values.

It also generates the standard errors of the forecasts, their means, and expected values,
the Bonferroni B statistic for the specified number of forecasts and level of confidence, the
B statistic times the standard errors, and the confidence intervals for the forecasts, their
mean, and expected value. (Neter et al)
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Working-Hotelling Confidence Limits

The W. Working-Hotelling Confidence Limits option on the FORECAST OPTIONS menu
generates a forecast of the dependent variable, its standard error, and the Working-
Hotelling W statistic for the specified level of confidence.

It also generates the W statistic times the standard error and the confidence interval for the
forecast. (Neter et al)
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Factor Analysis

There are a number of factor analysis options available in ASP. You can access these
options by clicking on:

STATISTICS -> Factor Analysis
When you execute the Factor Analysis option:

You are prompted to specify whether you wish to enter a set of variables or the columns
of a correlation or covariance matrix.

You are then prompted to select the variables or columns to be used in the factor
analysis.

Next you must specify whether you wish to undertake a principal component or a factor
analysis of the matrix to be factored.

The way in which the program proceeds at this point depends on whether you wish to
undertake a principal component or a factor analysis:

If you wish to undertake a factor analysis you are presented with the
COMMUNALITIES OPTIONS menu. When this menu is exited the matrix is factored
using the method you have chosen, and the resulting output is obtained through the
FACTOR ANALYSIS OPTIONS menu.

If you wish to undertake a principal component analysis you are prompted to
specify the maximum number of factors to extract from the matrix to be factored and
the minimum acceptable eigen value for a factor. At this point the matrix is factored
using the principal factor method and the resulting output is obtained through the
FACTOR ANALYSIS OPTIONS menu.

(Harman, Joreskoq)

Principal Components Analysis
A principal components analysis can be undertaken by clicking on:
STATISTICS -> Factor Analysis,

selecting the variables or columns of the data matrix to be analyzed, and responding
PRINCIPAL to the PRINCIPAL Component or FACTOR Analysis? prompt. ASP then
calculates a principal factor solution to the matrix to be factored.
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If the inputted matrix is a correlation matrix with ones in the diagonal, or if a set of variables
is inputted and then a correlation or matrix is calculated the result is a principal components
analysis of the matrix being factored.

The output generated by this analysis is obtained through the FACTOR ANALYSIS
OPTIONS menu. (Harman)

Communalities Options Menu

If you respond FACTOR to the PRINCIPAL Component or FACTOR Analysis? prompt
when executing the Factor Analysis option on the STATISTICS menu, ASP provides seven
options for estimating communalities:

R. Largest Row Correlation S. Squared Multiple Correlation
C. Principal Components Variance |. lteration By Refactoring
G. Generalized Least Squares M. Maximum Likelihood

U. Unweighted Least Squares

(Harman)

Direct Estimates Of Communalities

Three options on the COMMUNALITIES OPTIONS menu provide for direct estimates of the
communalities in a common factor model:

R. Largest Row Correlation allows you to replace each diagonal element of the matrix
to be factored by the largest non diagonal element in its row.

S. Squared Multiple Correlation allows you to replace each diagonal element of the
matrix to be factored by the squared correlation of the corresponding variable with all of
the remaining variables in the system.

C. Principal Components Variance allows you to replace each diagonal element of
the matrix to be factored by the variance implied by the principal component solution of
the matrix for all factors with corresponding eigen values greater than one.

The formats by which these three options are executed are identical:

You are first prompted to specify the maximum number of factors to extract from the
matrix to be factored and the minimum acceptable eigen value for a factor.

The matrix to be factored is then factored via the principal factor method.
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The output generated is obtained via the FACTOR ANALYSIS OPTIONS menu.
(Harman)

Iteration By Refactoring

An iteration by refactoring solution to the factor analysis problem can be obtained by
executing the I. Iteration By Refactoring option on the COMMUNALITIES OPTIONS
menu.

When this option is executed:

You are prompted to specify the maximum number of factors to extract and the
minimum acceptable eigen value.

Next you are prompted to specify the maximum number of iterations the program is to
run and a convergence tolerance.

You are then prompted to indicate whether the starting values for the communalities to
be estimated are to be calculated by the program from the diagonal elements of the
matrix to be factored or are to be entered by you.

If you choose to enter the starting values you are prompted to enter these values in
turn.

The program then proceeds to calculate an iterative solution to the factoring problem by:

Calculating a principal factor solution to the matrix being factored for the specified
number of factors.

Calculating the sum of squares of the factor coefficients to be used for the estimates of
the communalities in the next iteration.

Calculating a new principal factor solution to the matrix being factored with the new
estimates of the communalities in the diagonal of this matrix.

These steps are repeated until the maximum difference between successive estimates of
the communalities is less than the specified convergence tolerance or until the specified
maximum number of iterations is exceeded.

In the latter case you are given the option of increasing the maximum number of iterations
and/or of changing the value of the specified convergence tolerance.

When the iterative process is ended, the output generated is obtained via the FACTOR
ANALYSIS OPTIONS menu

The total number of iterations and the actual convergence tolerance appears in the header
of the output from this option. (Harman )
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Generalized Least Squares

A generalized least squares solution to the factor analysis problem can be obtained by
executing the G. Generalized Least Squares option on the COMMUNALITIES OPTIONS
menu.

When this option is executed:
You are prompted to specify the maximum number of factors to extract.

You are then prompted to specify the maximum number of iterations the program is to
run and a convergence tolerance.

If a correlation matrix is entered into the program (rather than a set of variables) you are
prompted to enter the number of observations on the original variables from which the
correlation/covariance matrix was calculated. If this number is not known you may enter
a missing value (i.e., an M or *) in which case the program will not be able to calculate
the chi square statistic and reliability coefficient.

The program then proceeds to calculate an iterative generalized least squares solution to
the factoring problem by minimizing the function:

where denotes the vector of estimated communalities,  the th eigen value of the

matrix being factored, the total number of variables, and the number of factors
extracted.

The iterative process continues until the maximum difference between successive
estimates of the communalities is less than the specified convergence tolerance or until the
specified maximum number of iterations is exceeded.

In the latter case you are given the option of increasing the maximum number of iterations
and/or of changing the value of the specified convergence tolerance.

When the iterative process is ended the output generated is obtained via the FACTOR
ANALYSIS OPTIONS menu.

The minimum value of the above function along with the total number of iterations and the
actual convergence tolerance appear in the header of the output from this option.

In certain situations the program will be stopped by a DOMAIN ERROR when the algorithm
attempts to invert a singular matrix. This situation generally indicates an attempt to extract
too many factors or possibly the use of inappropriate starting values. It can be remedied by
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reducing the maximum number of factors to be extracted or by using different starting
values. (Harman, Joreskoq)

Maximum Likelihood Estimation

A maximum likelihood solution to a factor analysis problem can be obtained by executing
the M. Maximum Likelihood option on the COMMUNALITIES OPTIONS menu.

The format by which this option is executed is identical to that of the G. Generalized Least
Squares option, the only difference being that the function to be minimized is given by:

m(‘P}=% S (log Ay ~ 1417 4, ~1)

Hamf 4+l

(Harman, Joreskoq)

Unweighted Least Squares

An unweighted least squares solution to a factor analysis problem can be obtained by
executing the U. Unweighted Least Squares option on the COMMUNALITIES OPTIONS
menu.

The format by which this option is executed is identical to that of the G Generalized Least
Squares option, the only difference being the function to be minimized. (Harman,

Joreskoq)

Factor Analysis Output

The output generated from the J. Factor Analysis option on the STATISTICS menu,
whether it be a principal components or a common factor analysis problem, is accessed
through the FACTOR ANALYSIS OPTIONS menu. This menu contains ten options:

D. Extract Additional Factors C. Reestimate Communalities

E. Estimate Another Model M. Correlation Matrix

F. Factor Loadings R. Rotate Factors
S. Factor Scores A. Residual Matrix
P. Plot Eigen Values N. Canonical Form

The D. Extract Additional Factors, C. Reestimate Communalities, and E. Estimate
Another Model options on this menu do not generate output:
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The first allows you to change the maximum number of factors to extract and/or to respecify
the minimum acceptable eigen value. This option appears on the FACTOR ANALYSIS
OPTIONS menu only when a principal factor solution has been calculated for the particular
problem being examined.

The second allows you to return (or go) to the COMMUNALITIES OPTIONS menu without
reentering or recalculating the correlation matrix to be factored. This option makes it
possible to use the resulting estimates of a particular option on the COMMUNALITIES
OPTIONS menu as starting values in one of the three iterative options (I, G, or M) on this
menu. (See Factor Analysis Output/Correlation Matrix )

The third allows you to enter a new set of variables or a matrix without returning to the
STATISTICS menu. When this option is executed you are prompted to change the current
data matrix and to select a new set of variables or a new matrix. The process of specifying
a factor analysis model is then begun anew. (Harman, Joreskoq)

Correlation Matrix

Executing the M. Correlation Matrix option on the FACTOR ANALYSIS OPTIONS menu
yields a listing of the correlation matrix that has been factored. It should be noted that this
matrix has estimates of the communalities in its diagonal and is the actual matrix that has
been factored.

Furthermore, if the C. Reestimate Communalities option is subsequently executed this
matrix, with its estimates of the communalities in the diagonal, is the matrix that is available
to the options on the COMMUNALITIES OPTIONS menu. This makes it possible to use the
resulting estimates of a particular option on the COMMUNALITIES OPTIONS menu as
starting values in one of the three iterative options (I, G, or M) on this menu. This is
accomplished by:

Executing the particular option.

Executing the C. Reestimate Communalities option when the FACTOR ANALYSIS
OPTIONS menu appears.

Executing one of the iterative options on the COMMUNALITIES OPTIONS menu.

Responding NO to the subsequent Calculate Starting Values? prompt.

At this point you will be prompted to enter the individual starting values. The default values
of the prompts to enter the initial values will be the estimate of the communality in the
diagonal of the correlation matrix. (Harman)

Factor Loadings

Factor loadings can be obtained by executing the F. Factor Loadings option on the
FACTOR ANALYSIS OPTIONS menu.




137

In addition to the factor loadings, the variances of each factor and of the variables across
the set of factors are presented, along with the estimates of the communalities in the model
that has been estimated.

The variance of each factor and the total variance as a percent of the total communality is
also presented. (Harman)

Factor Scores

Factor scores can be obtained by executing the S. Factor Scores option on the FACTOR
ANALYSIS OPTIONS menu and also in response to the Calculate Factor Scores? prompt
that appears when the output display from a factor rotation option is exited.

These scores are calculated directly in the case of a principal components analysis and are
calculated using the regression technique in the common factor analysis case. (Harman)

Residual Matrix, Eigen Values, And Canonical Form

The A. Residual Matrix option on the FACTOR ANALYSIS OPTIONS menu allows you to
examine the matrix of residuals in the model being estimated.

The V. Eigen Values option on the FACTOR ANALYSIS OPTIONS menu allows you to
lists the eigen values of the matrix that has been factored. This option only available if the
matrix has been factored using the principal factor method.

The N. Canonical Form option on the FACTOR ANALYSIS OPTIONS menu allows you to
put the extracted factors in canonical form. (Harman)

Factor Rotations

The R. Rotate Factors option on the FACTOR ANALYSIS OPTIONS menu yields the
ROTATION OPTIONS menu. This menu has four options:

V. Varimax O. Orthoblique (Varimax)

Q. Quartimax B. Orthoblique (Quartimax)

The first two of these options yield orthogonal rotations, the second two yield oblique
rotations. (Harman, Joreskoq)

Orthogonal Rotations
There are two orthogonal rotation options on the ROTATIONS OPTIONS menu:

V. Varimax produces a varimax rotation by providing an iterative solution to the problem of
maximizing the function V:
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where ’Egii"denotes the -/ th loading of the ith rotated factor weighted by the reciprocal of the
estimate of the “th communality, # denotes the number of variables in the model, and
%the number of factors being rotated.

Q. Quartimax produces a quartimax rotation by providing an iterative solution to problem of
maximizing the function 2.
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where b?i"denotes the -/ th loading of the ith rotated factor and #and % are as defined above.
When either of these options is executed you are prompted to specify:

The number of factors to rotate.

The maximum number of iterations the program is to run.

The convergence tolerance.

The rotated factor loadings are then calculated and displayed in a format that is essentially
identical to that of the F. Factor Loadings except for the labeling. (Harman)

Oblique Rotation
There are two oblique rotation options on the ROTATIONS OPTIONS menu:

O. Orthoblique (Varimax) combines the orthoblique algorithm with the varimax algorithm
to rotate the factors.

B. Orthoblique (Quartimax)combines the orthoblique algorithm with the quartimax
algorithm to rotate the factors.

The formats by which these two options are executed are similar to that explained above
for the execution of the orthogonal rotation options in that you are prompted to specify the:

Number of factors to rotate.

Maximum number of iterations.
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Convergence tolerance.

However, when one of the oblique options is executed you are also prompted to specify the
value of the proportionality exponent, which defines the nature of the orthoblique solution.
This exponent can take any value from zero to one half:

A value of zero yields an orthoblique independent cluster solution.

A value of one half yields either a varimax or quartimax solution depending on whether
option O. Orthoblique (Varimax) or B. Orthoblique (Quartimax) is executed.

A value of this exponent that lies between zero and one half yields an orthoblique/varimax
or quartimax proportional solution.

Except for labeling, the format of the output generated by the two oblique rotation options is
the same and comes in two parts:

The first part is the pattern matrix of the rotated factors. This output contains all of the
header information along with the factor pattern coefficients. It also contains a correlation
matrix below the factor pattern coefficients that gives the correlations between the factor
pattern vectors.

The second part is the structure matrix of the rotated factors.

When the display of output for either the orthogonal or oblique rotation options on the
ROTATION OPTIONS menu is exited by clicking on CONTINUE you are prompted to
calculate factor scores. If you choose to calculate factor scores you are subsequently given
the option of adding these scores to the current data matrix. (Harman)
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Time Series Analysis

You can access the TIME SERIES menu by clicking on:
STATISTICS -> Time Series Analysis.

This menu has nine options:

N. Naive Forecast M. Simple Moving Average

E. Simple Exponential Smoothing L. Linear Exponential Smoothing
S. Seasonal Linear Exponential A. Adaptive Filtering

Smoothing

D. Seasonal Decomposition R. ARIMA Mode

C. Auto/Partial Correlation Plot

(Wheelwright and Makridakis, Box and Jenkins)

Naive Forecast

The N. Naive Forecast option on the TIME SERIES menu forecasts the next period’s value

(Fﬂl) of the variable to be forecasted by assuming it will be the same as the current

period’s value (< ):

F

+

1=X:r_

When this option is executed you are prompted to select the variable to be examined and
then the NAIVE FORECAST OPTIONS menu is presented.

The output from this option is as explained in Time Series Output. (Wheelwright and
Makridakis)

Simple Moving Average

The M. Simple Moving Average option on the TIME SERIES menu forecasts the next

period’s value (F='+1) of the variable to be forecasted (X ) by averaging its last® values:
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When this option is executed you are prompted to select the variable to be examined and
to specify the number of periods to be averaged. The SIMPLE MOVING AVERAGE
OPTIONS menu is then presented. The output from this option is as explained in Time
Series Output. (Wheelwright and Makridakis)

Simple Exponential Smoothing

The E. Simple Exponential Smoothing option on the TIME SERIES menu forecasts the

next period’s value (F='+1) of the variable to be forecasted (<) by adjusting the current
period’s forecast of this variable by a fraction () of the error in this forecast:

Fz+1=Fz+m':X:r_Fz:'_

The fraction is the smoothing adjustment factor. (Wheelwright and Makridakis)

When this option is executed you are prompted to select the variable to be examined and
then to specify a smoothing adjustment factor. The SIMPLE EXPONENTIAL SMOOTHING
OPTIONS menu is then presented.

The output from this option is as explained in Time Series Output. (Wheelwright and
Makridakis)

Linear Exponential Smoothing

The L. Linear Exponential Smoothing option on the TIME SERIES menu forecasts the

next period’s value (F='+1) of the variable to be forecasted (<1 ) by adding a trend factor (T')
to a smoothed value ()

F:,+1:S:,+?;

The trend factor and smoothed values are, in turn, given by:

5, = o, + (1- (S, +Ty)
T =B, S +(1- AT,

Where £ is a smoothing adjustment factor and ¥ is a trend adjustment factor.

When a forecast is to be made ¥ periods ahead it is given by:
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F:r+1 :S:"'MT;

Initial values are determined by regression.

When this option is executed you are prompted to select the variable to be examined and
then to specify the smoothing and trend adjustment factors. (Wheelwright and Makridakis)

The output from this option is as explained Time Series Output, except that the smoothed
and trend values are also presented in the output matrix for this option. (Wheelwright and
Makridakis)

Seasonal Linear Exponential Smoothing

The S. Seasonal Linear Exponential Smoothing option on the TIME SERIES menu

forecasts the next period’s value (F=‘+1) of the variable to be forecasted (- ) by multiplying
the sum of the trend factor (7') and smoothed value (%) by a seasonal factor ({):

F:r+1 = ':S:r +T;:If:,.

The trend factor, smoothed values, and seasonal factor are, in turn, given by:

Sz = (5"-}{: ! iT:r-1:' +(1- "-3:”:3:-1 +T:r-1:' )

T= B, - S +(1- AT

L=y X 08 +(1- ;V}f,_l_

where & is a smoothing adjustment factor, £ is a trend adjustment factor, and ¥ is a
seasonal adjustment factor.

When a forecast is to be made ¥ periods ahead it is given by:

F:r+M =S:r+ﬂfﬂ1:r:'f:r_

Initial values are determined by regression.

When this option is executed you are prompted to select the variable to be examined and
then to specify the smoothing, trend, and seasonal adjustment factors along with the
number of seasonal periods.
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The output from this option is as explained in Time Series Output, except that the
smoothed and trend values are also presented in the output matrix along with the seasonal
indices. (Wheelwright and Makridakis)

Adaptive Filtering

The A. Adaptive Filtering option on the TIME SERIES menu forecasts the next period’s

value (F=‘+1) of the variable to be forecasted (< ) by multiplying previous values of £ by a

set of weights (™ ):

N
Fa= ZWiX—hl

iml

where " is the weight for the Zth period’s value of < and# is the number of weights.

The weights (™) are determined by an iterative scheme wherein initial weights are chosen
and used to forecast % .

The error in this forecast ( ) is then used to adjust the weights via the formula:

W, =W, +2ke A

i =

Where £ is a learning constant specified by you.

When a forecast is to be made # periods ahead it is determined by making 4 one period
forecasts weighting previously forecasted values. (Wheelwright and Makridakis)

When this option is executed you are prompted:

To select the variable to be examined.

To specify the number of weights to appear in the model,

To specify a learning constant by which the weights are to be adjusted.

To specify a convergence tolerance, which defines the point at which the iterative process
has converged.

To specify the maximum number of iterations that are to be attempted.

You are then prompted to choose between having the program calculate the initial weights
that are to be used to start the iterative process and entering these weights at the
keyboard.
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If you choose to enter the initial weights you are prompted to do so. If you do not choose to
enter the initial weights the program assigns initial weights equal to 1/n.

In either event, once the initial weights have been determined the iterative process by
which the final weights are determined is begun. The iterations continue until either the
maximum change in a weight from the previous iteration is less than the specified
convergence tolerance, or until the specified maximum number of iterations has been
reached, in which case you are prompted to add additional iterations.

The output from this option is as explained in Time Series Output, except that the
smoothed and trend values are also presented in the output matrix. (Wheelwright and
Makridakis)

Seasonal Decomposition

The D. Seasonal Decomposition option on the TIME SERIES menu forecasts the next
period’s value of the variable to be forecasted using classical decomposition techniques.

When this option is executed you are prompted to select the variable to be examined and
then to specify the number of seasonal periods in the unit time period.

The output from this option is as explained in Time Series Output, except that the
deseasonalized values of the variable being examined (indicated by adding (Des.) To the
variable name) are reported along with the seasonal indices, trend values, the 3*3 centered
moving average, and the cyclical indices. (Wheelwright and Makridakis)

ARIMA Models

The R. ARIMA Model option on the TIME SERIES menu forecasts the next period’s value
of the variable to be forecasted using Box Jenkins autoregressive, integrated moving
average techniques. (Box and Jenkins)

When this option is executed you are:
Prompted to select the variable to be forecasted.
Given the option of applying a log or power transformation to the variable.

Prompted to specify the order of the autoregressive process, the order of the moving
average process, the degree of differencing, the number of seasonal periods, the order of
the seasonal autoregressive Process, the order of the seasonal moving average process,
and the degree of seasonal differencing.

Given the option of adding or suppressing the constant in the model.
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Prompted to enter the convergence tolerance for the iterative estimating process and the
maximum number of iterations.

Given the choice between specifying the initial values for the iterative process or of having
the program calculate them for you. If you choose to specify the initial values you are
prompted to enter each in turn.

The output is then generated and displayed.

If the iterative process does not converge to the convergence tolerance in the number of
iterations you have allowed, you will be given the option of adding more iterations or
generating output from the model as it is.

The output from this option is as explained in Time Series Output. (Wheelwright and
Makridakis, Box and Jenkins)

Auto/Partial Correlation Plot

The A. Auto/Partial Correlation Plot option on the TIME SERIES menu generates both
auto and partial correlation plots.

The execution and output for this option is identical to the identical option on the
CHARACTER PLOTS menu. (Wilk and Gnanadesiikan, Box and Jenkins)

Time Series Output

The output from the options on the TIME SERIES menu is obtained through the TIME
SERIES OPTIONS menu. This menu is presented once the model being estimated is
specified.

Statistics summarizing the model are presented in a window at the top of the TIME SERIES
OPTIONS menu. These statistics include the mean error, percent error, absolute error,
absolute percent error, and squared error for the estimated forecasting routine along with
the next period forecast.

In addition, there are five options on this menu:

R. Reestimate Model 0. Output Matrix And Error Plot

N. N Period Forecast A. Add Variables To Data Matrix

E. Error Correlation Plot

R. Reestimate Model option you to reestimate the model being estimated.
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O. Output Matrix And Error Plot allows you to view the output matrix for the forecasting
routine being executed.

This matrix contains the actual value of the variable being forecasted along with its
forecasted value for each period and the amount of error in each forecast. There may be
other information that is specific to a particular forecasting routine.

This option also allows you to plot the forecast errors of the model being estimated.

N. N Period Forecast allows you to use the model that has been estimated to forecast N
periods into the future.

A. Add Variables To Data Matrix allows you to add columns from the output matrix to the
current data matrix.

E. Error Correlation Plot allows you to plot autocorrelations and partial autocorrelations in
the errors of the model being estimated. (Wheelwright and Makridakis, Box and Jenkins)
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Auxiliary Programs

There are a number of supplementary routines in ASP that handle computational chores.
They are to be found on the AUXILIARY PROGRAMS menu.

This menu has seven options:

Linear Equations Matrix Operations
Eigen Values Determinants
Depreciation Interest Rates

Linear Programming

You can access this menu by clicking on:

AUXILIARY

Solving Linear Equations
A set of linear equations can be solved by clicking on:
AUXILIARY -> Linear Equations.

You are then prompted to specify the coefficient matrix of the set of equations to be solved
by selecting variables from the current data matrix.

In specifying this matrix it is assumed that the equation system to be solved is of the form:
B = AX.

Where B is the vector of constants in the system, and A is the n by n matrix of coefficients
of the n variables in the vector X.

The coefficient matrix to be specified is the n by n+1 matrix in which the first column is the
vector of coefficients B, and the next n columns are the columns of the matrix A.

Eigen Values

The eigen values of a square matrix can be calculated by clicking on:
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AUXILIARY -> Eigen Values.

In response you are prompted to specify the matrix for which the eigen values are to be
calculated by selecting the appropriate variables and cases from the current data matrix.

Determinant
The determinant of a square matrix can be calculated by clicking on:
AUXILIARY -> Determinant.

In response you are prompted to specify the matrix for which the determinant is to be
calculated by selecting the appropriate variables and cases from the current data matrix.

Depreciation
A depreciation schedule for an asset can be calculated by clicking on:
AUXILIARY -> Depreciation.
In response you are prompted to enter the:
Cost of the asset to be depreciated,
Useful life of the asset, that is, the number of years over which it is to be depreciated.
Salvage value of the asset.

The value of the asset’s depreciation along with its book value are calculated for each year
of its useful life using straight line, sum of the year’s digits, 200% declining balance, and
150% declining balance techniques.

Linear Programming
A linear programming problem can be solved by clicking on:
AUXILIARY -> Linear Programming.

You are then prompted to specify the coefficient matrix of the linear programming problem
to be solved by selecting the appropriate variables and cases from the current data matrix.

This routine assumes that the coefficients of the objective function are contained in the first
row of the coefficient matrix to be specified and that the first element of this row is specified
as a missing value.
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It also assumes that the values of the constants in the constraints of the linear
programming problem to be solved are contained in the first column of this matrix and that
the first element of this column, (which is, of course, the first element of the first row) is
specified as a missing value.

Finally, this routine assumes that:

For a maximization problem the sum of the products of the choice variables and the
coefficients in each constraint are less than or equal to the constant term.

For a minimization problem the sum of these products is greater than or equal to the
constant term.

Thus, it is assumed that the standard maximization problem to be solved is of the
form:

A
Obj = 2 s 5
Max: fml

w
Bz 2 and
st El letON,

and that the standard minimization problem to be solved is of the form:

iy
Obj =3 ayX,
Max: =1
Iy
Bo=xaX,
st Zo J=loN,

Where By denotes the 3 constants in the # constraints, A denotes the ¥ choice

(M +1)x N

variables, and “¥ denotes the coefficients in the objective function (f - I3)

and constraints (< * °).

As a result, when the Linear Programming option on the AUXILIARY menu is executed
you must select the number of variables plus one (% +1) when you select variables for the
columns of the coefficient matrix, and the first variable you select must correspond to the

vector of constants (B-?') in the linear programming problem to be solved padded with a
missing value as the first element.

The next & variables selected must correspond to the vectors of coefficients (aii") of the &
choice variables in the objective function and constraints.
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Once the columns of the coefficient matrix have been specified you must specify whether
the objective function is to be maximized or minimized.

In response an algebraic representation of the model to be solved is displayed and you are
prompted to verify the appropriateness of the model.

The simplex method is used to optimize the objective function. The values of the choice
variables in both the primal linear programming problem and its dual (Pi) are reported as
are the values of the slack/surplus variables (Si) in each of the constraints.

Matrix Operations Menu
You can access the MATRIX OPERATIONS menu by clicking on:
AUXILIARY -> Matrix Operations.

There are six options on this menu:

S. XX A. X (+,-xetc...)Y T.X
C. C_reate Binary M. XY l. Inverse Of X
Matrix E—

Multiplying By Transpose
The S. X’X option on the MATRIX OPERATIONS menu allows you to premultiply a matrix
by its transpose.

When this option is executed you are prompted to load the file from which the X matrix is to
be specified and are given the option of selecting variables and cases from this file.

The specified matrix is then pre-multiplied by its transpose, and the results are displayed.

Once the results are displayed you can save this result in an ASP data file or add it to the
data matrix in memory by clicking on the Save button at the bottom of the output display.

Algebraic Operations

The A. X(+,-,x,etc...)Y option on the MATRIX OPERATIONS menu allows you to perform
algebraic operations on corresponding elements of two matrices.

When this option is executed you are first prompted to load the file from which the X matrix
is to be specified and then to load the file from which the Y matrix is to be specified. You
are given the option of selecting variables and cases from these two files.
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You are then prompted to select the operator or relation to be used to operate on
corresponding elements of the X and Y matrices.

The algebraic operation is then carried out, and the results are displayed.

Once the results are displayed you can save this result in an ASP data file or add it to the
data matrix in memory by clicking on the Save button at the bottom of the output display.

Matrix Multiplication

The M. XY option on the MATRIX OPERATIONS menu allows you to multiply one matrix
by another.

When this option is executed you are first prompted to load the file from which the X matrix
is to be specified and then to load the file from which the Y matrix is to be specified. You
are given the option of selecting variables and cases from these two files.

The Y matrix is the pre-multiplied by the X matrix, and the results are displayed.

Once the results are displayed you can save this result in an ASP data file or add it to the
data matrix in memory by clicking on the Save button at the bottom of the output display.

Transposing A Matrix
The T. X’ option on the MATRIX OPERATIONS menu allows you to transpose a matrix.

When this option is executed you are prompted to load the file from which the X matrix is to
be specified and are given the option of selecting variables and cases from this file.

The transpose is then carried out and the results are displayed.

Once the results are displayed you can save this result in an ASP data file or add it to the
data matrix in memory by clicking on the Save button at the bottom of the output display.

Inverse Of A Matrix

The I. Inverse Of X option on the MATRIX OPERATIONS menu allows you to find the
inverse of a matrix.

When this option is executed you are prompted to load the file from which the X matrix is to
be specified and are given the option of selecting variables and cases from this file.

The inverse of the specified matrix is then calculated and the results are displayed.

Once the results are displayed you can save this result in an ASP data file or add it to the
data matrix in memory by clicking on the Save button at the bottom of the output display.
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Create Binary Matrices

The C. Create Binary Matrix option on the MATRIX OPERATIONS menu allows you
to create of binary matrices. When this option is executed you are presented with the
BINARY MATRIX OPTIONS menu.

There are six option on this menu:

|. Identity Matrix S. Sum Matrix L. Lower Trianqular Matrix
U. Upper Triangular B. Below Diagonal Matrix A. Above Diagonal Matrix
Matrix

When one of these options is executed you are prompted to specify the number of columns
in the matrix to be created. The corresponding binary matrix is then created, and the
results are displayed.

Once the results are displayed you can save this result in an ASP data file or add it to the
data matrix in memory by clicking on the Save button at the bottom of the output display.

I. Identity Matrix allows you to create an identity matrix.
S. Sum Matrix allows you to create a matrix of ones (1).

L. Lower Triangular Matrix allows you to create a matrix with ones (1) on and below the
diagonal.

U. Upper Triangular Matrix allows you to create a matrix with ones (1) on and above the
diagonal.

B. Below Diagonal Matrix allows you to create a matrix with ones (1) below the diagonal.

A. Above Diagonal Matrix allows you to create a matrix with ones (1) above the diagonal.

Interest Analysis Menu
You can access the INTEREST ANALYSIS menu by clicking on:
AUXILIARY -> Interest Rates.
There are five options on this menu:

M. Mortgage Amortization P. Present Value E. Equivalent Interest Rates

W. Withdrawal Of
Funds

F. Future Value
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Mortgage Amortization

A mortgage amortization analysis can be obtained by executing the M. Mortgage
Amortization option on the INTEREST ANALYSIS menu. The program responds by
prompting you to enter the:

Principal.

Rate of interest.

Number of years the mortgage is to run.
Amount of the monthly payment.

You have the option of entering a value in response to all four of these prompts or of
entering a value in response to any three and a missing value (i.e., an M or an *) in
response to the fourth. In the latter case the program will assume the entire principal is to
be amortized over the specified time period and will calculate the missing value
accordingly.

The terms of the mortgage amortization are then reported including the calculated value if a
missing value was entered in response to one of the above prompts. In a situation where a
missing value has been entered and one of the values calculated, the program also reports
the total payments and interest cost.

You are then given two options for producing amortization tables:
A month by month table.
A year end summary.

The month by month table option produces a month by month table. The terms of the
amortization agreement are reported above the table along with the total payments and
total interest cost.

In the table itself the payment made each month is reported along with the amount of
interest cost. The amount deducted from the principal owed as a result of making each
payment is also reported, as is the balance due after each payment, and the cumulative
interest paid after each payment.

If all four of the requisite values have been entered by you, the last payment reported in the
last line of the amortization table will be the size of the balloon payment needed to pay off
the entire mortgage at that point. If one of the four input values has been calculated by the
program this last payment will be the same as the other payments.

When the year end summary option menu is executed a year end amortization table is
calculated in which only the last month of each fiscal year (i.e., the twelfth month from the
month at which the payments start) is presented.
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Present Value

When the R. Present Value option on the INTEREST ANALYSIS menu is executed you
are prompted to:

Get Payment Stream From Data Matrix?.

If you respond YES to this prompt you are then prompted to:

Select the appropriate variable.

Specify the rate of interest at which the income stream is to be discounted.

If a nonmissing value is entered in response to the interest rate prompt, you are then
prompted to identify the number of payments per year.

Once this number is specified the present value of the income stream embodied in the
variable selected is calculated by discounting each element of this stream by the
appropriate discount rate.

If a missing value (i.e. an M or an *) is entered in response to the interest rate prompt, you
are then prompted to specify the present value before the number of payments per year
prompt is presented.

Once the present value and number of payments per year are specified, the rate of interest
that equates the specified present value and the discounted value of the income stream
embodied in the variable selected is calculated.

If you respond NO to the Get Payment Stream From Data Matrix? the program
assumes that a standard payment stream is to be discounted. This payment stream is
assumed to be made up of a constant periodic payment plus a principal payment that is
made at the end of the discounting time span.

In specifying this payment stream you are prompted to specify the:
Amount of the principal payment.

Rate of interest.

Time for which the payment stream runs.

Amount of the periodic payment.

The number of payments per year.

The present value of the specified payment stream is then calculated and displayed.
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If a missing value (i.e., an M or an *) is entered in response to one of the above prompts,
you are then prompted to enter the desired present value. The missing value will then be
calculated in such a way as to equate the discounted payment stream with the specified
present value.

Future Value Of Standard Payment Stream

The F. Future Value option on the INTEREST ANALYSIS menu calculates the future value
of a standard payment stream that is comprised of an initial principal balance and a
constant periodic payment.

In specifying this payment stream you are prompted to specify the:

Amount of the initial principal.

Rate of interest.

Time for which the payment stream runs.

Amount of the periodic payment.

The number of payments per year.

The future value of the specified payment stream is then calculated and displayed.

If a missing value (i.e., an M or an *) is entered in response to one of the above prompts
you are then prompted to specify the desired future value before the number of payments
per year prompt is presented.

At this point the missing value is calculated in such a way as to equate the specified future
value and the appreciated standard payment stream.

Equivalent Interest Rates

The E. Equivalent Interest Rates option on the INTEREST ANALYSIS menu allows you to
calculate interest rates that yield the same interest income for different rates of
compounding.

When this option is executed you are prompted to specify the number of compounds per
year, and the rate of interest. Once these two parameters are specified the equivalent
interest rates for different rates of compounding are calculated.

Withdrawal Of Funds

The W. Withdrawal of funds option on the INTEREST ANALYSIS menu allows you to
calculate the extent to which funds can be withdrawn from an initial principal balance at a
periodic rate.
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When this option is executed you are prompted to specify the:
Rate of interest.

Time period for which the periodic withdrawals are to be made.
Amount of the periodic withdrawal payments.

The number of payments per year.

The initial balance needed to maintain the specified payment stream for the specified
period of time is then calculated and displayed.

If a missing value (i.e., an M or an *) is entered in response to one of the above prompts
you are prompted to specify the initial principal balance before the number of payments per
year prompt is presented. The missing value is then calculated in such a way as to provide
for the specified withdrawal scheme.
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Character Plots

The character plot options in ASP are available in the CHARACTER PLOTS menu. You
can access this menu by clicking on:

GRAPHS -> Character Plots.
The CHARACTER PLOTS menu has twelve options:

D. Cumulative Plot K. Scatter Plot O. Overlay Plot

Q. Quantile Plot N. Normal Probability Plot V. Vertical Sequence Plot

A. Auto/Partial Correlation C. Cross Correlation Plot F. Frequency Plot
Plot

B. Box And Whisker Plot S. Stem And Leaf Plot T. Control Chart

These options provide a number of data analysis plots constructed from ASCII characters.
(Options K, O, Q, N, A, C, and F on this menu have comparable options on the Graphics
menu.)

The options on this menu provide the only source of plots in the Student Version of ASP.
Three options on this menu, F. Frequency Plot, B. Box And Whisker Plot, and S. Stem

And Leaf Plot, allow you to examine data quite quickly in that they allow you to input more
than one variable at a time. They also generate summary statistics for each variable.

Horizontal Plots
Horizontal plots are characterized by a horizontal and vertical axis.

There are five options on the CHARTER PLOTS menu that generate horizontal plots:

K. Scatter Plot N. Normal Probability Plot D. Cumulative Plot

Q. Quantile Plot O. Overlay Plot

Except as noted, all of these options follow a common format:

When one of these options is executed you are first prompted to select the variable or
samples to be used in the plot.



158

You are next prompted to specify any conditions that are unique to the option being
executed such as whether the plot is to be broken down by a third variable.

You are then prompted to enter a scale factor. This factor determines the extent to which
the plot is spread vertically. A scale factor of 0 or 1 places the entire plot on a single
screen, and a scale factor of 4 or 5 puts the entire plot on a single printed page.

You are next given the option of listing the observations that are to appear in the plot. This
allows you to preview the data before it is plotted.

The plot is then generated and displayed.

If a plot is a two variable plot that is not broken down by a set of criteria, each point in the
plot is represented by an asterisk (*).

If the plot is a multivariable plot or is broken down by a set of criteria, the points that
corresponds to a given variable or criteria are represented in the plot by a unique letter, a
for the first variable (lowest criteria), b for the second variable (second lowest criteria), etc.

If there are between two and nine observations at a given point, the number of
observations appears at that point instead of an asterisk or a letter. A question mark
indicates more than nine observations at that particular point.

In some plots (D, N, and Q) the equation of the regression line fitted to the points in the plot
is contained in the output, along with the coefficient of determination (R SQ.) and standard
error of estimate (Sd. Er. Est.).

The vertical end points of the regression line are marked on the vertical axis by an Rand L,
which can be paired with the right (R) and left (L) ends of the horizontal axis to locate the
end points of the regression line in the plot. If only an L appears, the regression line is
horizontal at that point.

Scatter Plot

K. Scatter Plot option on the CHARACTER PLOTS menu generates a scatter plot of one
variable against another. When this option is executed you are prompted to select two
variables for the plot and are given the option of breaking down the plot by a third variable.
The scatter plot is then generated and displayed as a horizontal plot .

Normal Probability Plot

N. Normal Probability Plot option on the CHARACTER PLOTS menu generates a normal
probability plot of a variable against its expected value on the assumption that the values of
the variable come from a normal distribution. These expected values are calculated and
then plotted as a horizontal plot against the actual values of the variable. (Neter et al)
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Cumulative Plot

D. Cumulative Plot option on the CHARACTER PLOTS menu generates a cumulative
plot of a variable. In constructing this plot the ith value of the variable being plotted is
plotted as a horizontal plot against i/n where n is the number of observations in the
variable.

Quantile Plot

Q. Quantile Plot option on the CHARACTER PLOTS menu generates quantile plots.
When this option is executed you are prompted to specify whether a one or two variable
plot is to be constructed and for the number of quantiles to be plotted.

In constructing a two variable quantile plot the values for each quantile are calculated for
each variable. These values are then plotted against each other.

In constructing a one variable quantile plot the values for each quantile are calculated for
the given variable, and these values are then plotted against the quantiles to which they
correspond.

If the number of quantiles selected is 4 then the value for each quartile is calculated and
plotted against the quartile to which it corresponds.

If the number of quantiles selected is 100 then the value for each percentile is calculated
and plotted against the percentile rank to which it corresponds. (Wilk and Gnanadesiikan)

Overlay Plot

O. Overlay Plot option on the CHARACTER PLOTS menu generates an overlay plot.
When this option is executed you are prompted to select the variables to be plotted. Each
variable in the plot is represented by a unique letter (a, b, etc.) and is plotted against its
sequence number as a horizontal plot .

Vertical Plots

There are four options on the CHARACTER PLOTS menu that generate vertical plots:

A. Auto/Partial Correlation C. Cross Correlation Plot
Plot

V. Vertical Sequence Plot

T. Control Charts

When one of these options is executed you are prompted, in a way that is specific to the
option being executed, to select the variable or samples that are to be used in the plot, and
to specify the parameters needed for the plot.

The relevant plot is then generated and displayed.
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In constructing a vertical plot each value plotted is listed to the left of the plot, and a value
that falls outside the range of the plot is indicated by an <= or => symbol depending on
whether the value falls outside the range on the left or the right.

Correlations are plotted as bars rather than points.

Vertical Sequence Plot

The V. Vertical Sequence Plot option on the CHARACTER PLOTS menu generates a
vertical plot of the variable being examined.

In constructing this plot the center vertical mark on the scale at the top of the plot indicates
the mean of the variable being plotted, and the values for the mean and three standard
deviations above and below the mean are listed on this scale.

Correlation Plots

The A. Auto/Partial Correlation Plot option on the CHARACTER PLOTS menu generates
both auto and partial correlation plots.

When this option is executed you are given the option of using a power or log
transformation on the series being examined. You are then prompted to specify:

The number of lags for which autocorrelations are to be calculated.

The degree of differencing to apply to the series being examined.

The number of seasonal periods in the series.

The degree of seasonal differencing to apply to the series being examined.

A vertical plot of the autocorrelations implied by the specified parameters is then generated
and plotted.

In constructing an autocorrelation plot the large-lag standard error is listed to the left of the
plot along with the autocorrelation being plotted. The box-pierce q statistic for the null
hypothesis that all of the autocorrelations are zero is also listed at the top of the plot along
with its degrees of freedom and p-value. Two standard error intervals above and below a
zero correlation are indicated by parentheses.

When the autocorrelation plot is exited by pressing CONTINUE the partial correlation plot
implied by the specified parameters is generated and plotted. In constructing the partial
correlation plot the standard error is listed to the left of the plot along with the partial
correlation being plotted. Two standard error intervals above and below a zero correlation
are indicated by parentheses.
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The partial correlation plot is not displayed if you exit the autocorrelation plot by clicking on
CANCEL or by pressing Esc.

C. Cross Correlation Plot generates a cross correlation plot. When this option is executed
you must specify the number of lags for which the cross correlations are to be calculated.
(Wilk and Gnanadesiikan, Box and Jenkins)

Control Charts

The T. Control Charts option on the CHARACTER PLOTS menu yields the CONTROL
CHART menu. (This menu is also available through the HYPOTHESIS TEST menu.) This
menu has five options:

V. VARIABLE M. MEANS P. PROPORTIONS

D. DEFECTS R. RANGES O. MOVING RANGE

The options on this menu follow the same format:

When one of these options is executed you are given the choice of specifying the standard
deviation for the chart, or of having the program calculate it from the data.

If you choose to specify the standard deviation you are prompted to enter the value for this
parameter.

You are prompted to specify any conditions that are particular to the data at hand or the
option being executed.

You are prompted to select the variable or samples to be used in the plot.
The plot is then displayed as a vertical plot.

Three of the options on the CONTROL CHART menu (M, P, and R) generate a table of
relevant statistics that is displayed when you exit the plot by clicking on CONTINUE. This
table is not displayed if you exit the plot by clicking on CANCEL or by pressing Esc.

Estimates of the standard deviations from which the control limits for each chart are derived
are based on the average variation within the subgroups. (Wheeler)

Control Chart For A Variable

The V. Variable option on the CONTROL CHART menu generates a vertical plot control
chart for a variable.

In constructing this chart each value plotted is listed to the left of the plot. Also listed to the
left of the plot is an indicator variable (REJECT) that indicates whether the plotted value is
(0) or is not (1) within three standard deviations of the mean of the values being plotted.
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The center vertical mark on the scale at the top of the plot indicates the mean of the values
being plotted. The distance between the vertical marks represents one standard deviation
of the values being plotted.

The values of the mean and three standard deviations above and below the mean are
listed on the scale at the top of the plot. (Wheeler)

Control Chart For Means

The M. Means option on the CONTROL CHART menu generates a vertical plot control
chart for a set of sample means.

In constructing this control chart the value of each sample mean plotted is listed to the left
of the plot. Also listed to the left of the plot is an indicator variable (REJECT) that indicates
whether the plotted value is (0) or is not (1) within three sample standard errors of the
grand mean.

The center vertical mark on the scale at the top of the plot indicates the grand mean of the
sample value. The distance between the vertical marks represents one standard error
(based on the median sample size) of the means being plotted.

The value of the grand mean and three standard errors above and below this mean are
listed on the scale at the top of the plot.

When the plot of the control chart is exited by clicking on CONTINUE a table listing the
sample values, the exact control limits for each sample mean, each sample mean, the
sample size, and the indicator variable REJECT is displayed.

This table is not displayed if you exit the plot of the control chart by clicking on CANCEL or
by pressing Esc. (Wheeler)

Control Chart For Proportions

The P. Proportions option on the CONTROL CHART menu generates a vertical
plot control chart for a set of proportions.

When this option is executed you are prompted to specify whether or not the sample sizes
are constant:

If the sample sizes are constant you are prompted to enter the size of the sample and to
select the variable that contains the number of defects per sample.

If the sample sizes are not constant you are prompted to select the variable that contains
the number of defects per sample and the variable that contains the sample sizes.
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In constructing this chart the proportion of defects per sample is calculated, plotted, and
listed to the left of the plot. Also listed to the left of the plot is an indicator variable
(REJECT) that indicates whether the plotted value is (0) or is not (1) within three standard
errors of the proportion of defects for the set of samples as a whole.

The center vertical mark on the scale at the top of the plot indicates the proportion of
defects for the set of samples as a whole. The distance between the vertical marks
represents one standard error (based on the median sample size) of the proportions being
plotted.

The values for the proportion of defects for the samples as a whole and three standard
errors above and below this proportion are listed on the scale at the top of the plot

When the plot of the control chart is exited by clicking on CONTINUE a table listing the
number of defects in each sample, the control limits for each sample, each sample
proportion, the size of each sample, and the indicator variable REJECT is displayed.

This table is not displayed if you exit the plot of the control chart by clicking on CANCEL or
by pressing Esc. (Wheeler)

Control Chart For Defects

The D. Defects option on the CONTROL CHART menu generates a vertical plot control
chart for defects as a vertical plot .

When this option is executed you are first prompted to specify whether or not the sample
sizes are constant:

If the sample sizes are not constant you are prompted to select the variable that contains
the number of defects per sample and the variable that contains the sample sizes. The
defects/unit are then calculated by dividing the number of defects by the sample size, and
this value is then plotted and listed to the left of the plot.

If the sample sizes are constant you are prompted to select the variable that contains the
number of defects per sample, and the defects themselves are then plotted and listed to
the left of the plot.

Also listed to the left of the plot is an indicator variable (REJECT) that indicates whether the
plotted value is (0) or is not (1) within three sample standard errors of the mean of the
defects(/unit) for the set of samples as a whole.

The center vertical mark on the scale at the top of the plot indicates the mean of the
defects(/unit) for the set of samples as a whole. The distance between the vertical marks
represents one standard error of the defects(/unit) being plotted.

The values for the defects(/unit) for the samples as a whole and three standard errors
above and below these defects(/unit) are listed on the scale at the top of the plot.
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When the plot of the control chart is exited by clicking on CONTINUE a table listing the
number of defects, the control limits, the defects/unit, and the size of each sample is
displayed along with the indicator variable REJECT.

This table is not displayed if you exit the plot of the control chart by clicking on CANCEL or
by pressing Esc. This table is also not displayed if the sample sizes are constant since
otherwise it contains no information that is not in the plot of the control chart itself.
(Wheeler)

Control Chart For Ranges

The R. Ranges option on the CONTROL CHARTS menu generates a vertical plot control
chart for a set of sample ranges.

In constructing this chart the value of the range for each sample is plotted and listed to the
left of the plot. Also listed to the left of the plot is an indicator variable (REJECT) that
indicates whether the plotted value is (0) or is not (1) within three sample standard errors of
the mean. The way in which the set of samples are selected from the current data matrix is
indicated above the plot.

The center vertical mark on the scale at the top of the plot indicates the mean of the
individual sample ranges. The distance between the vertical marks represents one
standard error (based on the median sample size) of the sample range as derived from a
table of control chart factors.

The value of the mean of the individual sample ranges and three standard errors above
and below the mean are listed on the scale at the top of the plot.

When the plot of the control chart is exited by clicking on CONTINUE a table listing the
sample values, the control limits for each sample range, each sample range, each sample
size, and the indicator variable REJECT is displayed.

This table is not displayed if you exit the plot of the control chart by clicking on CANCEL or
by pressing Esc. (Wheeler, Sincich)

Moving Ranges

The O. Moving Ranges option on the CONTROL CHARTS menu generates a vertical
plot moving range control chart for a variable.

In constructing this chart each value plotted is listed to the left of the plot. Also listed to the
left of the plot is an indicator variable (REJECT) that indicates whether the plotted value is
(0) or is not (1) within three standard deviations of the mean of the values being plotted.
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The center vertical mark on the scale at the top of the plot indicates the mean of the values
being plotted. The distance between the vertical marks represents one standard deviation
of the values being plotted.

The values of the mean and three standard deviations above and below the mean are
listed on the scale at the top of the plot. (Wheeler)

Special Plots

There are three special plot options on the CHARACTER PLOTS menu:

F. Frequency Plot B. Box And Whisker Plot S. Stem And Leaf Plot

When one of these options is executed you are prompted to select the variables for which
the plots are to be generated and to specify the parameters needed to construct the plot.

In addition to the plot for each variable, a number of summary statistics for each variable
are included in the output generated by these options. These statistics include the mean,
median, sample standard deviation, interquartile range, first and third quartile, midpoint of
the interquartile range, lower and upper adjacent values, number of valid cases and
missing values, and the minor and maijor outliers, if any, in the variable being plotted.

You are given the option of suppressing these statistics if you do not want to include them
in the output.

Frequency Plot

The F. Frequency Plot option on the CHARACTER PLOTS menu generates a frequency
plot for each variable selected.

When this option is executed you are prompted to specify whether the frequency
distributions are to be calculated by groups or by individual values:

If the distributions are to be calculated by groups you are prompted to specify the lower
limit of the first group, then the width of the group interval, the maximum number of
intervals to be calculated, and, finally, whether you want to suppress the summary
statistics.

If the distributions are to be calculated by individual values you are prompted to enter
the lowest value to be counted and the maximum number of values to be counted.

Frequency distribution plots are then generated and displayed for each of the selected
variables.

In addition to the plot and summary statistics (if not suppressed), the output also lists the
frequencies for each interval or value, the cumulative frequencies, frequencies as a percent
of the total, and cumulative frequencies as a percent of the total.
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Box And Whisker Plots

The B. Box And Whisker Plot option on the CHARACTER PLOTS menu generates a box
and whisker plot for each variable selected.

If two or more variables are selected you must choose between constructing the plots
independently of each other with separate scales or constructing these plots using a
common scale allowing for direct comparisons among the plots:

If you choose to use independent scales in constructing the plots, the end points of the
scale for each variable are determined by the smallest and largest values in the variable.

If you choose to use a common scale in constructing the plots, the end points of the
common scale are determined by the smallest and largest values in the set of variables
being considered.

The end points of the box formed by the Xs are determined by the first and third quartiles of
each variable. The length of each whisker formed by the dashed lines (---) are determined
by the upper and lower adjacent values. Minor outliers are represented by the lower case
letter o, and major outliers are represented by the upper case letter O. The median of each
variable is indicated by the vertical bar (]) located in the box formed by the Xs. (Koopmans)

Stem And Leaf Plots

The S. Stem And Leaf Plot option on the CHARACTER PLOTS menu generates a stem
and leaf plot for each variable selected.

When this option is executed you are prompted to specify the:
Number of digits in the stem.

Number of lines in the stem.

Number of digits in the leaf.

The corresponding stem and leaf plot is then generated. (Koopmans)



Graphics Options

High resolution graphics are available in ASP through the GRAPHICS OPTIONS menu.

You can access this menu by clicking on:

GRAPHS -> Graphics Options.
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(This menu is not available in the Student Version of ASP or if the ASP Graphics Add On

has not been installed.) The options on this menu use the ChartFX ® DLL to generate

the graphics output, and this output is displayed in the ChartFX Editor.

The GRAPHICS OPTIONS menu has thirteen options:

A. Scatter Plot B. Sequence Plot C. Pie Chart D. Bar Graph
E. Area Plot F. Function Plot  G. Frequency Plot H. Quantile Plot

K. Normal Prob. L. Crosstab Plot

|. Control Chart J. Correlation Plot

Plot

M. Regression Plot

Plots And Graphs

There are at least thirteen kinds of high resolution plots and graphs that are available

through the Graphics Option on the GRAPHS menu:

Sequence Plots Bar Graphs Area Plots Scatter Plots
Pie Charts Crosstab Plots Frequency Plots Control Charts
Quantile Plots Probability Plots Regression Plots Function Plots

Correlation Plots

Sequence Plots, Bar Graphs, And Area Plots

The B. Sequence Plot, D. Bar Graph, and E. Area Plot options on the GRAPHICS
OPTIONS menu generate horizontal sequence plots, bar graphs, and area plots.

When you execute one of these options:

You are prompted to select the variables to be plotted.
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The plot of the variables you selected is generated and displayed in the ChartFX editor.

The X axis in a sequence plot, bar graph, and area plot indicates the sequence number of
the value being plotted and can extend beyond the visible area of the plot. In this situation a
slider will appear at the bottom of the plot that you can use to change the visible area of the
plot.

Scatter Plots
The A. Scatter Plot option on the GRAPHICS OPTIONS menu generates a scatter plot.

When you execute this option:

You are prompted to select the variable to plot on the X axis and the variables to plot on the
Y axis.

If you select a single variable to plot on the Y axis you are given the option of choosing a
third variable by which to breakdown this variable.

The Y axis variables are then plotted against the X axis variable, and the plot is displayed
in the ChartFX editor.

Pie Charts
The C. Pie Chart option on the GRAPHICS OPTIONS menu generates a pie chart.

When you execute this option:
You are prompted to select the variable to plot.

The values of the variable you selected are then plotted as wedges in a pie chart, and the
chart is displayed in the ChartFX editor.

Crosstab Plots

When the L. Crosstab Plot option on the GRAPHICS OPTIONS menu generates a plot of
two crosstabulated variables.

When this option is executed:
You are prompted to select two variables to be crosstabulated.

You are then given the option of plotting the resulting crosstabulation by: frequencies,
expected frequencies, or the percent of column, row, or total frequencies.

The plot is generated and displayed in the ChartFX editor .
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Control Charts, Quantile And Probability Plots

The H. Quantile Plot, I. Control Charts, J. Correlation Plots, and K. Normal Prob. Plot
options on the GRAPHICS OPTIONS menu follow the same format, and generate the
same output, as their counterparts on the CHARACTER PLOTS menu.

The only difference between these options and their counterparts on the CHARACTER
PLOTS menu is the high resolution output from the GRAPHICS OPTIONS menu.

Regression Plots

The M. Regression Plot option on the GRAPHICS OPTIONS menu generates a two
variable regression plot.

The actual and estimated values of the dependent variable and the 95% confidence limits
above and below the estimated values are identified in the plot.

When this option is executed:

You are prompted to select the dependent (Variable 1) and independent (Variable 2)
variable for the plot.

The plot is generated and displayed in the ChartFX editor. You can then customize the plot
as you wish.

Function Plots
The F. Function Plot option on the GRAPHICS OPTIONS menu allows you to:

Specify A function to plot

Plot a probability distribution

The way in which the program proceeds depends on the option chosen.

Specifying A Function To Plot

The P. Specify Function To Plot option on the FEUNCTION PLOT menu provides a means
for generating two and three dimensional plots of a function you specify.

When this option is executed:

You are first presented with the SPECIFY FUNCTION TO PLOT form. You can specify
your function of X and Y in the edit box on this form using the notation defined in the
window at the top of the form.

When you exit the SPECIFY FUNCTION TO PLOT form by clicking on OK you are
prompted to enter the:
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Minimum value for X.

Maximum value for X.

Minimum value for Y.

Maximum value for Y.

Number of points to plot.

(For single variable functions of X the values for Y are not requested.)

The plot of the function you specified is generated and displayed in the ChartFX editor.

When you exit the ChartFX editor you are returned to the SPECIFY FUNCTION TO PLOT
form.

Plotting Probability Distributions

Eight options on the FUNCTION PLOT menu allow you to generate one and two
dimensional plots of the probability distributions:

N. Normal Distribution T. t Distribution F. F Distribution
C. Chi Square W. Weibull Distribution B. Beta Distribution
Distribution

G. Gamma Distribution E. Exponential Distribution

When one of these options is executed you are prompted to:

Choose whether you want to create a two or three dimensional plot.

For a two dimensional plot, to specify the number of curves you want to plot.

Specify the number of points you want to plot.

You must also specify information necessary to the particular distribution you have chosen:
N. Normal Distribution allows you to plot the normal distribution:

For a two dimensional plot you must specify the mean and variance for each curve to be
plotted.

For a three dimensional plot you must specify the mean and variance for each dimension of
the bivariate normal distribution to be plotted as well as the correlation between the two
variables.
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T. t Distribution allows you to plot the t distribution:

For a two dimensional plot you must specify the degrees of freedom for each curve to be
plotted and whether you wish to add a standard normal curve to the plot.

For a three dimensional plot you must specify the minimum and maximum degrees of
freedom for which the t distribution is to be plotted.

F. F Distribution allows you to plot the F distribution:

For a two dimensional plot you must specify the numerator and denominator degrees of
freedom for each curve to be plotted, and minimum and maximum values for F as well.

For a three dimensional plot you must choose to set either the numerator or denominator
degrees of freedom to a specific value, and then specify minimum and maximum degrees
of freedom for the other parameter. You must also specify minimum and maximum values
for F.

C. Chi Square Distribution allows you to plot the chi square distribution:

For a two dimensional plot you must specify the degrees of freedom for each curve to be
plotted and minimum and maximum values for chi square as well.

For a three dimensional plot you must specify minimum and maximum values for chi
square as well as minimum and maximum values for the degrees of freedom.

W. Weibull Distribution allows you to plot the Weibull distribution:

For a two dimensional plot you must specify values for the a and b parameters of this
distribution for each curve to be plotted and then the minimum and maximum values for the
Weibull statistic (X):

For a three dimensional plot you must choose to set either a or b to a specific value and
then specify minimum and maximum values for the other parameter. You must also specify
minimum and maximum values for the Weibull statistic.

B. Beta Distribution allows you to plot the beta distribution:

For a two dimensional plot you must specify the a and b parameters of this distribution for
each curve to be plotted and then minimum and maximum values for the beta statistic (X ).

For a three dimensional plot you must choose to set either a or b to a specific value and
then specify minimum and maximum values for the other parameter. You must also specify
minimum and maximum values for the beta statistic.

G. Gamma Distribution allows you to plot the gamma distribution:
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For a two dimensional plot you must specify values for the a and b parameters of this
distribution for each curve to be plotted and then minimum and maximum values for the
gamma statistic (X ).

For a three dimensional plot you must choose to set either a or b to a specific value and
then specify minimum and maximum values for the other parameter. You must also specify
minimum and maximum values for the gamma statistic.

E. Exponential Distribution allows you to plot the exponential distribution:

For a two dimensional plot you must specify minimum and maximum values for the
exponential statistic (X ).

For a three dimensional plot you must specify minimum and maximum values for the mean
of the distribution as well as minimum and maximum values for the exponential statistic.

Correlation Plots

The J. Correlation Plots option on the GRAPHICS OPTIONS menu generates correlation
plots.

When this option is executed you are presented with the CORRELATION PLOTS menu.
This menu has three options:

A. Autocorrelation Plot P. Partial Correlation Plot C. Cross Correlation Plot

The way in which the program proceeds depends on the option chosen.

Auto And Partial Correlation Plots

The A. Autocorrelation Plot and P. Partial Correlation Plot options on the
CORRELATION PLOT menu generate auto and partial correlation plots. When one of
these options is executed you are prompted to:

Select the variable to be examined.

To choose between performing a log or power transformation on the variable.
Specify the number of lags to consider.

Specify the degree of differencing to consider.

Specify the number of seasonal periods.

Specify the degree of seasonal differencing.

The plot is then generated and displayed in the ChartFX editor.
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Cross Correlation Plot

The C. Cross Correlation Plot option on the CORRELATION PLOTS menu generates a
cross correlation plot.

When this option is executed you are prompted to:
Select the two variables to cross correlate.
Specify the number of lags to be examined.

The plot is generated and displayed in the ChartFX.

ChartFX Graphics Editor

When an option on the GRAPHICS OPTIONS menu is executed the result is a high
resolution graph that is presented in the ChartFX Graphics editor. The graph is displayed at
the bottom of this editor and a Windows menu bar is presented at the top. The options on
this menu bar allow you to customize the graph that is displayed at the bottom.

The ChartFX menu bar has six options:

File Edit Tools View Gallery Help

Each of these options accesses a separate menu.

Using The Mouse In The ChartFX Editor

Pressing the left mouse button when the pointer is on the graph in the ChartFX editor
generates vertical and horizontal crosshairs. These crosshairs can be used to locate the X
and Y values on the horizontal and vertical axes.

You can also use the left mouse button to resize and drag legends to the position you want
them to appear in the graph, to drag wedges in a pie chart to an offset position, to drag
colors form the palette bar, and to drag patterns from the pattern bar.

Pressing the right mouse button when the pointer is on a point on a graph in the ChartFX
editor will display the value of the graph at that point.

You can also use the right button to identify the function of an icon in the toolbar by right
clicking on the icon.

ChartFX File Menu

The ChartFX File menu allows you to export and import graphs to and from a file, to export
and import templates to and from a file, to setup and print a graph, and to exit the ChartFX
editor and return to the ASP GRAPHICS OPTIONS menu.
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The ChartFX File menu has seven options:

Export Import Export Template Import Template
Page Setup Print Close

Export allows you to save the graph in the editor to a ChartFX formatted file. This format
can be read only by the ChartFX editor.

Import allows you get a file that you previously saved in ChartFX format and load it into the
ChartFX editor.

Export Template allows you to save in a template file all of the non data dependent
information associated with the graph in the editor. This allows to save the colors, chart
type and style, visible tools, etc. associated with the graph in the editor.

Import Template allows you to load a template you previously saved and, thereby, to apply
the properties saved in the template to the graph in the editor.

Page Setup allows you to specify the way in which a graph in the editor will be positioned
on the page when the graph is printed.

Print allows you to print the graph in the editor using a standard Windows print form.

Close allows you to close the ChartFX editor and return the ASP GRAPHICS OPTION
menu.

ChartFX Edit Menu

The ChartFX Edit menu allows you copy the graph in the editor to the clipboard, change
the fonts used in the graph, and to edit the titles that appear in the graph.

This menu has three options: Copy, Fonts, Titles.

Copy allows you to copy the graph in the editor to the clipboard. This, in turn, allows you to
paste the graph into another program. When the focus is on this option a submenu appears
with three options: Data, Bitmap, Metafile.

Data allows you to copy the data underlying the graph to the clipboard.

Bitmap allows you to copy the graph to the clipboard in bitmap format.

Metafile allows you to copy the graph to the clipboard in the Windows metafile format.
Fonts allows you to specify the fonts used in the titles, legends, and values displayed in the

graph in the editor using a standard Windows form to specify a font. When the focus is on
this option a submenu appears with nine options:
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Left Title Right Title Top Title
Bottom Title X Legend Y Legend
Legend Box Constant Legends Values Font

Executing one of these options allows you to set the font for the corresponding title, legend,
or value.

Titles allows you edit the top, left, right, and bottom titles displayed in the graph in the
editor. When this option is executed an EDIT TITLES form is presented. This form contains
four edit boxes, one for each title to be edited.

ChartFX Tools Menu

The ChartFX Tools menu allows you to add or remove legends from the graph in the
editor. It also allows you to display editing tools at the top of the ChartFX editor and to edit
the data and labels underlying the graph in the editor.

This menu has seven option:

Legend Series Legends Toolbar
PaletteBar PatternBar StatusBar
Data Editor

Legend allows you toggle the values legend on and off in the graph. When this legend is
on you can resize it using the mouse and drag it to the place on the graph at which you
want it to appear.

Series Legends allows you to toggle the series legend on and off in the graph. When this
legend is on you can resize it using the mouse and drag it to the place on the graph at
which you want it to appear.

Toolbar allows you to toggle the toolbar on and off in the ChartFX editor. The toolbar
contains icons that provide shortcuts to the options on the menu bar menus at the top of
the ChartFX editor. You can view the function of an icon on the toolbar by right clicking on it
or by placing the mouse pointer over the icon for three seconds without moving it. Either of
these actions will open a balloon window above the icon that explains its function.

PaletteBar allows you to toggle the palette bar on an off in the ChartFX editor. You can
drag colors from the palette bar to the graph and thereby change the colors in the graph.
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PatternBar allows you to toggle the pattern bar on and off in the ChartFX editor. You can
drag patterns from the pattern bar to the graph and thereby change the background
patterns in the graph.

StatusBar allows you to toggle the status bar on and off in the ChartFX editor when the
status bar is available.

Data Editor allows you to open the ChartFX data editor. This editor allows you to change
the numbers and labels in the data underlying the graph in the editor. Changes made in the
ChartFX data editor do not affect the data in the ASP editor.

To change a value in a cell in the ChartFX data editor:

Double Click on the cell in the ChartFX data editor that you want to change. This will open
an edit window over the cell.

Enter the new value for the cell.

Press Enter.

ChartFX View Menu

The View menu allows you to change the orientation of the graph in the editor, add grid
lines to the graph, and to zoom part of the graph. It also allows you access to the CHART
PROPERTIES form. This form provides an efficient mechanism by which to set a number
of properties for the graph in the editor.

The View menu has six options:

3D Rotate Cluster Grid Options Zoom

3D allows you to toggle between a two dimensional and three dimensional view of the
graph in the editor.

Rotate allows you to change the perspective and rotate the graph in the editor when the 3D
option is on. When this option is executed you are presented with the 3D VIEW
PROPERTIES form. This form contains a slider, three checkboxes, and two edit boxes:

The slider allows you to change the proportions of the graph in the editor.
3D check box allows you to toggle the three dimensional view on and off.

Full 3D View check box allows you to toggle the X Angle and Y Angle edit boxes on and
off.

X Angle edit box allows you to set the angle of the X axis of the graph in the editor when
the Full 3D View is on.
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Y Angle edit box allows you to set the angle of the Y axis of the graph in the editor when
the Full 3D View is on.

Shadow check box allows you to toggle the shadow property of the graph in the editor on
and off.

Cluster allows you to toggle the cluster property of the graph in the editor on and off.

Grid allows you to add grid lines to the graph in the editor. When the focus is on this option
you are give the option of toggling on and off grid lines for the horizontal and vertical axes.

Options allows you to access the CHART PROPERTIES form. This from provides an
efficient mechanism by which to set a number of properties for the graph in the editor,
some of which can be set from other menus and some of which are unique to this form.
When this option is executed the CHART PROPERTIES form is displayed. This form has
five menu tabs at the top:

General Series Scale 3D View Titles
The General tab contains five combo boxes, two sliders, and two check boxes:

Gallery Type combo box allows you to select the graph type: Line, Point, Spline, Bar, Hoz
Bar, Cubes, Area, Surface, Pareto, Pie, Doughnut, Polar, Scatter, and Hi-Low.

Stack Style combo box allows you to select the stack style for bar charts.

Grid Lines combo box allows you to add grid lines to the graph.

Color Scheme combo box allows you to select a color scheme for the graph.

Point Type combo box allows you to select the point types for plots.

Point Size slider allows you to set the point size for plots.

Marker Value slider allows you to set the marker size for bar charts.

3D Cluster check box allows you to toggle three dimensions on and off.

Color Lines check box allows you to toggle color for lines on and off.

The Series tab contains three combo boxes, eight check boxes, and one edit box/slider:
Series combo box allows you to select the series to be modified.

Series Color combo box allows you to set the color for the selected series.

Gallery Type combo box allows you to select the kind of graph to display: Line, Point,

Spline, Bar, Hoz Bar, Cubes, Area, Surface, Pareto, Pie, Doughnut, Polar, Scatter, and Hi-
Low.
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Multiple Types check box allows you to activate the Gallery Type combo box.

Point Markers check box allows you to add point markers to the selected series.
Show Values check box allows you to display the underlying values in the graph.
Borders check box allows you to add borders to the graph.

Area Lines check box allows you to add grid lines to an area plot.

Connecting Lines check box allows you to add connecting lines to the points in a plot.
Multiple Shapes check box allows you to enable multiple shapes in a bar graph.
Conic check box allows you to include conic shapes in a bar graph.

No. of vertex edit box/slider allows you to set the number of vertices in the bars of a bar
graph.

The Scale tab contains three sets of option buttons, five edit boxes, and one check box:

Main Y axis, X Axis, and Secondary Y axis option buttons allow you to select the axis to
be customized.

Automatic and Fixed option buttons allow you to set the tick marks on the selected axis.

Linear and Logarithmic option buttons allow you to choose a linear or logarithmic scale on
the selected axis.

Minimum edit box allows you to specify the minimum value on the selected axis.
Maximum edit box allows you to specify the maximum value on the selected axis.

Scale Unit edit box allows you to specify the scale unit on the selected axis.

Decimals edit box allows you to specify the number of decimal places on the selected axis.
Fixed edit box allows you to specify the size of the increment on the selected axis.

Show Zero axis check box allows you to show the zero value on the selected axis.

The 3D View tab allows you to access the 3D VIEW PROPERTIES form from the CHART
PROPERTIES form.

The Titles tab allows you to access the Edit Titles form from within the CHART
PROPERTIES form.
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Zoom allows you to use the right mouse button to drag a rectangle over a portion of the
graph that you want to examine more closely. This rectangle is then zoomed to fill the
entire graph.

ChartFX Gallery Menu

The Gallery menu allows you to select the kind of graph in the editor. This menu has
fourteen options:

Line Point Spline Bar Hoz Bar
Cubes Area Surface Pareto Pie
Doughnut Polar Scatter Hi-Low

These options allow you to select, by clicking on the corresponding option, the kind of plot
displayed in the editor.

Not all of these options will necessarily be compatible with a given set of data. The graph
will not be displayed if there is an incompatibility.

It should be noted that the Line and Scatter options differ, in that the X axes for the two
options are not the same. Even though you can eliminate lines from a line plot and add
lines to a scatter plot, this does not make the two plots equivalent.

The X axis in the Line option is the sequence number of the series being plotted and can
extend beyond the visible area of the plot. You can use this option to convert a scatter plot
to a sequence plot.

The X axis in the Scatter option is the value of a variable and will not extend beyond the
visible area of the plot. You can use this option to convert a sequence plot that extends
beyond the visible area of the plot to a sequence plot that does not extend beyond the
visible area of the plot.

ChartFX Help Menu

The Help menu allows you to access the ASP help system. This menu has three options:
Contents allows you to examine the table of contents of the ASP help file.

How to Use Help allows you to access the Windows help system to explain the
Windows help system.

About ChartFX provides copyright and other information about the ChartFX DLL.
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